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Introduction1

Welcome to your printer
Your printer is a color inkjet printer designed for printing high-quality images on paper up to 914 mm (36 
in) wide.

Some major features of the printer are shown below:

● Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the Best 
print-quality option, the Maximum Detail option and photo paper

● The printer can be controlled from its control panel or from a remote computer using the 
Embedded Web Server, HP Command Center, or HP Click (see the HP website at the following 
link: http://www.hp.com/go/clickDesignJet)

● Touch-sensitive control panel in color, with an intuitive graphical user interface

● Job previews in the control panel

● Job previews on remote computers

● Includes Web-connected features such as automatic firmware updates and Mobile Printing

● Driverless printing: Files in common graphical formats can be printed directly without needing a 
printer driver. Just insert a USB flash drive, use HP Click, AirPrint, or Print from network

● Easy paper loading, see Paper handling on page 36, with information and presets accessible from 
the control panel and the HP Command Center

● Handles roll paper

● Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of 
unattended printing

● Four-ink system

● Accurate and consistent color reproduction

● Ink and paper usage information available from the Embedded Web Server and control panel, see 
Embedded Web Server on page 35 and Control panel on page 8

● Access to the online HP Support Center (see HP Support Center on page 223)

Printer model
This guide covers the following printer model, normally referring to it by its short name for brevity.

Table 1-1 Printer models

Full name Short name

HP DesignJet XL 3800 Multifunction Printer XL 3800MFP
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Safety precautions
Before using your printer, read, understand, and follow these safety precautions, and your local 
Environmental, Health, and Safety regulations.

This equipment is not suitable for use in locations where children are likely to be present. For any 
maintenance or part replacement, follow the instructions provided in HP documentation to minimize 
safety risks and to avoid damaging the printer.

General safety guidelines
Please read all the safety guidelines carefully.

There are no operator-serviceable parts inside the printer except those covered by HP’s Customer 
Self Repair program (see the HP website at the following link: http://www.hp.com/go/selfrepair). Refer 
servicing of other parts to qualified service personnel.

Turn off the printer and call your service representative in any of the following cases:

● The power cord or plug is damaged

● The printer has been damaged by an impact

● There is any mechanical or enclosure damage

● Liquid has entered the printer

● There is smoke or an unusual smell coming from the printer

● The printer has been dropped

● The printer is not operating normally

Turn off the printer in either of the following cases:

● During a thunderstorm

● During a power failure

Take special care with zones marked with warning labels.

Ventilation measures for your location, whether office, copy room, or printer room, should meet local 
environmental health and safety (EHS) guidelines and regulations.

Electrical shock hazard
The printer requires a building installation circuit breaker, which must meet the requirements of the 
printer and should be in accordance with the Electrical Code requirements of the local jurisdiction of the 
country in which the equipment is installed.

WARNING! The internal circuits of the built-in power supplies and power inlet operate at hazardous 
voltages capable of causing death or serious personal injury.

Unplug the printer’s power cord before servicing the printer.
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To avoid the risk of electric shock:

● The printer must be connected to earthed mains outlets only

● Avoid overloading the printer's electrical outlet with multiple devices

● Do not remove or open any closed system covers or plugs

● Do not insert objects through slots in the printer

● Take care not to trip over the cables when walking behind the printer

● Insert the power cord securely and completely into the wall socket and printer inlet

● Never handle the power cord with wet hands

Fire hazard
The customer is responsible for meeting the printer’s requirements and the Electrical Code 
requirements according to the local jurisdiction of the country where the equipment is installed.

To avoid the risk of fire, take the following precautions:

● Use the power supply voltage specified on the nameplate

● Use only the power cord supplied by HP with the printer. Do not use a damaged power cord. Do not 
use the power cord with other products

● Do not insert objects through slots in the printer

● Take care not to spill liquid on the printer. After cleaning, make sure all components are dry before 
using the printer again

● Do not use aerosol products that contain flammable gases inside or around the printer. Do not 
operate the printer in an explosive atmosphere

● Do not block or cover the openings of the printer

Mechanical hazard
The printer has moving parts that could cause injury. To avoid personal injury, follow all the precautions 
when working close to the printer.

Take the following precautions:

● Keep your clothing and all parts of your body away from the printer’s moving parts

● Avoid wearing necklaces, bracelets, and other hanging objects

● If your hair is long, try to secure it so that it will not fall into the printer

● Take care that sleeves or gloves do not get caught in the printer’s moving parts

● Do not operate the printer with covers bypassed

● If you need to replace the cutter assembly, remember that the cutter has a sharp cutting edge, and 
take care not to cut yourself

● Internal fan blades are hazardous moving parts. Disconnect the printer before servicing
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● Never insert your hands into the printer while it is printing, due to the moving parts inside

Transportation hazard
Special care must be taken when moving and/or transporting the printer.

● Remove all supplies (ink, paper roll, etc.) and ensure the drawers are correctly closed before printer 
transportation

● Always move the printer in the direction of its length

● Take special care when you move the printer over a rough surface (carpet etc.), or if you have to 
move the printer in the direction of its width

Heavy paper hazard
Special care must be taken to avoid personal injury when handling heavy papers.

● Handling heavy paper rolls may require more than one person. Care must be taken to avoid back 
strain and/or injury

● When handling heavy paper rolls, wear personal protective equipment, including safety boots and 
gloves

● Follow your local Environmental Health and Safety (EHS) regulations for handling heavy paper rolls

Chemical hazard
See the safety data sheets to identify the chemical ingredients of your consumables.

The safety data sheets are available on the HP website at the following link: http://www.hp.com/go/msds.

Ink handling
HP recommends that you wear gloves when handling ink system components.

Warnings and cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the 
printer from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal 
injury or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal 
injury or damage to the printer.

Warning labels
Warning labels are placed in various locations on the printer, it is important to familiarize yourself with 
their meaning to ensure your safety during operations.
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Table 1-2 Warning labels

Label Explanation

Electric shock hazard. Power Supply inside that operates 
at hazardous voltages. Disconnect all power sources before 
servicing.

Before starting, read and follow the operating and safety 
instructions.

Moving part. Keep your fingers and hands away from the 
carriage.

Do not step on. Roll paper drawer open. Do not step on or climb 
on drawer.

Moving fan blades. Electronics Box Fan. Keep hands out.

NOTE: The final label position and its size on the printer may vary slightly, but labels should always be 
visible and close to the potential risk area.

Main components
The following front and rear views of the printer illustrate the main components.

Front view
The printer viewed from the front.
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1. Ink cartridge slot

2. Stacker

3. Scanner

4. Control panel

5. 1st drawer

6. 2nd drawer

Rear view

1. Power socket

2. Gigabit Ethernet port, to connect to a network; and diagnostic LEDs, to be used by service engineers
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3. Accessories port

Turn the printer on and off
You can turn the printer on with a single press of the power key, which is located below the control panel.

To turn the printer off, press the power key, and a message appears on the control panel. Tap Shut Down 
to confirm the action:

The power key could be left unresponsive to a short press when certain errors have occurred. In these 
situations it is still possible to reset the unit by long-pressing the power key. This option should be used 
only as a last resort to restart the printer. Afterwards the system should power on again immediately. 
Alternatively, to reset the printer, the power cord at the rear can be unplugged.

When the printer is powered back on, it takes about 3 minutes to initialize, check, and prepare the 
printheads. Preparing the printheads takes about 1–2 minutes; however, if the printer has been off for 6 
weeks or more, preparing the printheads could take up to 6 minutes.

The printer can be left powered on without using much energy. Leaving it on improves response time and 
overall system reliability.

TIP: When the printer has not been used for a certain period of time (the default time is determined by 
Energy Star), it saves power by going into sleep mode. Interaction with the control panel, or sending a 
job to print, returns the printer to active mode and it can resume printing immediately. To change the 
sleep-mode time, see Change system options on page 10.

NOTE: In sleep mode, from time to time the printer performs a maintenance service to the printheads. 
This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to 
leave the printer powered on or in sleep mode to avoid wasting ink and time.
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Control panel
The control panel is a touch-sensitive screen with a graphical user interface, located on the front right of 
the printer.

It gives you complete control of your printer: from the control panel, you can perform the main tasks 
such as print, and scan and copy. You can also view information about the printer, change printer 
settings, monitor printer status, and perform tasks such as supplies replacement and calibrations. The 
control panel displays alerts (warning and error messages) when necessary.

It includes the following components:

1. The control panel: a 15.6 inch, full-color, touch-sensitive screen with a graphical user interface.

2. The power key, with which you can turn the printer on or off, or wake up from sleep mode.

3. A Hi-Speed USB host port, intended for connecting a USB flash drive, which can provide files to be 
printed. When a USB flash drive is inserted, a USB icon  is displayed on the control panel’s 
all-apps page.

The control panel has a large central area to display dynamic information and icons.

Home pages

In the main screen there are four widgets with which you can quickly make copies, scan to network, go to 
the job queue, or check the status of the ink cartridges.

● At the bottom are the apps for the main printer functions.

8 Chapter 1  Introduction



● The menu displays all the apps available in your printer.

● Swipe down the top part of the screen to open the Status Center, where you’ll find the main 
notifications and fast-action buttons.

Sleep mode
Sleep mode puts the printer into a reduced power state after a period of inactivity, turning off some 
elements to save energy. Printer features can be enabled from this mode, and the printer maintains 
network connectivity, waking up only as necessary.

The printer can be woken from sleep mode any of the following ways:

● By pressing the power button

● By touching the control panel
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● By opening a cover

● By sending a print job

The printer wakes up in several seconds, more quickly than if it is completely turned off. While in sleep 
mode, the power button blinks.

To change the time that elapses before sleep mode (5 minutes by default), see Change system options 
on page 10.

Printer Monitoring (with the Print Spooler) and Remote Printer Management with the HP Command 
Center and Web JetAdmin continue to be available during sleep mode. Some remote management tasks 
offer the option of remotely waking up the printer if needed to perform the task.

Change the language of the control-panel display
From the control panel, you can change the language displayed on the control panel.

If you can understand the current control-panel display language, tap the Menu icon , then the 

Settings icon , then General > Language.

The language selection menu should now appear on the control-panel display. Tap your preferred 
language.

The available languages are English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, 
Polish, Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese.

Change system options
You can change various printer system options from the control panel.

Tap the Menu icon , then the Settings icon , then General.

● Date and time

● Energy:

– Sleep schedule

– Sleep

– Inactivity shutdown

– Disable shutdown

● Display:

– Brightness

● Height above sea level

● Enable USB port

● Show last used settings
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HP Command Center
HP Command Center is a cloud-based device-management portal with which you can monitor your 
printer at any time and from anywhere in a secure way.

You can access it from this HP website: https://hp-commandcenter.com.

Here you will find a centralized dashboard from which you can monitor your device status.

You can select a specific device to get detailed information on its status.

Access HP Command Center
Follow these steps to access HP Command Center and register your printer there.

1. Go to the HP Command Center website, using the URL indicated on the control panel: 
https://start.hp.com.

HP Command Center 11
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2. If you already have an HP account, click Sign in to an existing account; otherwise, click Create 
account to create a new account.

3. Register your printer, using the printer pairing code that you can find on the printer’s control panel, 
and click Continue.

4. Enter the details of your organization, giving its name, country, region, and (optional) description.

5. Click Continue to proceed and Accept to accept the HP Command Center Terms of Use.

6. Click Continue to accept the Connected Printing Services agreement, allowing HP to collect data to 
support HP Command Center features and operations.

7. If you have a contractual relationship with your service provider, you may connect the printer to 
HP Partner Link Pay-Per-Use during the onboarding. You will need to enter the HP Partner Link ID 
provided by your service provider, and click Connect.
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8. Click Go to HP Command Center to start using its facilities.

Embedded Web Server
To use the Embedded Web Server on any computer, open your Web browser and enter the printer’s IP 
address into the browser’s address bar.

The following browsers are known to be compatible with the Embedded Web Server:

Table 1-3 Compatible browsers

Browser Supported versions

Google Chrome Latest version

Apple Safari 15 and later OS X 13 and later

Mozilla Firefox Latest version

Microsoft Edge Windows 7 and later

You can find your printer’s IP address in the printer’s control panel: tap the Menu icon , then Network. 
See Configure your printer on page 14.

NOTE: Your browser may display a security warning when you enter the IP address. If you have 
entered the correct address, it is safe to ignore the warning and continue to access the Embedded 
Web Server.
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The Embedded Web Server window displays a menu used to access all supported functions. It supports 
the following languages: English, Portuguese, Spanish, Catalan, French, Dutch, Italian, German, Polish, 
Russian, Simplified Chinese, Traditional Chinese, Korean, and Japanese. You can select the default 
language by tapping General > Language.

The default language options are:

● Use printer language

● Use browser language

● Select a language (from a list)

If the Embedded Web Server cannot support the language specified in your browser settings, it uses the 
language chosen in your printer. If it cannot support that language either, it uses English.

To change the language for the current Embedded Web Server session, select the desired language in 
the select box located in the bottom right corner of each page. This change is temporary, and will be lost 
when the page is refreshed or after closing the browser.

To change the language permanently, change the printer language in the control panel (see Change 
the language of the control-panel display on page 10), or change the browser language in the browser 
settings.

Demo prints
The demo prints give various kinds of information about your printer. They can be requested from the 
control panel.

Before requesting a demo print, check that the printer and the paper are ready for printing.

● The loaded roll paper should be at least A3 landscape—419 mm (16.53 in) wide—otherwise the print 
may be clipped.

To print a demo print, tap the Menu icon , then the Tools icon , then Reports > Demo pages, and 
select a print.

The following prints are available:

● CAD

● Presentation Panel

● GIS

● Retail 1

● Retail 2

Configure your printer

Connect the printer to your network
The printer is able to configure itself automatically for most networks, in a similar way to any computer in 
the same network. The first time you connect it to a network, this process may take a few minutes.
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Once the printer has a working network configuration, you can check its network address from the 
control panel: tap the Menu icon , then Info > Connectivity, or in the status center by swiping the top 
part of the screen.

TIP: Consider making a note of the printer’s IP address, because you may need it during the setup 
process of connecting your Windows or macOS computer clients.

Modify the network configuration
You can modify the current network configuration from the control panel.

Tap the Menu icon , then the Settings icon , then Network > Ethernet. From here it is possible, 
though not normally necessary, to change the settings manually; this can also be done remotely using 
the Embedded Web Server.

For full details of the available connectivity settings, see Networking on page 51.

If you accidentally misconfigure the printer’s network settings, you can restore the network settings to 
their factory values from the control panel: tap the Menu icon , then the Settings icon , then 
Network > Restore Network Settings. Then you must restart the printer. This automatically provides a 
working network configuration for most networks. The printer’s other settings remain unchanged.

Install your printer under Windows
The instructions apply if you intend to print from software applications using a printer driver.

See Printing on page 57 for alternative ways of printing.

Before you begin, check your equipment:

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your 
network on page 14).

Now you can proceed to install the printer software and connect to your printer.

1. Make a note of the printer’s host name and IP address from the control panel (see Connect the 
printer to your network on page 14).
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2. Install the printer software from the HP website at the following link: 
http://www.hp.com/go/DesignJetXL3800/software, following the software installation instructions. 
By default, the following driver is installed:

● Windows 7 or Windows Server 2008R2: The generic HP DesignJet driver

● Windows 8, Windows Server 2012, or later: The PDF driver (recommended) or PCL3 driver

3. Once downloaded, open it, and follow on-screen steps.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, 
which helps you to try to find your printer. If you have a firewall in operation; you may have to disable 
it temporarily in order to find the printer. You also have the options of searching for the printer by its 
hostname, IP address or MAC address.

Uninstall the printer software under Windows
Use the Control Panel to uninstall the software, in the same way as you can uninstall any other software.

Install AirPrint under macOS
Before you begin, check your equipment.

● The printer should be set up and on.

● The Ethernet switch or router should be on and functioning correctly.

● The printer and the computer should be connected to the network (see Connect the printer to your 
network on page 14).

Now you can proceed to install the printer software and connect to your printer.

1. Go to the control panel and tap the Menu icon , then Info > Connectivity > Ethernet to localize 
your printer’s Bonjour name.
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2. Check that your Mac and printer are both connected to the same network, then go to System 
Preferences > Printers and Scanners, and tap the Add icon  to add a new printer.

3. Tap  and add the Bonjour name (C000F0) into the search box (alternatively the  icon can be 
selected and the IP address inserted).

Install AirPrint under macOS 17



4. Your printer will appear under Name, (you can edit it if you like).

5. In the Use menu, select Secure AirPrint or AirPrint, and tap Add.
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6. Your printer now appears in the list of printers.

Connect a computer to the printer by network (macOS)
HP Click is the recommended way to connect with your printer to a network.

See the HP website at the following link: http://www.hp.com/go/clickDesignJet for installation 
instructions.

Set up printer services
A network connection is required, so the printer will test its own connectivity. Remember to connect the 
network cable to the printer.

You can set up the following services:

● Receive automatic firmware updates

● Enable additional printer services

Each printer service can be enabled or disabled individually as explained below.

During initial printer setup, you are asked whether you want to enable these services.

Configure firmware updates
You can choose from the Embedded Web Server or from the control panel whether and how to 
download firmware updates.

● In the Embedded Web Server: Click General > Firmware Update

● At the control panel: Tap the Menu icon , then the Settings icon , then Firmware update

The following settings are available:

● Auto update (recommended): The printer will inform you when new firmware is available

● Notify
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● Do not check

LDAP Configure the email address book
The printer uses Lightweight Directory Access Protocol (LDAP), which provides access to a network 
address book for scan-to-email and authentication purposes.

The following instructions explain how to use LDAP to connect the printer to a network email address 
book, and to authenticate users of the printer using their LDAP credentials.

Information needed before starting

Ensure that you have the all the required information before you start the configuration.

You need:

● Server address (hostname or IP)

● Server authentication requirements

● Path to start search (BaseDN, Search Root) (for example, o=mycompany.com)

● Attributes for matching the name entered (such as cnor samAccountName), retrieving the email 
address (such as mail), and how the name will be displayed on the control panel (such as 
displayName)

Address book setup

In the Embedded Web Server, click Contacts >Address book. Here you can configure the printer to 
obtain email addresses from an LDAP server, so that they are available when users perform a search 
from the Scan to Email screen.

Do the following:

1. Open the Embedded Web Server.

2. Click Contacts >Address book.

3. Enable the LDAP server (mandatory to continue with the LDAP configuration).

Network Directory Server section:

4. Select the LDAP in the Manage address book table and edit the configuration.

5. In the Network Directory Server section, enter the name of the LDAP server address (for example, 
ldap.mycompany.com) and Port.

Server Authentication requirements section:

6. In the Server authentication requirements section you can select the appropriate authentication 
type in the server (Windows credentials, LDAP Administrator's credential, use printer user’s 
credentials). It is mandatory to fill the Domain name, Username, and password.

LDAP Database search settings section:

7. Fill in these fields:

● In the path to start a search (BaseDN, Search Root) box, enter the path to start searching the 
database (for example, o=mycompany.com).
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● In the recipient's display name box, enter the name of the attribute that contains the person's 
name (for example, displayName).

● In the recipient's email address box, enter the name of the attribute that contains the person's 
email address (for example, mail or rfc822Mailbox).

● Use the LDAP filter condition box to set up an optional filter to filter out e-mail addresses.

8. Click the Apply button to save the settings. Setup is complete.

9. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network 
contact name in the Test box, and then click the Test button. If the test is successful a message is 
displayed.

Configure a network folder
There are three different ways to configure a network folder.

Configure a default network folder

The printer has the option to configure a default network folder that will be used as the default 
destination in the Scan to Network widget and in the Scan to Network folder application.

1. In the Embedded Web Server, click Scan > Scan to network folder.

2. Click Specify network folder in the configuration options to create a new folder from scratch, or 
click Contact to select an existing folder from the printer’s contacts (see Configure a network folder 
as a contact on page 22).
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3. If you clicked Specify network folder, fill in the requested information to finish the process.

There are two sign-in methods:

● Use the credentials of the user currently signed in (default). If you use it from the control panel, 
the control panel may also request credentials.

● Use the following credentials. In this case, the control panel will not request further credentials.

4. Click Apply to finish the process. The default network folder will now be available and visible to the 
printer.

Configure a network folder as a contact

A network folder can be configured as a contact from the Contacts tab in the Embedded Web Server.
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1. On the Contacts page, click the person icon with a + sign.

2. In the dialog box, activate the Network folder toggle to be able to input the network folder 
information.

3. Click Add to finish the process.

The contact will now be updated and accessible from the control panel.

Network folder configuration for a Quick Set

When configuring a network folder as a Quick Set, this folder will be accessible only when using the 
specific Quick Set in the printer’s control panel.

In the Embedded Web Server, click Quick Sets.

See Embedded Web Server on page 35.

On the Quick Sets page, click the plus icon . In the table, in the Quick Set Type box, click Network 
folder and then Next. Follow the flow to configure the network folder (5 steps):
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Step 1: Name

● Quick Set name

● Quick Set description

● Quick Set start option

Step 2: Network folder options

● Network folder path or device user’s home folder attribute

● Sign-in method

– Use credentials of the user currently signed in (default)

– Use the following credentials

● Windows domain

● User name

● Password

● Security PIN

Step 3: Options

● Content type

● Original paper type

● Color mode

● Resolution

● Auto-release original

● Long original

● Black enhancement

● Automatic de-skew

● File name

● File type

● File name preview

● File size

● Output size

Step 4: Summary

Step 5: Finish

For a network folder, enter the remote computer’s name or IP address, the shared folder’s, and the 
username and password of the user already created on the remote computer. Leave the user domain 
field empty unless the user is a member of a Windows domain. If the user is only a local user of the 
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remote computer, leave the field empty. You can use the name (instead of the IP address) in the server 
name field, only if the shared folder is on a Windows computer in the same local network.

● Click Next to save the configuration.

NOTE: If the product has already been configured for scanning to network/printing from networks 
and you now want to use a different shared folder, click the Modify icon .

You can check that the shared folder remains accessible by clicking Verify in the network-folder Quick 
Set configuration flow, step 2 during Quick Set creation or at any time by modifying it (reaching step 2). A 
correctly configured shared folder can become inaccessible if the user’s password is changed, or if the 
shared folder is moved or deleted.

Example: Create a network folder under Windows

Set up a shared network folder in the Windows operating system.

1. Create a new user account on the remote computer. You can use an existing user account for this 
purpose, but it is not recommended.

2. Create a new folder on the remote computer, unless you want to use an existing folder.

3. Right-click the folder and click Properties.

4. In the Sharing tab, click the Advanced Sharing button.
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5. Ensure that the user has the correct permission settings depending of the functionality use of the 
network folder. If you configured a scan-to-folder, you need to ensure full read/write control over the 
shared folder so that the user(s) can add files to folder. To do this, click Permissions and grant Full 
Control to the user (or to any suitable group that includes that user). If the user(s) is going to use the 
folder to print documents, a read-only permission is enough.
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6. For scanner users, If there is a Security tab in the Properties window for your folder, then you must 
also grant the same user Full Control over the folder in the Security tab. Only some file systems 
such as NTFS require this.

Example: Create a network folder under macOS

Set up a shared network folder in macOS.

1. Create a new user account for the User on the remote computer. You can use an existing user 
account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, macOS users have a Public folder 
that can easily be used for this purpose.

3. Open the System Preferences application and click the Sharing icon.

4. Depending of the functionality of the folder, make sure the user has the right permissions. For 
scanning purposes, Read & Write is needed to access the folder.
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5. Click Options.

6. Check the Share files and folder using the SMB box, and make sure that the scanner user is 
checked in the On column.

7. Click Done. You can now see file sharing enabled and Windows sharing on.

8. You must configure the printer to send scans to the folder.

Access Control

Manage printer security with HP Command Center
If you are the printer administrator, you can manage printer security or change your printer status to 
lock mode by visiting HP Command Center.

Go to the HP Command Center at the following link: https://www.hp-commandcenter.com/.
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You can also change your printer’s configuration and manage print jobs from there. On your first visit, 
you will need to create an account at HP Command Center using the printer’s code.

Embedded Web Server - Security

Password Settings

From the Embedded Web Server menu, you can click Security > Password Settings and then Admin 
Account Password to control access to the printer (by specifying an administrator account), the 
Embedded Web Server, and the printer control-panel.

Access Control - Permissions

You can set sign-in requirements for specific tasks, and restrict access by users who have not signed in 
(Guests) to specific features. Permissions can be applied to local user accounts stored on the printer.

Access Control - Printer User Accounts

In the tab Printer User Accounts, the administrator can create new printer user accounts and assign 
them specific permissions depending on their role.

To create a new printer user account, tap the Add New icon  at the top of the page. Now fill in the 
fields: User Name, Display Name, Network Name, Permission Set, Email Address, and Password. Press 
Add to create the new account.

Share the access code with the user. When using device user accounts, users sign in to the device using 
an access code.

LDAP – sign-in server

Information needed before starting

Ensure that you have the all the required information before you start the configuration.

You need:

● Server address (hostname or IP).

● Server authentication requirements.

● Path to start search (BaseDN, Search Root) (for example, o=mycompany.com).
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● Attributes for matching the name entered (such as cnor samAccountName), retrieving the email 
address (such as mail), and how the name will be displayed on the control panel (such as 
displayName).

Setup

In the Embedded Web Server, click Security > Access Control > LDAP Setup.

1. Enable the LDAP server (mandatory to continue with the LDAP configuration).

LDAP sign-in setup:

2. In the Network Directory Server section, enter the name of the LDAP server address (for example, 
ldap.mycompany.com) and Port.

● If you do not know the LDAP server, contact the server administrator.

● If you want to enable a secure (SSL) connection, enable the toggle Use a secure connection 
(SSL).

Server authentication requirements section:

3. In the Server authentication requirements section you can select the appropriate authentication 
type in the server (use printer user’s credentials, use LDAP administrator’s credentials). It is 
mandatory to fill the Domain name, Username, and password.

LDAP Database search settings section:

4. Fill in these fields:

● In the Bind and search root enter the path to start searching the database (for example, 
o=mycompany.com).

● In the Retrieve the printer User’s Name using this attribute box enter the name of the attribute 
that contains the person's name (for example, displayName).

● In the Match the name entered with this attribute box enter the name of the attribute which its 
content should be matched with the username type during sign-in.

● In the Retrieve the Users Email Address using this attribute box, enter the name of the attribute 
that contains the person's email address (for example, mail or rfc822Mailbox).

● In the Retrieve the printer user group using this attribute box enter the name of the attribute 
that contains the groups the person belongs to.

5. Click the Apply button to save the settings. Setup is complete.

6. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network 
contact name in the Test box, and then click the Test button. If the test is successful a message is 
displayed.

Windows sign-in configuration

Information needed before starting

Ensure that you have the all the required information before you start the configuration

You need:

● Windows domain.
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● Attributes for matching the name entered (such as cnor samAccountName), retrieving the email 
address (such as mail), and how the name will be displayed on the control panel (such as 
displayName).

Setup

In the Embedded Web Server, click Security > Access Control > Windows Authentication.

1. Enable Windows sign-in status (mandatory to continue with windows sign-in configuration).

Windows authentication configuration:

2. Enter the name of the Default Windows Domain (for example, mycompany.com).

● If you do not know the Windows domain, contact the server administrator.

● If you want to enable a secure (SSL) connection, enable the toggle Use a secure connection 
(SSL).

3. In the Match the name entered with this attribute box, enter the name of the attribute; its content 
should be matched with the username type during sign-in.

4. In the Retrieve the Users’ Email Address using this attribute box, enter the name of the attribute 
that contains the person's email address (for example, mail or rfc822Mailbox).

5. In the Retrieve the printer User’s Name using this attribute box, enter the name of the attribute that 
contains the person's name (for example, displayName).

6. Click the Apply button to save the settings. Setup is complete.

7. To check that the LDAP retrieval is set up correctly, enter at least three characters of a network 
contact name in the Test box, and then click the Test button. If the test is successful a message is 
displayed.

Certificate management
You can configure the printer´s identity certificate, and the list of trusted certification authorities (CA), in 
EWS > Security > Certificate Management. These certificates are used to establish trusted and secure 
connections with external servers.

Other Embedded Web Server security settings
In the Embedded Web Server menu Security > Printer Features, you can customize your printer if you 
enable or disable features from the list below. A feature is no longer available after has been disabled it.

● Host USB Plug and Play: to enable/disable firmware update diagnostic package

● Print from USB

● Print from Network Folder

● Scan to USB

● Scan to Network Folder

● Color Copy
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Control-panel security settings

From the control panel, you can tap the Settings icon , then Security, to control some of the features 
of the printer.

You can control:

● Security settings

● Cloud services

– Enter Setup Flow

– Removal Confirmation

● AutoSend

– < enable/disable >

● Printer Data Sharing Agreement

– Privacy statement

– PDSA flow

● USB mass storage < On, Off >

● Embedded Web Server < On, Off >

● User session timeout

– None

– 1 minute

– 3 minutes

– 5 minutes

● Printer access control < On, Off >

If an administrator password has been set, it must be given in order to perform the following operations:

● Change the security settings (including the administrator password itself).

● Change the configuration of the Internet connection.

● Change the automatic firmware update configuration.

● Enable or disable automatic downloading and/or installation of automatic firmware updates.

● Reset factory defaults.

NOTE: The administrator password can contain only characters that appear on the control panel’s 
on-screen keyboard. If you set a new password with the Embedded Web Server, it will reject characters 
that do not appear in that limited character set.
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Job Storage security options
Use Required account ID and PIN Printing to control who has access to your printer and confidential 
documents.

Required account ID

If you want to keep records of printer usage by different users, you can set your printer to require an 
account ID for each job. At the control panel, tap the Settings icon , then Job management > Account 
ID required.

If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept 
"on hold for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for 
accounting" by the printer, you can introduce the account ID in the driver or control panel, by going to the 
job queue and clicking the job that is on hold. A window with a text box is displayed and you can enter the 
account ID into it.

Encrypted PIN Printing

Protect confidential prints, and reduce the risk of leaking sensitive data with Pin Printing.

Send jobs to print from the driver, encrypted, and with a pin. From the driver go to the Storage tab, select 
Retrieve from Control Panel (private job), enter a 4 digit pin, then go to the printer, insert the pin in the 
control panel and retrieve the printed job.

Drivers
You may wish to install one or several drivers according to your needs.

There are various different drivers for your printer; which is best for you depends on your circumstances:

● Your operating system

● The type of applications from which you print

● The number of printers you have

● The output accessories you have

You can get the latest driver software from the HP website at the following link 
http://www.hp.com/go/DesignJetXL3800/drivers/.

Set Windows driver preferences
You can change some default settings in your printer driver according to your own preferences, for 
instance to set color or paper-saving options. To do this, click the Start or Search button on your 
computer's screen, then click Devices and Settings or Devices and Printers. In the next window, right-
click your printer's icon, and click Printing Preferences.

Any settings you change in the Printing Preferences window will be saved as default values for the 
current user.

To set the default values for all users of your system, right-click the printer's icon, click Printer Properties, 
go to the Advanced tab, and click Printing Defaults. Any settings you change in the printing defaults will 
be saved for all users.
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Change the graphic language setting
You can change the graphic language setting from the control panel.

Tap the Settings icon , then Default printing configuration > Graphics language.

Then select one of the following options:

● Select Automatic to let the printer determine which type of file it is receiving. This is the default 
setting; it works for most software applications. You should not normally need to change it.

● Select PDF only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select HP-GL/2 only if you are sending a file of that type directly to the printer, without going through 
a printer driver.

● Select CALS/G4 only if you are sending a file of that type directly to the printer, without going 
through a printer driver.

● Select TIFF only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

● Select JPEG only if you are sending a file of that type directly to the printer, without going through a 
printer driver.

Mobile printing
With HP Mobile Printing Solutions, you can print straight from your smartphone or tablet in just a few 
simple steps wherever you are using your mobile device.

● HP app enhances your printing capabilities and enables scanning and sharing from your 
smartphone or tablet.

– You can obtain the latest iOS version from the Apple iTunes website at 
https://itunes.apple.com/app/id469284907.

– You can obtain the latest Android version from the Google Store website at 
https://play.google.com/store/apps/details?id=com.hp.printercontrol.

● Apple iOS printing is enabled through AirPrint, which comes pre-installed in iOS devices.

● For ChromeOS printing, you can use the Chrome Native Print system, which comes pre-installed in 
ChromeOS devices.

● For Android printing:

– Install the HP Print Service app. If you have already installed it, check that it is 
up to date. You can obtain the latest version from the Google Play website at 
https://play.google.com/store/apps/details?id=com.hp.android.printservice.

– Alternatively, you can install the Mopria Print Service plugin. You 
can obtain the latest version from the Google Play website at 
https://play.google.com/store/apps/details?id=org.mopria.printplugin.

– You can also print using the Android Default Print Service, which comes preinstalled in Android 
devices.
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For more information, visit the HP website at http://www.hp.com/go/designjetmobility.

Accessibility

Control panel
If required, the control-panel display brightness and the loudspeaker volume can be changed.

See Change system options on page 10.

Embedded Web Server
From the Embedded Web Server, you can see the status of the printer, and perform other actions 
without using the control panel.

For information about the accessibility features of the Embedded Web Server, click Accessibility.

See the HP website at the following link: http://www.hp.com/hpinfo/abouthp/accessibility/ for information 
about the HP Accessibility Program, and HP's commitment to making its products and services 
accessible to people with disabilities.

Other sources of information
Documents can be downloaded from HP Customer Support.
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Paper handling2

General information and tips
The most important features are listed to help you when using paper. Follow the suggestions for best 
practices and the most economical paper management when using your printer.

● All paper widths must be between 279.4 mm (11 in) and 914 mm (36 in), and the roll core must be 76 
mm (3 in) in diameter.

● When handling photo paper, wear cotton gloves to avoid transferring oils onto the paper.

● Each drawer can be loaded with 1 paper roll.

● Each drawer has lights to communicate its status:

Drawer icon light

– Off: There is no roll.

– On (yellow): The roll is running out of paper.

– On (red): The roll is out of paper.

– On (white): Do not open the drawer. Paper is loaded, and it could cause a paper jam.

● You can save paper by using the appropriate settings

● The printer automatically estimates the remaining length of the roll

NOTE: For an accurate estimation of the remaining roll length, you must enter the roll length when 
loading the roll. To update this setting at any time, tap the Paper icon , then Modify, select the 
paper length, and tap the roll whose length you want to assign.
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Paper status
The paper source displays the status of the drawers in your printer, and a status message for each roll.

The status messages are:

● Low on paper

● Out of paper

● Paper not loaded

● Standby

● Calibration pending

● Check pending

● Unsuccessful load

● Hardware malfunction

● Ready

● Error

Load a roll
Start the paper app to access the paper menu, then tap Load on the roll you want (1 or 2).

TIP: If the printer is not printing and the lock light on the drawer is off, you can skip going to the paper 
app and go straight to step one below.

1. Open the drawer.

WARNING! Do not stand on the drawer: the printer could fall over.

CAUTION: Do not leave the roll on top of the scanner.

TIP: You can load more than one roll at the same time.

TIP: Load heavier rolls in upper drawers; they can weigh up to 18 kg (40 lb).
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2. Open the locking lever on the right hub.

3. Move the hub outwards to make room for the roll.

4. Open the locking lever on the left hub.
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5. Take the roll with the paper edge as shown.

Load the roll at an angle, like this:
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6. Slide the hub back towards the center so that it engages with the roll.

7. Ensure that the hubs are fitted tightly to the roll on both sides.
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8. Close the left locking-lever. The hub engages the roll core to ensure precise roll management.

9. Feed the paper into the slot.

TIP: Do not stop feeding until the paper is automatically advanced.

10. Continue feeding until you hear a beep.
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11. Close the drawer.

12. Select the paper type by tapping the card of the roll you just loaded. It will open a list of papers and 
paper lengths from which you can choose. The control panel remembers the last paper type loaded 
in this position, in case that helps. You can add the length of the roll manually in the control panel.

NOTE: If you loaded two rolls at the same time, the printer asks you to select the paper type for 
both rolls.

TIP: Whenever possible, keep the loading table in the position shown below. For narrow papers, for 
which this position is not possible, move it to the middle of the roll.

TIP: If the leading edge of the paper is not a clean cut, you can trim it using the manual cutter, with 
the rail in the drawer as a support.

42 Chapter 2  Paper handling



TIP: If required, the roll can be left in the drawer as shown below, in order to help you with the 
loading process.

13. When you are ready, tap Finish and Check. The printer checks the position, width and length of all 
the loaded rolls.

TIP: Batch loading: You can load more than one roll at the same time. Load them into each drawer and 
tap Finish and Check. The printer automatically finishes loading both rolls and leaves them ready to 
use.

If you have any issues loading paper, see Paper cannot be loaded successfully on page 179.

Unload a roll
Ensure that the printer is not printing and that the lock light on the drawer is off before you unload a roll.

1. If the lock light is on, go to the control panel and tap the Paper icon  then Unload.

2. Open the drawer.
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WARNING! Do not stand on the drawer: the printer could fall over.

3. Open the locking lever on the left hub.

4. Open the locking lever on the right hub.

5. Slide the right hub to the side so that you can remove the roll.

6. Remove the roll.
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7. Close the left locking-lever and close the drawer.

Paper options
A variety of options are available in the control panel.

To see the paper options, in the control panel, tap the Paper icon .

Then:

● Modify: You can modify the loaded paper type.

● Move and cut (bottom left corner button): You can move and cut the paper manually (see Move the 
paper on page 48).

You can find more specific paper options in the control panel. Tap the Menu icon , then the Settings 

icon , then Paper selection and productivity. There you find:
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● Job autorotation

● Automatic roll selection. Default options being:

– Print on same size only

– Print on same size or larger

● Use most depleted roll

● Paper type protection: Protects selected paper types to avoid printing on them unintentionally

Store paper
To maintain paper quality, always store rolls in the original packaging within the temperature and 
humidity range specified on the paper label.

Also, follow these recommendations:

● When natural tracing paper is stored in a humid environment, its width when loaded can vary, and 
it may even jam in the printer. To avoid this, store this kind of paper in its packaging in humid 
conditions. Remove it from the printer in conditions of low temperature and high humidity (such as 
15°C and 80% relative humidity). If you see that the paper has been affected by humidity, cut off the 
beginning of the roll: about 8 m (26 ft).

● Store rolls covered by another piece of paper or cloth.

● Allow all papers to adapt to room conditions, out of the packaging, for 24 hours before using them for 
printing.

● The use of tape to stick the leading edge of the roll to the core is especially important for heavy 
papers, because the inherent stiffness of the paper can cause it to loosen and unwind from the 
core.
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Cannot load paper
See troubleshooting: Paper cannot be loaded successfully on page 179.

Paper presets
Each supported paper type has its own characteristics. For optimum print quality, the printer changes 
the way it prints on each different paper type.

For example: Some may need more ink and some may require a longer drying time. So the printer must 
be given a description of the requirements of each paper type. This description is called the paper 
preset. The paper preset contains the ICC profile, which describes the color characteristics of the paper; 
it also contains information on other characteristics and requirements of the paper that are not directly 
related to color. Existing paper presets for your printer are already installed in the printer's software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer contains 
paper presets only for the most commonly used paper types. If you have a paper type for which your 
printer has no preset, you cannot select that paper type in the control panel.

You can download additional paper presets from the Web and install them. See Install a downloaded 
paper preset on page 47.

Install a downloaded paper preset
If you do not find the paper preset you want on the Web, you may find that it has been added to the latest 
firmware for your printer.

NOTE: You can check the firmware release notes for information, see Update the firmware - HP 
DesignJet XL 3800 Multifunction Printer Series on page 146.

1. Find the right paper preset from the Global Brand Management Group website at 
http://www.globalbmg.com/hp/paperpresets, or the paper manufacturer’s website, then click the 
Download Now button and save the paper preset (an .oms file) on your computer.

2. Before starting to install the new preset, make sure that the printer is idle and the print queue is 
stopped. Installing a new paper preset will interrupt any printing that is in progress.

3. In the Embedded Web Server, click the Paper tab. In the Paper Management section, click the 
Import Paper preset tab.

4. On the Import page, select the paper preset file that you downloaded in step 1.
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5. Click the Import button and wait for the update process to finish. It may take some time.

6. Check that the new paper type appears in the Additional paper or Custom paper category in your 
printer’s control panel. It will appear automatically in the paper-type list in the Windows printer 
driver.

Now that you have imported the paper preset, you can select the paper type from the control panel and 
from the driver.

Move the paper
If the printer is idle (ready to print), you can move the paper forwards or backwards from the control 
panel.

You may want to do this in order to have more or less white space between the last print and the next 
one when the cutter is disabled; or to increase the top margin of the next print.

To move the paper, in the control panel, tap the Paper icon  and then tap the Move and cut icon . 
You can use the Advance, Rewind and Cut buttons to move the paper forward or backwards and cut it as 
desired.

Maintain paper
To maintain paper quality, always follow the recommendations.

Make sure you:

● Store rolls covered by another piece of paper or cloth

● Store cut sheets covered and clean or brush them before loading them in the printer

● Clean input and output platens

● Keep the scanner lowered unless you need to lift it for some reason

NOTE: Photo and coated paper require careful handling, see Print is scuffed or scratched on page 
201.

Turn the automatic cutter on and off
You turn the printer’s paper cutter on or off from the control panel.

Tap the Menu icon , then the Settings icon , then Output destinations, to see the horizontal cutter 
control.

The default setting is On.

If the cutter is turned off, it does not cut the paper between jobs, but continues to cut the paper on 
loading, unloading, switching between rolls.

Advantages of a multiroll printer
A multiroll printer can be useful in several different ways.
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Such as:

● The printer can automatically switch between different paper types according to your needs.

● The printer can automatically switch between different paper widths according to your needs. This 
enables you to save paper by printing smaller images on narrower paper.

● If you load two identical rolls into the printer, you can leave it printing unattended for a long time, 
because it can switch from one roll to the other automatically when the first is exhausted. See 
Unattended printing/overnight printing on page 68.

The current status of both rolls is shown on the control panel if you tap the Paper icon .

NOTE: If a paper type is protected from use, it can be printed on only when it is explicitly specified in 
the job. See Protect a paper type on page 68.

NOTE: If you use a paper not supported by your printer, you may find that automatic switching is 
disabled, in which case jobs sent to the standby roll are put on hold until the roll is manually unloaded.

NOTE: When you print from a USB flash drive, multiroll printing is considerably simplified: either you 
specify manually which roll you want to use, or you can select Save paper, in which case the printer 
chooses the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls
When you submit a print job from the printer driver, you can specify (using the Paper type or Type is 
option) that you want it to be printed on a particular paper type.

You can even specify (using the Paper source, Source is or Paper Feed option) that you want it to be 
printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for 
a paper roll large enough to print the image without clipping.

● If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy.

● If just one of the rolls is suitable for the job, it will be printed on that roll.

● If neither roll is suitable for the job, it will be put on hold for paper, or printed on an unsuitable roll, 
depending on the paper mismatch action. See Solve paper mismatch on page 76.

The printer driver for Windows will tell you which paper types and widths are currently loaded in the 
printer, and on which rolls.

Here are some settings that may be used in typical situations.

NOTE: The Paper settings are in the printer driver; the Roll switching policy is set in the control panel.

● With different paper types loaded:

– Paper types: select the paper type you require

– Paper source: Use printer settings

– Roll switching policy: doesn’t matter

● With different paper widths loaded:

– Paper type: Use printer settings
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– Paper source: Use printer settings

– Roll switching policy: Minimize paper waste

TIP: You can also save paper in some cases by rotating or nesting your images. See Use paper 
economically on page 65.

● With identical rolls loaded:

– Paper type: Use printer settings

– Paper source: Use printer settings

– Roll switching policy: Minimize roll changes

50 Chapter 2  Paper handling



Networking3

Introduction
The printer provides a single RJ-45 connector port for a network connection. In order to meet Class B 
limits, the use of shielded I/O cables is required.

The device supports connection to IEEE 802.3 10Base-T Ethernet, IEEE 802.3u 100Base-TX Fast Ethernet 
and 802.3ab 1000Base-T Gigabit Ethernet compliant networks. When connected and powered on, the 
printer auto-negotiates with your network to operate with a link speed of 10, 100, or 1000 Mbps, and to 
communicate using full- or half-duplex mode. However, you can manually configure the link using the 
printer's control panel, or through other configuration tools once network communication is established.

The printer can support multiple network protocols simultaneously, including TCP/IPv4 and TCP/IPv6. For 
security, it includes features to control IP traffic to and from the printer and supports configuration of IP 
Security (IPsec) protocols.

Control network protocols
The printer can simultaneously support multiple network communication protocols. This allows network 
computers that may be using different protocols to communicate with the same printer.

Each protocol may require some configuration before the printer can communicate on the network. 
For some protocols, required parameters are automatically sensed and user-specified settings are not 
needed. However, for other protocols, there may be many parameters to configure.

Enable or disable network protocols
If a network protocol is enabled, the printer may actively transmit on the network even when there are no 
computers on the network that use the protocol. This may increase network traffic.

To eliminate unnecessary traffic, you can disable unused protocols. Disabling unused protocols lets you:

● Reduce network traffic by eliminating broadcast messages from unused protocols

● Provide better control over who prints to the printer by eliminating users from other networks who 
might route print jobs to this printer

● Display protocol-specific error conditions for enabled protocols only

To disable unused protocols through the device’s control panel menu, see Control-panel menu items on 
page 51.

Control-panel menu items
You can access the printer network configuration settings from the control panel.

Tap the Menu icon , then the Settings icon , then Network > Ethernet.
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Table 3-1 Control-panel menu items

Menu item Sub-menu item Sub-menu item Values and description

TCP/IP Host Name N/A An alphanumeric string, up to 32 characters, used to identify the device. This name 
is listed on the HP Jetdirect configuration page. The default host name is NPIxxxxxx, 
where xxxxxx is the last six digits of the LAN hardware (MAC) address.

TCP/IP IPV4 Settings Config Method Specifies the method that TCP/IPv4 parameters will be configured.

DHCP (default): Use DHCP (Dynamic Host Configuration Protocol) for automatic 
configuration from a DHCPv4 server. If selected and a DHCP lease exists, DHCP 
Release and DHCP Renew menus are available to set DHCP lease options.

Auto IP: Use automatic link-local IPv4 addressing. An address in the form 169.254.x.x is 
assigned automatically.

Manual: Use the Manual Settings menu to configure TCP/IPv4 parameters.

TCP/IP IPV4 Settings Manual 
Settings

(Available only if Config Method is set to Manual) Configure parameters directly from 
the printer control panel:

IP Address: The unique IP address of the printer (n.n.n.n).

Subnet Mask: The subnet mask for the printer (n.n.n.n).

Default Gateway: The IP address (n.n.n.n) of the gateway or router used for 
communications with other networks.

TCP/IP IPV4 Settings Primary DNS Specify the IP address (n.n.n.n) of a Primary DNS Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Precedence table, configured through the embedded Web server.

TCP/IP IPV4 Settings Secondary 
DNS

Specify the IP address (n.n.n.n) of a Secondary Domain Name System (DNS) Server.

NOTE: This item appears only if Manual configuration is a higher priority than DHCP in 
the Config Precedence table, configured through the embedded Web server.

TCP/IP IPV6 Settings Enable Use this item to enable or disable IPv6 operation on the print server.

Off: IPv6 is disabled.

On: IPv6 is enabled.

TCP/IP Proxy Server N/A Specifies the proxy server to be used by embedded applications in the device. A proxy 
server is typically used by network clients for Internet access. It caches Web pages, 
and provides a degree of Internet security, for those clients.

To specify a proxy server, enter its IPv4 address or fully-qualified domain name. The 
name can be up to 255 octets.

For some networks, you may need to contact your Independent Service Provider (ISP) 
for the proxy server address.

TCP/IP Proxy Port N/A Type the port number used by the proxy server for client support. The port number 
identifies the port reserved for proxy activity on your network, and can be a value from 
0 to 65535.

Security IPSEC N/A Specify the IPsec or Firewall status on the print server.

Keep: IPsec/Firewall status remains the same as currently configured.

Disable: IPsec/Firewall operation on the print server is disabled.

Security 802.1x N/A N/A

Security Enable Wipe N/A N/A
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Table 3-1 Control-panel menu items (continued)

Menu item Sub-menu item Sub-menu item Values and description

Reset Security N/A N/A Specify whether the current security settings on the print server will be saved or reset 
to factory defaults.

No (default): The current security settings are maintained.

Yes: Security settings are reset to factory defaults.

Link configuration methods
The printer supports 10, 100, or 1000 Mbps network link speeds using full-duplex or half-duplex 
communication modes (a 1000T half-duplex selection is not supported). By default, it will attempt to 
auto-negotiate its link operation with the network.

When connecting to network hubs and switches that do not support auto-negotiation, the printer will 
configure itself for 10 Mbps or 100 Mbps half-duplex operation. For example, when connected to a non-
negotiating 10 Mbps hub, the print server will automatically set itself to operate at 10 Mbps half-duplex.

If the printer is not able to connect to the network through auto-negotiation, you can set the link setting 
by one of the following methods:

● The Embedded Web Server

● Network management tools such as HP Web Jetadmin

Troubleshooting

Reset network parameters
If you accidentally misconfigured the printer’s network settings, they can be reset to factory default 
values from the control panel.

Tap the Menu icon , then the Settings icon , then Network > Restore network settings.

CAUTION: A factory-installed HP X.509 certificate will be saved during reset to factory default values. 
However, a Certificate Authority (CA) certificate that has been installed by the user to validate a 
network authentication server will not be saved.

Link troubleshooting
If a link failure is indicated, try the following:

The printer has status lights (LEDs) beside the network connector that indicate the link status and 
network activity.

● When the green light is on, the printer has successfully linked to the network.

● When the yellow light is blinking, there is network transmission activity.
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If the printer does not successfully connect to the network:

● Both LEDs will be off.

● The alert No network cable connected will appear on the control panel.

1. Check the cable connections at both ends.

2. Consider replacing the cables by known good ones.

3. Consider switching to another network connector in the network switch, hub, or device to which the 
printer is connected.

4. Manually configure the link setting to match the port configuration of the network hub or switch. 
For manual configuration methods, see Link configuration methods on page 53. Turn the printer off, 
then on again, to re-initialize the setting.

5. Print a Connectivity Configuration page and check link settings.

Table 3-2 Link Settings

Item Description

Port Config If the printer is properly linked, this item has one of the following values:

● 10BASE-T HALF: 10 Mbps, half-duplex

● 10BASE-T FULL: 10 Mbps, full-duplex

● 100TX-HALF: 100 Mbps, half-duplex

● 100TX-FULL: 100 Mbps, full-duplex

● 1000TX FULL

If the printer is not properly linked, one of the following messages will appear:

● UNKNOWN: The printer is in an initialization state.

● DISCONNECTED: A network connection has not been detected. Check network cables. 
Reconfigure the link settings, or restart the printer.

Auto Negotiation Indicates whether auto-negotiation for link configuration is on or off.

● ON (default): The printer will attempt to automatically configure itself onto the network at the 
proper speed and communication mode.

● OFF: You must manually configure the link speed and communication mode using the control 
panel. Your settings must match those of the network for proper operation.

6. In case of doubt or misconfiguration of link settings, reset the network parameters to their factory 
settings. See Reset network parameters on page 53.

Communication failures between computer and printer
Some symptoms are:

● The control panel does not show the Received jobs message when you have sent jobs to the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.
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● Print jobs get stuck in your computer’s print spooler.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so 
on).

To solve a communication problem:

● Ensure that you have selected the correct printer when sending your job.

● Ensure that the printer works correctly when printing from other applications.

● If your printer is connected to your computer through any other intermediate devices, such as 
switch boxes, buffer boxes, cable adapters, or cable converters, try using it when connected directly 
to your computer.

● Try another network cable.

● Remember that very large prints may take some time to receive, process and print.

● If your printer displays warning or error messages that require action, take the required action 
before trying to print.

Cannot access the Embedded Web Server
Try these suggestions.

If you have not done so already, read Embedded Web Server on page 35.

1. Make sure that Embedded Web Server functionality is enabled in the printer: from the control panel, 
tap the Menu icon , then the Settings icon , then Security > Enable EWS.

2. Check the proxy configuration in your Web browser in case it is preventing communication with the 
printer.

3. Ensure that the printer works correctly when printing or accessed from other applications.

4. If the printer displays warning or error messages that require further action, take the action to 
resolve the problems.

5. If all else fails, turn the printer off and on again with the power key on the control panel.

Cannot access the printer from the HP Command Center
If you have not done so already, read the “HP Command Center” section.

See HP Command Center on page 11.

Print jobs take too much time to be received by the printer
If you send a very large print to the printer, there will normally be some delay before it starts printing. 
However, if you think you are experiencing abnormally long delays, there are various things you could 
check.

● Make sure the network cable connected to the printer is rated at least Cat5e.

● Make sure that gigabit-speed networking equipment and cabling interconnects your computer client 
to the printer.

● Make sure that there are no network link issues. See Link troubleshooting on page 53.
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● Take into account that, in network deployments with IPSec security protocols enabled and 
configured in the printer, network performance may be reduced due to the use of cryptographic 
algorithms to protect network communications.

● Try resetting the network configuration to its factory settings in order to get default settings that are 
suitable for most standard network environments. See Reset network parameters on page 53.

● You may also find it helpful to test connecting the computer to the printer directly, using a normal 
Ethernet (Cat5e or Cat6) cable point-to-point, without passing through an Ethernet switch or router. 
In this configuration, the printer and the computer should both automatically change their IPv4 
addresses to the form 169.254.x.x . In this point-to-point configuration you can discard any issues 
caused by other network equipment.
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Printing4

Introduction
There are various different ways in which you can choose to print, depending on your circumstances and 
preferences.

● Print a TIFF, JPEG, HP-GL/2, or PDF file directly from a computer connected to the printer, using 
HP Click. See the HP website at the following link: http://www.hp.com/go/clickDesignJet.

● Print a TIFF, JPEG, HP-GL/2, RTL, or PDF file directly from a USB flash drive. See Print from a USB 
flash drive on page 57.

● Print from HP SmartStream: See the HP SmartStream documentation on the HP website at the 
following link: http://www.hp.com/go/smartstreamdesignjet.

● Print any kind of file from a computer connected to the printer, using a software application that 
can open the file, and a printer driver supplied with your printer. See Print from a computer using a 
printer driver on page 59.

● Print from a smartphone or tablet. See Mobile printing on page 70.

● Print from a network folder. See Print from the network folder on page 58.

Print from a USB flash drive
1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, or PDF files into the 

printer’s USB port.

NOTE: The use of USB flash drives with your printer may be disabled by the administrator.

2. At the control panel, go to the home page and tap the Print icon .

3. Select Print from USB. You can tap folders to browse their contents. Files are shown as document 
thumbnails, and you can preview a file by tapping the preview icon. When the preview is displayed, 
you can zoom in and out.

4. Select a file to be printed. A preview of the document can be displayed by tapping Preview. Use the 
toolbar buttons to zoom in and out to see information about the selected job. You can also choose 
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the predefined zoom modes Fit to screen, Pinch to zoom or Original document size. Tap OK to go to 
the Quick Set selection.

5. The list of print-from-SUB Quick Sets is displayed. You can choose and/or edit one of the Quick Sets 
for the selected job.

NOTE: If you edit a Quick Set after selecting a job, the changed settings are applied only to the 
current job and are not saved permanently. You can change any of your own Quick Sets 
permanently by tapping Save.

NOTE: The factory Quick Sets cannot be modified.

The following settings are available:

● Quick Set name allows you to name the Quick Set you are working with.

● Print quality allows you to set the print quality to Fast, Normal, or Best.

● Output scale allows you to resize the print in two different ways: to a percentage of its original 
size, or to fit a particular paper size. The default is 100% (its original size).

● Color options allows you to choose color, grayscale, or black only.

● Paper source automatically selects roll 1 or roll 2.

● Paper category allows you to choose the type of paper.

● Page order allows you to choose first page on top, or last page on top.

● Collate allows you to turn collation on or off.

● Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, 
which rotates the print automatically if that will save paper.

● Print margins allows you to change the default printer margins.

● Output destination.

6. When you are satisfied with the Quick Set settings, tap OK to continue.

7. Copies, Page order, and Collate can be selected in the right column of the screen. Tap Print to 
continue.

8. After printing, you can choose to print another file or go to the job queue. If you print another file 
immediately without returning to the home page, the temporary settings used for the previous file 
are used again.

Print from the network folder
You can choose to print from a network folder, if it suits your circumstances and preferences.

1. At the control panel, go to the home page and tap the Print icon .

2. Select Print from network folder.

3. Select a file to be printed.
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4. The list of print-from-network Quick Sets is displayed. You can choose and/or edit one of the Quick 
Sets for the selected job.

NOTE: If you edit a Quick Set after selecting a job, the changed settings are applied only to the 
current job and are not saved permanently. You can change any of your own Quick Sets 
permanently by tapping Save.

NOTE: The factory Quick Sets cannot be modified.

The following settings are available:

● Quick Set name allows you to name the Quick Set you are working with.

● Print quality allows you to set the print quality to Fast, Normal, or Best.

● Output scale allows you to resize the print in two different ways: to a percentage of its original 
size, or to fit a particular paper size. The default is 100% (its original size).

● Color options allows you to choose color, grayscale or black only.

● Paper source automatically selects roll 1 or roll 2.

● Paper category allows you to choose the type of paper.

● Page order allows you to choose first page on top, or last page on top.

● Collate allows you to turn collation on or off.

● Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, 
which rotates the print automatically if that will save paper.

● Print margins allows you to change the default printer margins.

● Output destination.

5. When you are satisfied with the Quick Set settings, tap OK  to continue. You can tap the ellipsis 
icon , then Show Quick Set details panel to show the most common Quick Set settings used.

6. Copies, Page order, and Collate can be selected in the right column of the screen. Tap Print to 
continue.

7. After printing, you can choose to print another file or go to the job queue. If you print another file 
immediately without returning to the home page, the temporary settings used for the previous file 
are used again.

Print from a computer using a printer driver
This is the traditional way of printing from a computer.

The correct printer driver must be installed on the computer (see Install your printer under Windows on 
page 15), and the computer must be connected to the printer.

When the printer driver has been installed and the computer is connected to the printer, you can print 
from a software application by using the application's own Print command and selecting the correct 
printer.
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Default printing preferences
At the control panel, tap the Settings icon , then Print > Default print settings to define the default 
properties of jobs sent to your printer from remote locations.

You can define settings in the following areas: Print quality, Color, Paper, Margins, Print retrieval.

Advanced print settings
There are a relatively large number of advanced print settings that you can use when printing with a 
printer driver or from the control panel.

TIP: In general you are recommended to use the default settings unless you know that they do not 
meet your requirements.

TIP: If you intend to reuse a particular group of settings repeatedly, you can save those settings under 
a name of your own choice and recall them later. A saved group of settings is known as a ‘Quick Set’ in 
the Windows printer driver.

Select print quality
The printer has various print-quality options because best-quality printing requires some loss of speed, 
while fast printing implies some reduction in print quality.

Therefore, the print-quality selector is a slider that allows you to choose between Best and Fast. With 
some paper types, you can choose a compromise position between the two.

NOTE: In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom 
Print Quality Options dialog box (click Custom options > Settings).

You can select print-quality options in the following ways:

● In the Windows driver dialog:
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● Using the control panel: Tap the Settings icon , then Default printing configuration > Print quality.

NOTE: If the print quality is set from your computer, it overrides the print-quality setting in the 
control panel.

NOTE: You cannot change the print quality of pages that the printer is already receiving or has 
already received (even if they have not started to print yet).

Select paper size
The paper size specified here should be the paper size in which the document was created.

NOTE: It is possible to rescale the document to a different size for printing. See Rescale a print on 
page 65.

● In the Windows driver dialog:
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NOTE: If you are printing with the PDF driver and from Adobe Acrobat, the page size and 
orientation are determined automatically by the application based on the original page size of the 
PDF file. If you prefer to select the page size manually, go to Preferences in the driver dialog and 
enable Application automatic printing settings.

NOTE: If your application offers no Page Setup dialog, use the Print dialog.

● Using the control panel: tap the Settings icon , then Default printing configuration > Paper 
options > Paper size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the control 
panel.
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Custom paper sizes
Use the Windows driver dialog to customize paper sizes.

1. Go to Basic > Document size.

2. Open the drop-down list, scroll down to the Custom section and tap Create.

3. Enter the name, unit, and size of the new paper custom size.

4. Tap the Save button.

Use Windows forms

A custom paper size can be created with the printer driver, or with Windows forms.

A custom paper size created with the printer driver has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● The paper size is local to the printer queue. It will not be seen from other printer queues in the same 
computer.

● In Domain server networks, the paper size is local to the computer. It will not be seen from other 
computers sharing the printer queue.

● In Workgroup networks, the paper size will be shared among all the computers sharing the printer 
queue.

● If the printer queue is deleted, the paper size is deleted with it.

To create a new Windows form:

1. From the Start menu, or from the control panel, select Printers and Faxes.

2. From the File menu, select Server Properties.

3. In the Forms tab, check the Create a new form box.
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4. Enter the name and dimensions of your new paper size. Leave the margins as 0.00.

5. Click the Save Form button.

6. Go to the printer driver, and click Basic > Document size.

7. Select More… from the drop-down list of paper sizes.

8. Select your new paper size from the group of custom sizes.

A custom paper size created with Windows forms has the following characteristics:

● The paper size is permanent. It will not disappear if the driver is closed or the computer is turned off.

● Restricted users cannot create paper forms. The “manage documents” role in the Windows Active 
Directory is the minimum required.

● The paper size is local to the computer. It will be seen in all the printer queues that have been 
created on the computer and that support paper of that size.

● If a printer queue is shared, this paper size will appear in all the client computers.

● If a printer queue is shared from another computer, this paper size will not appear on the driver’s 
document size list. A Windows form in a shared queue needs to be created in the server.

● If the printer queue is deleted, the paper size is not deleted.

Select margin options
By default, the printer leaves a 3 mm margin between the edges of your image and the edges of the 
paper.

However, you can change this behavior in the following way:

● In the Windows driver dialog: Click Basic > Margin layout.

At least some of the following options appear:

● Standard or Use application settings. Your image will be printed on a page of the size you have 
selected, with the default margin between the edges of the image and the edges of the paper. The 
image should be small enough to fit between the margins.

● Oversize. You should load paper that is larger than the size you selected in the application or driver. 
If you cut off the margins after printing, you will be left with a page of the size you selected, with no 
margins remaining between your image and the edges of the paper. This is useful when you want 
your image to cover the whole area of the paper.

● Clip contents by margins. Your image will be printed on a page of the size you have selected, with the 
default margin between the edges of the image and the edges of the paper. In this case, if the image 
is the same size as the page, the printer assumes that the extreme edges of the image are either 
white or unimportant, and do not need to be printed. This may be useful when your image already 
contains a border.

Print on loaded paper
You can print a job on whichever substrate is loaded in the printer.
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● In the Windows driver dialog: Select Use printer settings in the Paper Type option of your printer 
driver.

NOTE: Use printer settings is the default Paper Type selection.

Rescale a print
You can send an image to the printer at a certain size but tell the printer to rescale it to a different size 
(normally larger).

This may be useful:

● If your software does not support large formats

● If your file is too large for the printer’s memory; in which case you can reduce the paper size in your 
software and then scale it up again using the control-panel option

You can rescale an image in the following ways:

● In the Windows driver dialog: Click Advanced > Document > Scale.

– By selecting a paper size, the image size is adjusted to the paper size you have selected. For 
example, if you have selected ISO A2 and you print an A3-sized image, it is enlarged to fit the A2 
paper. If the ISO A4 size is selected, the printer reduces a larger image to fit the A4 size.

– The Percentage of actual size option enlarges the printable area of the original paper size by the 
percentage indicated, and then adds the margins to create the output paper size.

If you are printing to a single sheet, you must ensure that the image fits onto the sheet. If not, the image 
will be clipped.

If you have a high-resolution image
You can improve print sharpness when using glossy paper.

If your image has a resolution greater than the rendering resolution, print sharpness may be improved 
by selecting the Maximum detail option.

This option is available only if you are printing on photo paper.

NOTE: The Maximum detail option results in slower printing with photo papers, but it does not 
increase the amount of ink used.

Print in gray shades
You can convert all colors in your image to shades of gray.

See Printing in grayscale on page 109.

Use paper economically
You may be able to save some of your roll paper by removing blank areas and/or by image rotation.

● In the Windows driver dialog: Click Advanced > Output > Remove blank areas and enable the setting.

You can also select one of the Rotation options.
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Nest jobs to save roll paper
Nesting means automatically printing images or document pages side by side on the paper, rather than 
one after the other. This is done to avoid wasting paper.

1. Direction of paper flow

2. Nesting off

3. Nesting on

4. Paper saved by nesting

When does the printer try to nest pages?
When both of the following are true: The printer is loaded with roll paper, not sheet paper and the 
printer's Nest option is turned on.

See: How to turn nesting on and off on page 67.

What pages can be nested?
All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or 
unless there are too many of them to fit into the remaining length of the roll. A single group of nested 
pages cannot be split between two rolls.

Which pages qualify for nesting?
In order to be in the same nest, the individual pages must be compatible in all the ways listed.

● All pages must have the same print quality setting (Fast, Normal, or Best).

● The Maximum Detail setting must be the same on all pages.

● The Layout/Margins setting must be the same for all pages.

● The Mirror Image setting must be the same for all pages.

● The Rendering Intent must be the same for all pages.

● The Cutter setting must be the same for all pages.

● Pages must be all color, or all grayscale: not some in color and some in grayscale.

● All pages must be in one or other of the following two groups (the two groups cannot be mixed in the 
same nest):
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– PCL3, RTL, TIFF, JPEG

– PDF

● JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some 
cases.

How to turn nesting on and off
You can turn nesting on and off from the control panel.

Tap the Settings icon , then Job management > Nest options > Nesting.

You will see the following options:

● In order: Pages are nested in the order in which they are sent to the printer (this is the default option). 
The nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The next page is incompatible with the pages already nested (see Nest jobs to save roll paper 
on page 66).

● Optimized order: Pages are not necessarily nested in the order in which they are sent to the printer. 
When it receives an incompatible page, the printer holds it and waits for compatible pages to 
complete the nest. The nested pages are printed as soon as one of three conditions is met:

– The next page will not fit on the same row as the other pages already nested.

– No page has been sent to the printer during the specified wait time.

– The incompatible-page queue is full. The printer can queue up to six incompatible pages while 
nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

● Off: Nesting is disabled.

TIP: Optimized order uses the minimum amount of paper; however, it may take longer to print 
because the printer waits for compatible pages to arrive.

How long does the printer wait for another file?
So that the printer can make the best nest possible, it waits after a file has been received to check 
whether a subsequent page will nest with it or with pages already in the queue.

This waiting period is the nest wait time; the factory default nest wait time is 2 minutes. This means that 
the printer waits for up to 2 minutes after the last file is received before printing the final nest. You can 
change this waiting time from the control panel: tap the Settings icon , then Job management > Nest 
options, and select the wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the control panel and 
in the Embedded Web Server.

Use ink economically
There are various ways to economize on the use of ink.
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Recommendations:

● For draft prints, use plain paper and set print quality to Fast.

● Clean the printheads only when needed, and clean only those printheads that need cleaning. 
Cleaning the printheads can be useful, but it uses a small amount of ink.

● Leave the printer permanently turned on so that it can maintain the printheads in good condition 
automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not 
done, the printer may need to use much more ink later to restore the health of the printheads.

● Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses 
some ink, and its frequency is related to the number of passes made by the printheads. Therefore, 
nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper on page 66).

Protect a paper type
You can protect selected paper types to avoid printing on them unintentionally. A protected paper type 
will be printed on only when the paper type is explicitly specified in the job.

To protect a paper type, tap the Settings icon , then Job management > Roll policies > Paper type 
protection, then select the category of paper you want to protect.

When a paper type is protected, the  icon appears before the paper name.

To print on a protected paper category, just select the paper type explicitly when submitting the job from 
a printer driver or other job submission software.

NOTE: If a protected paper type is not explicitly selected, and no other paper types are available, an 
out-of-paper message will appear.

Unattended printing/overnight printing
The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent 
print quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

● If feasible, use brand-new long rolls of paper.

● If you want to print on partly-used rolls, you can check the paper type and the remaining length in 
the Embedded Web Server or in the control panel, to confirm that you have enough paper to print all 
your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the 
roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

● Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically 
switch to the other.

● HP recommends the use of papers approved for your printer. See Supplies and accessories on 
page 153.

● Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may 
be put on hold for paper if the paper mismatch action is set to Put job on hold (see Solve paper 
mismatch on page 76).
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● Check the ink levels remaining in your ink cartridges.

● When you have submitted your print jobs, you can use the Embedded Web Server from a remote 
location to monitor their status.

● Drying time should be set to Optimal.

● Tap the Settings icon , then Paper selection and productivity > Use most depleted roll > On.
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Mobile printing5

Introduction
You can print to your printer from many mobile devices and from almost any location.

The main method of Mobile Printing is: Direct printing by connection to the same network.

Your printer can be connected to the HP Cloud, providing various benefits. See (link to Connectivity – 
Printer Onboarding TBD) for more information.

See the HP website at the following link: http://www.hp.com/go/designjetmobility for more detailed 
information.

IMPORTANT: The printer must be connected to a network with Internet access: connect an Ethernet 
cable. See Connect the printer to your network on page 14.

IMPORTANT: In order to print/scan from mobile devices, Bonjour, IPP/IPPS and Remote scan protocols 
must be enabled in the Embedded Web Server (Network > Advanced Settings).

Print from Android
Printing is available only from applications that offer printing or sharing.

You can add and manage your device print services from Settings > Connected devices > Connection 
preferences > Printing. The exact command sequence may vary depending on your Android OS version.

Print and scan using the HP app
Stay productive and organized with the HP app. Print, scan, and share your HP printer. Install the HP app 
on all your devices and save time for what matters.

You must have Android 9.0 or later.

You can download the HP app from the Google Play store at 
https://play.google.com/store/apps/details?id=com.hp.printercontrol.

To have access to all HP app features, connect your printer to HP Cloud and log in using your HP 
credentials.

Make sure your device and printer are operating on the same network and follow the steps below.

To print using the HP app

1. Open the HP app and select your printer.

2. Select whether you want to print documents or photos from your local device, or link your Google 
Drive, Dropbox, or other accounts to access your content.

3. Use the edit options to adjust quality, color, and other settings if you wish to make such adjustments.

4. Tap Print and collect your printed documents.
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To scan using the HP app

1. Place the document that you want to scan on the scanner area.

2. Open the HP app and start scanning from it.

3. Once the scanned document is received in the HP app, you can store the document in your mobile 
device, send it by email, or upload it directly to your preferred cloud repository.

Print using the HP Print Service plugin
You must have Android 6.0 or later.

If it is not already installed on your device, download, install, and enable the HP Print Service plugin from 
the Google Play store at https://play.google.com/store/apps/details?id=com.hp.android.printservice.

To use the plugin, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the HP Print Service plugin will appear with 
the HP logo.

3. Check the print settings, then tap Print.

Alternatively, for document types PDF, JPEG, and PNG, you can use the Android Share button and select 
the HP Print Service plugin from the list of options.

Print using the Mopria Print Service
You must have Android 5.0 or later.

If it is not already installed on your device, download, install, and enable the Mopria Print Service from 
the Google Play store at https://play.google.com/store/apps/details?id=org.mopria.printplugin.

To use Mopria, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the Mopria Print Service will appear with 
the Mopria Alliance logo.

3. Check the print settings, then tap Print.

Alternatively, for document types PDF, JPEG, and PNG, you can use the Android Share button and select 
Mopria from the list of options.

For more information, visit the Mopria website at https://mopria.org/.

Print using the Android default print service
You must have Android 12.0 or later.

The Android default print service comes pre-installed on Android devices, but is enabled only if no other 
compatible print service is installed, such as the HP Print Service plugin or the Mopria Print Service.
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To use the default service, follow the steps below:

1. Open the document or photo you want to print, tap the Menu icon, then tap Print.

2. Choose your printer from the list. Printers discovered by the default print service will appear with a 
generic printer logo.

3. Check the print settings, then tap Print.

Print from Apple iOS
Printing is available only from applications that offer printing or sharing.

Print and scan using the HP app
Stay productive and organized with the HP app. Print, scan, and share your HP printer. Install the HP app 
on all your devices and save time for what matters.

You must have iOS/iPadOS 15.0 or later.

You can download the HP app from the iTunes store at https://itunes.apple.com/app/id469284907.

To have access to all HP app features, connect your printer to HP Cloud and log in using your HP 
credentials.

Make sure your device and printer are operating on the same network and follow the steps below.

To print using the HP app

1. Open the HP app and select your printer.

2. Select whether you want to print documents or photos from your local device, or link your Google 
Drive, Dropbox, or other accounts to access your content.

3. Use the edit options to adjust quality, color, and other settings if you wish to make such adjustments.

4. Tap Print and collect your printed documents.

To scan using the HP app

1. Place the document that you want to scan on the scanner area.

2. Open the HP app and start scanning from it.

3. Once the scanned document is received in the HP app, you can store the document in your mobile 
device, send it by email, or upload it directly to your preferred cloud repository.

Print using AirPrint
You must have iOS 7.0 or later.

To use AirPrint, follow the steps below:

1. Open the document or photo you want to print, and tap the Share button.

2. Swipe the screen to reveal the Print button.

3. Check the print settings, then tap Print.
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Print from Chrome OS
Printing is available only from applications that offer printing or sharing.

Print using Chrome OS Native Print

With the latest ChromeOS versions, you can use native printing capabilities for basic printing without 
having to install additional software.

1. Choose your content. Open the document or photo you want to print, tap the menu icon, then tap 
Print.

2. Choose your printer. Select from the list of printers that appears. Printers discovered by HP Print for 
Chrome Extension will appear with a generic printer logo.

3. Confirm that the correct printer and print settings are selected. Tap Print and collect your printed 
documents.

For more information, visit the Google website at https://support.google.com/chrome/a/topic/9045842.

Mobile specifications
The HP app requires you to have an Internet connection.

Print and scan functionalities require that the mobile device and printer be on the same network.

NOTE: OS versions supported may vary in the future.
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Job queue management6

Job queue in the control panel
Tap the Job queue icon  on the home screen to view the job queue on the control panel.

Job queue
The job queue includes jobs that are in different phases: being received, processed, printed, already 
printed, and so on.

Tap the name of the job to see all the job details, including information about status and preview. The 
details displayed depend of the type of job.

In an active queue, the jobs in progress appear at the top, the upcoming jobs in the middle and the 
history at the bottom. You can scroll up and down. Once scrolled, the queue remains static and does not 
move automatically.

Jobs in the left pane are divided into three categories (In progress, Upcoming, and History). In History, 
the top job is the last job completed. In Upcoming, the top job is the next one to be executed (print jobs 
printed, send jobs sent, and so on).

Upcoming

● Processing: The printer is rendering the job.
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● Waiting to print or Paused: The job is processed and waiting for the print engine to be ready to 
proceed with printing.

In progress

The job is in progress (printing for print jobs, sending for send jobs, and so on).

● Preparing to print: The printer is performing actions in order to print.

● Drying: The job has printed and is waiting for the ink to dry.

On hold

The job will not be printed until you take some action. You should respond in one of the following ways:

● On hold for manual release: The job is not automatically printed. You must release it from the queue.

● On hold for paper mismatch: Resolve the issue with paper or output destination to print the job.

● On hold for accounting: Enter an account ID to be used for the job.

● On hold for attended mode: Some paper types require attended mode to be printed.

● On hold for supplies: Resolve the issue with supplies to print the job.

● On hold for recovery: After a printer recovery, some jobs that were not printed are kept on hold.

History

● Completed: Jobs completed in inverse chronological order (last job completed is on top)

● Canceled: Canceled by the user

● Failed: The job has failed for one or more reasons

Job queue actions
You can pause the job queue from the control panel.

Tap the Pause All button, and resume by tapping the Resume button. The pause takes effect at the end 
of the page that is currently printing.

The following actions can be accessed by tapping the ellipsis icon :

● Delete history: Delete the contents of the jobs in the history.

● Cancel all jobs: Cancel all jobs currently being processed.

● Modify queue settings: Manage settings such as: Hide deleted jobs, Queue recovery mode, Hold 
jobs for manual recovery, and whether to Delete jobs on hold after a specified time.

Job actions

● Cancel: Allows you to cancel a job in progress or upcoming.

● Reprint: In the History section, tap the job you want to reprint. On the details screen, tap Reprint. On 
the next screen, you can select the number of copies and whether to collate them (if applicable).
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● Resend: Allows you to resend a job to the same destination as before.

● Promote: Puts the job in the first position in the job queue after the job in progress.

● Delete: Deletes the content of a job in the History section.

● Release: Allows you to release jobs on hold for attended mode or on hold for recovery.

● Load: Allows you to load another paper roll when there is a paper mismatch.

● Change: Allows you to change the output destination when there is a paper mismatch.

See job details
Tap the name of the job to show its details, including information about status, pages, copies, total, and 
preview. Scroll down as necessary to see all of the information.

By tapping the thumbnail, you can navigate over all pages of the job. From there you can zoom in and out 
(pinch and zoom).

In an active queue, the job in progress appears at the top, the upcoming jobs in the middle, and the 
history at the bottom.

Solve paper mismatch
If the paper currently loaded in the printer is not suitable for a particular job or page, the printer can 
automatically solve the conflict or give a number of choices depending on the printer policies.

Such a conflict may be caused by a job sent to the printer with a specific roll and/or paper type that are 
different from the ones loaded, (e.g., requested plain paper but glossy is loaded), or by a roll coming to its 
end during printing.

The following options are available in the paper mismatch settings menu; you can reach this menu by 
tapping the Settings icon , then Mismatch actions > Paper mismatch.

● Pause and ask (the most restrictive option): Printing stops until the correct paper is loaded. This 
option is recommended when the printer is attended. A message appears, asking what you want to 
do: cancel the job, print anyway, put on hold, or load paper. These options are also available in the job 
queue.

● Hold job and continue with next: Put mismatched jobs on hold until the correct paper is loaded, and 
continue printing the rest of the job queue. The printer sends an alert whenever a job is put on hold. 
This option is recommended when the printer is unattended—even though the job may be partially 
printed or skipped—to avoid stopping the queue. Once the paper required for the job is loaded, the 
job or pages are automatically resumed.

● Print anyway (the least restrictive option): Print on whatever paper is loaded. The printer will choose 
the roll to print according to the following criteria: first where the page fits and then the same paper 
type. This option will never select a paper type that has been protected.

Job queue options
You can change the job queue options from the control panel.

Tap the Settings icon , then Jobs. Alternatively tap the Job queue icon , then the ellipsis icon , 
then Settings > Jobs.
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You can select hide deleted jobs, queue recovery mode, hold jobs for manual recovery, and decide 
whether to delete jobs on hold after a specified time.

Job deletion
If the printer runs out of storage space for new jobs, the content of the oldest printed jobs is 
automatically deleted. The jobs still appear in the history but are not printable. If you don't want to 
see deleted jobs in the history, go to the job settings and select Hide deleted jobs.

Cancel jobs on hold allows you to define the time after which these jobs will be removed (2–48 h).

To delete a job manually, select the job and tap Delete job at the bottom right.

The Delete option deletes the job contents, while the Cancel option cancels the job but leaves it in the 
queue, marked as Canceled by the user in the history category.

Job queue in the Embedded Web Server
To see the queue in the Embedded Web Server, select Jobs > Job queue in the Main menu.

Printing

Job queue page
Every page in the Embedded Web Server is PIN/password protected and there is no way a user can 
remove the protection. Users are asked to enter the PIN/password by default.

The job queue page shows all jobs that are available in the queue. The queue includes jobs that are 
being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

● File name: The name of the job

● Status: The current status of the job

● Pages: Number of pages in the job

● Copies: Number of copies printed

● Total: Total number of pages (including copies)

● User name: Username

● Account ID: Account ID for the job

● Started: Date and time attached to the job that was received by the printer, shown in the locale of 
the Embedded Web Server

● File source: Application from which the job was sent to print

● Paper source: Output option selected for the printed job

● Completed: Date and time of the job completion

● Job type: Type of job (Print, Scan, Copy)

● Quality: Quality of the job (Normal, Draft, Best,...)
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● Color mode: Color mode (Grayscale, Color, Black only)

You can perform the following operations on one or all jobs in the queue:

● Cancel: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job 
remains stored in the printer, but will not be printed unless you click Print

● Hold: Holds the select jobs until you click Continue to print

● Resume: All selected jobs, which are on hold, continue printing

● Print: Prints more copies of a job

● Next print: Sends all selected jobs to the top of the job queue

● Print anyway: Printer will try to print the job even if there is some problem with it

● Delete job: Deletes selected jobs from the job queue

Prioritize a job in the queue
You can select any job in the queue and make it the next one to be printed. After selecting the job, click 
Move to front.

In the following cases, the Next print button is not displayed:

● The job is already at the front of the queue

● The job is on hold—in this case the Resume printing button is displayed instead

● The job has finished—in this case the Print button is displayed instead

● The job has some error condition

Delete a job from the queue
Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will 
just fall off the end of the queue as more files are sent.

However, if you have sent a file in error, and want to avoid printing it, you can simply select the job and 
then click Delete job.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can click Cancel and then Delete job.

Reprint a job in the queue
To reprint an already-printed job, select the job from the queue, then click Print. When reprinting a print 
job, you cannot change the print settings, because the job has already been rasterized.

Job status messages
The job status messages are listed approximately in the order in which they may appear.

● Processing: The printer is parsing and rendering the job.

● Waiting to print: The job is waiting for the print engine to become free to proceed with printing.

● Preparing to print: The printer is performing writing system checks before printing the job.
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● On hold for manual release: The job is not automatically printed, you must release it from the queue.

● On hold for recovery: After printer recovery, some unprinted jobs are kept on hold.

NOTE: If the printer hangs up while printing a job, and the queue facility is turned on, the partially 
printed job will appear in the queue as on hold when the printer is next turned on. When you resume 
the job, it will start printing at the page at which it was interrupted.

● On hold for paper: The job cannot be printed because the right paper is not loaded in the printer. 
Load the required paper, see Paper handling on page 36, and click Continue to resume the job.

● On hold for accounting: The job cannot be printed because the printer requires all jobs to have an 
account ID: enter the account ID and then click Continue to resume the job.

TIP: To set an account ID, see Required account ID on page 33.

● Printing

● Scanning

● Drying

● Canceling: The job is being canceled, but will remain in the printer job queue.

● Deleting: The job is being deleted from the printer.

● Printed

● Failed: The job has been canceled by the printer.

● Canceled by user

● Empty job: The job does not contain anything to print.

Reactivate a job on hold

When the printer puts a job on hold you receive an alert which explains why the job is on hold. Follow the 
instructions on the screen to remove the hold and continue printing.

See Alerts on page 220.
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Scanning and copying7

Quick Sets
A Quick Set is a named group of settings with defined default values that help you to be more efficient.

Quick Sets are convenient for inexperienced users, and can be used to scan, copy, and print jobs.

Factory Quick Sets
The printer comes with some factory Quick Sets already defined, designed to support typical user 
requirements.

User Quick Sets
Quick Sets can be defined by a user and created or modified with the Embedded Web Server.

For information about the Embedded Web Server, see Embedded Web Server on page 35

To create or modify a user Quick Set, tap Quick Sets in the menu at the left side of the Embedded Web 
Server window.

Your own Quick Sets can be duplicated, edited temporarily or permanently, and deleted. Factory Quick 
Sets can only be duplicated.

To add a new Quick Set:

1. Tap the Add icon . A window opens to create a new Quick Set to scan, copy, or print jobs.
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2. Select from the drop-down list where the new Quick Set will appear. Choose from: Copy, Network 
folder, USB drive, or Print from network folder, then tap Next.

3. Give the new Quick Set a Name, a Description, and choose the Start Option from the drop-down list. 
When ready, tap Next.

4. Select the Input options you require, then tap Next.
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5. A summary of the Quick Set appears. Tap Next to save the Quick Set and continue.

6. The Quick Set is added and now available to use. Tap OK to finish.

Scanning
You can easily digitize your projects with automated scanning, user-centric Quick Sets, and post-editing 
capabilities.

1. From the control panel, tap the Scan icon .
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2. Select the scan destination.

● Scan to Network Folder (if a network folder has been added). See Configure a network folder 
on page 21.

● Scan to USB flash drive.

3. Select the appropriate Quick Set for your scan job. You can select the file type, color mode, original 
paper type and change the default file name.

NOTE: If paper is already inserted when you enter this screen, instead of the Send 
button  being displayed, you will see the Start button  instead. Tap the button to 
start the scanning process.

4. Insert the original, facing upwards, the scanning process will automatically start.
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5. Pick up the original when the scanner releases it.

TIP: To release the page, you can select automatic release in the Quick Set settings, or tap the 
Eject icon  at the bottom left of the screen.

6. Once scanning has finished, a preview is shown.

NOTE: You can tap the Hide icon  to hide the toolbar, the Show icon  to reveal it.

NOTE: Changing any option while scanning pages of a job will apply to the next job.

7. You can add more pages or tap the Done button  to the send the images to the selected 
destination.
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You can change the Quick Set settings tapping the More Options  icon at the bottom right of the 
screen.

The following settings are available in scan Quick Sets:

● Content type allows you to set the content type to Lines, Mixed, or Image.

● Original paper type allows you to set the content type to White paper, Photo paper, Old/recycled 
paper, Translucent paper, Blueprint, or Ammonia/old blueprint.

● Blueprints invert allows you to invert blueprints.

● Auto-release original allows you to auto-release the page once scanned.

● Output size allows you to set the output size page to Automatic, or customize the following options:

– Media source allows you to choose between automatic, roll 1, and roll 2.

– Size has a list of available paper sizes (A0, A1, A2, and so on).

– Positioning allows you to set the position of the original page in the output size area, when 
output size is not automatic. The options are Top-left, Top-center, Top-right, Middle-left, Middle-
center, Middle-right, Bottom-left, Bottom-center, Bottom-right.

For example, if you are scanning an A1 original and the input size is smaller (such as A2), top-left 
positioning crops the original page from the top left corner.

If you are scanning an A2 original and the input size is larger (for instance A1), top-left positioning 
places the original image in the top-left corner and adds white margins on the right and bottom 
to create an A1 image.

– Orientation allows you to set the page orientation to Landscape or Portrait when Output size is 
set to Custom size, or any Standard size except A0.

● Scan resolution allows you to set the resolution to 200, 300, or 600 dpi.

● Color mode allows you to choose Grayscale or Color.

● Detailed background removal may be used if you have an original with a background that is not 
completely white, or an original on translucent paper.

Smart background removal analyzes the content of the scanned original and automatically removes 
the background to make it pure white without removing the contents (lines and areas). Smart 
removal is available only for Lines and Mixed images (content type) in Grayscale (color option).
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Detailed background removal allows you to fine-tune the result of the smart background removal 
when it is on, or to set a manual level of background removal when smart removal is off, for any type 
of original. You can define these values on a scale of darker to lighter measured in values from −6 to 
+6. The default value of both options is zero.

For example, if you are copying an original blueprint (lines with the blue background) and the result 
of the smart background removal shows some background noise, you can increase the detailed 
background removal (for instance, to +3) in order to remove the background and make it whiter. 
Keep in mind that the smart background removal is analyzing each page; so, if you have pages with 
different backgrounds, it automatically sets a different removal value for each page.

NOTE: For better results, most original paper types should be inserted with their contents (lines, 
area fields, title box) in the first 8.4 cm (3.31 in) length of the scanned area.

The ammonia/old blueprint paper type can be inserted from any side because background 
removal uses a smart algorithm optimized for originals with a non-uniform or noisy background.

● Black enhancement can be used to change dark grays to black

For example, if you are copying a brochure with a mixture of text and pictures, the text is often 
digitized to a color that we may see as black but is really a dark gray. When the printer receives this 
gray text, it may be printed with a halftone pattern, meaning scattered dots instead of solid black.

By increasing the black enhancement value, you can force the text to be copied in real black, and 
it will therefore appear clearer. Use the black enhancement option with caution, because it can 
change other dark colors (not only grays) into black, making small dark spots appear in the picture.

Both black enhancement and background removal function as cutoff values in which pixels under 
or over a certain value are affected by the setting. You define these values on a scale of low to high 
lightness measured in values from 0 to 255 for the black enhancement and from −6 to +6 for the 
detailed background removal.

For example, you have copied an original and want to improve it by making the text blacker and the 
background whiter. Adjust the black enhancement value upwards from its default of zero (to 25, for 
example) and increase the detailed background removal (to 6, for example), making pixels with low 
lightness values go to black and lighter background pixels go to white.

● Automatic deskew allows you to turn the digital skew correction on or off.

● Reduce scan speed to enhance quality allows you to reduce the scan speed to get better scan 
results when scanning at 200 and 300 dpi.

● File type allows you to set the file format to PDF, JPG, TIFF, or PDF/A.

● File name allows you to set the file name prefix for the generated file.

Scanning to the network folder using the widget
The scan-to-network-folder widget is a fast way to start a scan and send the document to a network 
folder.

With a document loaded in the scanner, tap the Send button  to start scanning it.

NOTE: If you need to change a setting before the scan starts, tap the Options icon.
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The widget settings used to scan and the folder to which the job is sent can be changed in the 
Embedded Web Server. See Embedded Web Server on page 35. However, you will then need to restart 
the printer to see the settings updated in the widget.

Copying
You can easily copy your projects with user-centric Quick Sets, copy modes, and post-editing 
capabilities.

1. From the control panel, tap the Copy icon .

2. Select the appropriate Quick Set for your copy job. You can modify the color, quality, content type, 
paper source, background color removal, collate, and select the number of copies.

NOTE: If paper is already inserted when you enter this screen, instead of the Copy 
button  being displayed, you will see the Start button  instead. Tap the button to 
start the copying process.
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3. Insert the original, facing upwards. The scanning process will automatically start.

4. Pick up the original when the scanner releases it.

TIP: To release the page, you can select automatic release in the Quick Set settings, or tap the 
Eject icon  at the bottom left of the screen.

5. Once scanning has finished, a preview is of each copied page is shown. You can browse through 
the thumbnails.

NOTE: You can tap the Hide icon  to hide the toolbar, the Show icon  to reveal it again, and 
change the scan options for the following pages.

6. You can add more pages or tap the Done button  when there are no more pages to copy, 
and the pages will be printed.

You can change the Quick Set settings tapping the More Options icon  at the bottom right of the 
screen.
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The following settings are available in copy Quick Sets:

● Content type allows you to set the content type to Lines, Mixed, or Image.

● Original paper type allows you to set the content type to White paper, Photo paper, Old/recycled 
paper, Translucent paper, Blueprint, or Ammonia/old blueprint.

● Blueprints invert allows you to invert blueprints.

● Auto-release original allows you to auto-release the page once scanned.

● Scan resolution allows you to set the resolution to 200, 300, or 600 dpi.

● Color mode allows you to choose Grayscale or Color.

● Detailed background removal may be used if you have an original with a background that is not 
completely white, or an original on translucent paper.

Smart background removal analyzes the content of the scanned original and automatically removes 
the background to make it pure white without removing the contents (lines and areas). Smart 
removal is available only for Lines and Mixed images (content type) in Grayscale (color option).

Detailed background removal allows you to fine-tune the result of the smart background removal 
when it is on, or to set a manual level of background removal when smart removal is off, for any type 
of original. You can define these values on a scale of darker to lighter measured in values from −6 to 
+6. The default value of both options is zero.

For example, if you are copying an original blueprint (lines with the blue background) and the result 
of the smart background removal shows some background noise, you can increase the detailed 
background removal (for instance, to +3) in order to remove the background and make it whiter. 
Keep in mind that the smart background removal is analyzing each page; so, if you have pages with 
different backgrounds, it automatically sets a different removal value for each page.

NOTE: For better results, most original paper types should be inserted with their contents (lines, 
area fields, title box) in the first 8.4 cm (3.31 in) of the scanned area.

The ammonia/old blueprint paper type can be inserted from any side because background 
removal uses a smart algorithm optimized for originals with a non-uniform or noisy background.

● Black enhancement can be used to change dark grays to black.

For example, if you are copying a brochure with a mixture of text and pictures, the text is often 
digitized to a color that we may see as black but is really a dark gray. When the printer receives this 
gray text, it may be printed with a halftone pattern, meaning scattered dots instead of solid black.
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By increasing the black enhancement value, you can force the text to be copied in real black, and 
it will therefore appear clearer. Use the black enhancement option with caution, because it can 
change other dark colors (not only grays) into black, making small dark spots appear in the picture.

Both black enhancement and background removal function as cutoff values in which pixels under 
or over a certain value are affected by the setting. You define these values on a scale of low to high 
lightness measured in values from 0 to 255 for the black enhancement and from −6 to +6 for the 
detailed background removal.

For example, you have copied an original and want to improve it by making the text blacker and the 
background whiter. Adjust the black enhancement value upwards from its default of zero (to 25, for 
example) and increase the detailed background removal (to 6, for example), making pixels with low 
lightness values go to black and lighter background pixels go to white.

● Automatic deskew allows you to turn the digital skew correction on or off.

● Reduce scan speed to enhance quality allows you to reduce the scan speed to get better scan 
results when scanning at 200 and 300 dpi.

● Number of copies sets the number of copies.

● Output scale allows you to select the output page size.

● Output size allows you to set the output size page to Automatic, or customize the following options:

– Media source allows you to choose between automatic, roll 1, and roll 2.

– Size has a list of available paper sizes (A0, A1, A2, and so on).

– Positioning allows you to set the position of the original page in the input size area, when input 
size is not automatic. The options are Top-left, Top-center, Top-right, Middle-left, Middle-center, 
Middle-right, Bottom-left, Bottom-center, Bottom-right.

For example, if you are scanning an A1 original and the input size is smaller (such as A2), top-left 
positioning crops the original page from the top left corner.

If you are scanning an A2 original and the input size is larger (for instance A1), top-left positioning 
places the original image in the top-left corner and adds white margins on the right and bottom 
to create an A1 image.

– Orientation allows you to set the page orientation to Landscape or Portrait when Input size is set 
to Custom size, or any Standard size except A0, B0, or B1.

● Paper source allows you to specify printing on roll 1 or roll 2.

● Quality allows you to select between Draft, Normal, or Best.

● Output destination allows you to select the paper output from those available to the printer.

● Copy margins allows you to change the default printer margins.

● Collate allows you to turn collation on or off.

Copying using the widget
The copy widget is a fast way to copy a document.
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With a document loaded in the scanner, tap the Copy button  to start scanning it.

NOTE: If you need to change a setting before the scan starts, tap the Options icon.

The widget settings used to copy can be changed in the Embedded Web Server. See Embedded Web 
Server on page 35. However, you will then need to restart the printer to see the settings updated in the 
widget.

Scanner troubleshooting
In this section the most common defects and failure modes are shown, sorted by relevance and 
frequency of appearance.

A defect is a common image artifact that usually appears when using any CIS scanner. These are due to 
incorrect settings, product limitations, or easily solvable mistakes. A failure mode is due to malfunctions 
of some of the scanner components.

Some of the corrective actions proposed here require the use of the scanner diagnostic plot, which you 
can print and scan as indicated in Scanner diagnostic plot on page 101. Do not use any printed version 
of this guide to test the scanner, as the resolution of the images included here is insufficient. Use the 
diagnostic plot when recommended in response to any of the errors described in this chapter.

You are recommended to clean the CIS sensors at first installation, and at any time for good scanning 
quality.

Random vertical lines
This is one of the most common issues in sheet-fed scanners. Usually, the vertical streaks are caused by 
dust particles inside the scanner, or miscalibration of the scanner (in these cases, the problem can be 
solved).

Here are some examples of images suffering from vertical lines or streaks. Note the black arrow 
indicating the scanning direction in these examples.

1. Clean the scanner’s glass plate and the original to be scanned as described in Clean the scanner’s 
glass plate on page 149. Re-scan your original afterwards.

2. If the streaks remain, recalibrate the scanner as indicated in Calibrate the scanner on page 151. 
Make sure you clean the maintenance sheet before calibrating the scanner, and check that the 
maintenance sheet is not damaged (if so, call your service representative and ask for a new 
maintenance sheet). Re-scan your original after the calibration is completed.

3. If the streaks still remain, check the scanner’s glass plate visually. If it is damaged (scratched or 
broken), call your service representative.

4. If the streaks remain, there may be dust particles inside the glass plate. Carefully take out the glass 
plate and clean it as described in Clean the scanner’s glass plate on page 149.
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NOTE: The problem of vertical streaks cannot always be solved, due to the technological limitations 
of CIS technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the 
streaks remain after the corrective actions explained above, then no further action can be taken to 
improve the image quality, except to buy a more expensive CCD scanner.

Wrinkles or folds
Scanners based on CIS technology have a high optical resolution within their focus plane, at the price 
of a very limited depth of field. Hence, the images are sharp and detailed when the scanned original is 
perfectly flat against the glass plate.

However, whenever the original contains wrinkles or folds, these defects are clearly visible in the 
scanned image (as shown in the following example).

1. Re-scan the original, setting the content type to Image, and contrast and background cleaning to 
zero.

2. If the problem persists, re-scan the original at a lower scanner resolution (Normal quality if 
scanning, Fast or Normal if copying). It may also help to flatten the original manually as much 
as possible before scanning it again.

NOTE: The problem of wrinkles cannot always be solved, due to the technological limitations of CIS 
technology. HP offers HD Scanners with CCD technology for higher quality requirements. If the 
wrinkles remain after the corrective actions explained above, then no further action can be taken to 
improve the image quality, except to buy a more expensive CCD scanner.

Line discontinuities
When scanning or copying large originals, you may sometimes find issues such as that shown in the 
following image, where a straight line (it does not necessarily have to be horizontal) appears with 
discontinuities or small steps.

Note the black arrow indicating the scanning direction in this example:
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1. Repeat the scan, preferably using a higher resolution, and this time make sure that the product is 
correctly positioned (it is flat on the floor and it does not move), and that the printer is not printing 
while you scan. Turning the original 90 or 180 degrees and scanning it again may also solve the 
problem.

2. If the problem persists, check that the original to be scanned is not skewed, and that it does 
not become skewed during the scan. If so, see Incorrect paper advance, skew during scanning, 
or horizontal wrinkles on page 97. You might also want to deactivate the automatic de-skew 
algorithm as indicated in Copied or scanned image is very skewed on page 100.

3. If there is no skew but the problem persists, clean and calibrate the scanner as indicated in 
Scanner maintenance on page 149. Take care not to move the printer during the calibration (the 
printer should not be printing during scanner calibration), and check that the maintenance sheet is 
correctly positioned before starting the calibration. Also check that the maintenance sheet is not 
damaged before calibrating the scanner (an old or damaged maintenance sheet may cause this 
problem); if it is damaged, call your service representative and ask for a new maintenance sheet.

4. If the problem persists, proceed to analyze the following areas of the diagnostic plot:

a. 4 (from module A to E).

b. 10, at the intersection between modules.

c. 13 in modules A and E, and 14 in modules B, C, and D.

If you see any of these defects in the studied areas, call your service representative and report a 
“line discontinuities” error after calibration.

The four vertical thin black lines at the beginning and the end of the diagnostic plot show, approximately, 
the position of the intersection between CIS modules, where this kind of error usually appears. If the 
error appears outside these areas, call your service representative and report “line discontinuities 
within a CIS module”.

Small color differences between adjacent CIS modules
When scanning wide documents, sometimes slightly different colors can be seen at both sides of the 
junction between two CIS modules. This issue, if present, can be easily seen by analyzing patterns 9 of 
the diagnostic plot at the intersection between CIS modules.

Here are some examples. Note the black arrow indicating the scanning direction.
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Sometimes the color mismatch between adjacent modules can be enormous, showing a serious 
scanner malfunction, as in the following example.

1. Repeat the scan or copy, setting the content type to Image, reducing the background cleaning to 0 
or turning the original 90 degrees before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on 
page 149. If calibration ended without errors, proceed to analyze again pattern number 9 and 
modules A through E of the diagnostic plot.

3. After analyzing pattern 9, if you see some color differences between left and right sides of the bars 
for neutral and vivid colors, call your service representative and report “small color differences 
between adjacent CIS modules”.

Variable line thickness or missing lines
When scanning some CAD plots at Normal resolution, mostly when working with grayscale or black-and-
white prints that contain very thin lines, you may see a variation in line thickness, or even some missing 
lines, in some places.

1. Repeat the scan or copy using a higher resolution (High or Max if scanning, Normal or Best if 
copying). You should also set background cleaning to 2, or set the content type to Mixed. You might 
also deactivate the automatic de-skew as explained in Copied or scanned image is very skewed 
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on page 100. In case you were working in black-and-white mode, we recommend using grayscale 
instead.

2. If the problem persists, turn the original plot 90 degrees before scanning it again.

3. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on 
page 149.

Inaccurately reproduced colors
You have to deal with several variables if you want perfect color matching between the original you are 
scanning and the copy or scanned file you obtain as a result.

If you find undesired colors in cases like the example shown below (original on the left, scanned image 
on the right), you can follow these guidelines.

Actions:

1. Make sure that you choose the correct paper type in the scan settings before scanning.

2. When dealing with copies, you must take into account that good color matching between a given 
original and its copy can be achieved only if both are printed on the same type of paper. In the case 
of scanned files, good color matching can be achieved only if your monitor is color-calibrated or 
compliant with sRGB or AdobeRGB standards.

3. If the above conditions are met, you should also take into account that various scanner settings 
can affect the final color result, such as contrast, background cleaning, content type and paper 
type. To obtain the best possible colors, set contrast and background cleaning to 0, set the content 
type to Image, and select the most appropriate type of paper according to the original you are 
scanning (if in doubt, use photo paper).

4. Note that the image enhancement settings are automatically reset to default values after a certain 
time, so you may get a different result from copying the same original if you have not checked the 
settings before starting the job.

5. If you scanned to a PDF file, try opening the PDF file in Adobe Acrobat 
and saving it as a PDF/A file. For more information, see the Adobe website: 
http://www.adobe.com/products/acrobat/standards.html (English only).

6. For optimum color results, clean and calibrate the scanner as indicated in Scanner maintenance on 
page 149.

7. Avoid placing the scanner in direct sunlight or near sources of heat or cold.
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Color fringing
The problem called “color fringing” occurs when the scanner is affected by incorrect paper advance 
and/or miscalibration. Nevertheless, some amount of color fringing is unavoidable, especially at high 
scanning speeds.

Color fringing can be seen at the borders of sharp black text over a white background, as in the example 
below (original on the left, scanned image on the right). Note the black arrow indicating the scanning 
direction.

1. Repeat the scan after increasing the scanner’s resolution (choose Max quality if scanning, Best if 
copying). Turn your original 90 degrees, if possible, before scanning it again.

2. If the problem persists, clean and calibrate the scanner as indicated in Scanner maintenance on 
page 149. Repeat the scan at a high resolution (Max if scanning, Best if copying) and check whether 
the problem disappears.

3. If the problem still persists, you can diagnose this issue by analyzing the patterns 6 and 8 (A to E) of 
the diagnostic plot. The black horizontal lines appear slightly colored at the top and bottom of each 
end (in the example on the right, below). Normally, they look red at the top and blue or green at the 
bottom, but it could be the other way around.

If you see this effect, call your service representative and report “color fringing problem after 
calibration”.

Vibration
The following steps provide the complete procedure for this topic.

If your printer is not properly placed on a flat surface, or if the scanner lid does not close correctly, you 
may sometimes find that the scanned image suffers from vibration, as in the following example: original 
on the left, scanned image on the right.
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1. Make sure that the scanner is placed on a flat surface, the scanner lid is correctly closed, and the 
printer is not working while you are scanning. Scan your original again.

2. If the problem persists, change (increase or decrease) the scanning resolution and re-scan your 
original. We also recommend turning the original 90 degrees before scanning it again.

3. If the problem persists, analyze pattern 4 of the diagnostic plot. If you see the problem shown on 
the right, call your service representative and report a “vibration problem”.

Incorrect paper advance, skew during scanning, or horizontal wrinkles
The following steps provide the complete procedure for this topic.

You may encounter problems with some thick glossy originals being moved through the scanner’s paper 
path. In some cases, the original may become skewed during the scanning process.

If some of the paper rollers are not working correctly, you may find small horizontal wrinkles in the 
scanned image, due to the paper being stuck in some regions while not in others.

1. Turn your original 90 degrees and repeat your scan.

IMPORTANT: Do not hold the paper while it is being scanned.

2. If the problem persists, open the scanner lid. Clean the motor wheels (small gray rubber) and the 
pressure rolls (wide white plastic). Check that all the pressure rolls can move freely. If you find dust 
particles or objects that obstruct the movement of the rollers, try to remove them, then close the 
scanner lid and repeat your scan.

3. If the problem persists, restart the scanner by turning it off and on again. If you find an error 
message on the control panel during this operation, call your service representative and report the 
error message. If no error message appears, try repeating your scan.

4. If the problem persists, analyze patterns 4, 13 and 14 of the diagnostic plot. The plot should look like 
this:

Incorrect paper advance, skew during scanning, or horizontal wrinkles 97



5. If you see an image resembling the incorrect examples below, call your service representative and 
report an “incorrect paper advance” problem.

Vertical black band 20 cm wide
Your scanner contains various different CIS modules, each of which covers an area 20 cm (7.9 in) wide. 
If one of the modules fails, and the scanner hardware check does not detect the failure, you may see a 
black vertical band, corresponding to the area covered by a single CIS module, in your scanned image or 
copy.

Here is an example: original on the left, scan on the right. The black arrow indicates the scanning 
direction.

1. Open the lid of the scanner and check that the five CIS modules show blinking red, green, and blue 
lights alternately. If a module is failing, call your service representative and report a “CIS module 
illumination” error.

2. If all the modules lit up correctly in the previous step, restart the scanner by turning it off and on 
again. If you find an error message on the control panel during this operation, call your service 
representative and report the error message. If no error message appears, try repeating your scan.

3. If the problem persists, try to calibrate the scanner as indicated in Calibrate the scanner on page 
151. If this operation fails, call your service representative with the error code given on the control 
panel. If no error code appears, try to repeat your scan.

4. If the problem persists, call your service representative and report a “vertical black band 20 cm 
wide”.

Scanner damages some originals
HP is aware that this scanner may cause vertical scratches on inkjet originals on thick glossy paper. 
Very thin tracing paper or old originals may also be damaged. This is because CIS technology requires 
the original to be held down with high pressure to obtain accurate results and avoid blurring and defocus 
problems.
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If the original you intend to scan is valuable, and if it belongs to one of the types described above 
(inkjet-printed, thick, glossy original or old/thin/tracing paper original), HP recommends using a CCD 
scanner such as the HP DesignJet T1200 HD MFP.

Object replication (ghosting)
This error very rarely appears in CIS scanners.

However, you can occasionally find defects such as the following: original on the left, scanned image on 
the right.

Image Ⓒ www.convincingblack.com, reproduced with permission.

1. Restart your printer. Then calibrate the scanner, as indicated in Calibrate the scanner on page 151, 
and repeat your scan. Turn the original 90 degrees if possible before rescanning.

2. If the problem persists, analyze pattern 3, modules A through E, of the diagnostic plot. Call your 
service representative and report an “object replication” issue if you see the kind of error shown on 
the right.

Clipping or incorrect scale factor when down-scaling in copies and prints
When doing copies or prints (from USB, or printer driver), the scaling setting is available with various 
possible options. If you are experiencing problems related to border clipping, or it seems that your print 
has lost the scale-factor adjustment, read this section carefully in order to select the best value for the 
scaling setting in future jobs.

● Precise scaling: In this case, the content of the original image is scaled by the percentage factor 
that you have selected. For example, in an original CAD image with a 1:100 scale, if user selects 
scale to 50%, the printed plot will have an accurate scale of 1:200. Nevertheless, in the case of 
down-scalings when selecting a fixed percentage, some clipping of the marginal content of the plot 
may occur, as it is impossible for the printer to print up to the borders of the paper.

Object replication (ghosting) 99



● Scale to fit into page size: In this case, the content of the original image is scaled by the 
percentage necessary to make sure that all the content is correctly printed and no clipping occurs. 
Nevertheless, in the case of down-scalings when selecting fit to page, the scale-factor adjustment 
may not be an integer divisor of the original. For example, in an original CAD plot with a 1:100 scale on 
A2 paper size, if user selects scale to fit on A3 paper size, the scaling factor will not be exactly 50% 
and the scale of the printed plot will not be 1:200 exactly. However, the plot will be printed completely 
without clipping any content.

Incorrect edge detection, mostly when scanning tracing paper
The following steps provide the complete procedure for this topic.

Tracing or translucent papers can be scanned with good results, although totally transparent papers 
are not supported. Nevertheless, the resulting image may have extra margins or some clipping of the 
content in some situations when detection of the edge of the paper is not accurate, which may also 
happen when scanning plain paper if the glass plate is dirty. In order to avoid these undesired effects, 
follow these recommendations.

1. Carefully clean the scanner's glass plate and the original to be scanned with a cloth. Turn the 
original 90 degrees if possible and re-scan it afterwards. Remember to select Translucent as the 
paper type at the scanner if your original is translucent.

2. If the problem persists, calibrate your scanner, and re-scan your original again afterwards.

3. If the problem persists in the case of translucent paper, attach a sheet of white paper to the back 
of the original to be scanned. Remember to select White paper as the paper type for the scanner in 
this case.

Copied or scanned image is very skewed
Originals are often loaded into the scanner with some degree of skew. In order to correct for this 
unavoidable problem, the scanner has a built-in automatic de-skew algorithm, which measures the skew 
in the original and rotates the scanned image so that the result is perfectly straight.

However, in some cases the de-skew algorithm may increase the skew rather than correcting it. In other 
cases, the skew is so bad that it cannot be automatically corrected.

To load the original with minimum skew, grasp the original with the image facing up and your hands at left 
and right edges. You are recommended to avoid resting your hands or the original on the scanner’s input 
tray. Push the original into the scanner insertion slot until you feel the whole top border of the original 
pressing against the scanner rubber rolls, which will load the original after a delay of 1 second. Now you 
can take your hands off the original. If you are not happy with the way the scanner has grabbed your 
original, you can tap the Eject icon  and try again.

The action of the automatic de-skew algorithm can be deactivated by tapping the Options icon . 
Select the Quick Set to use, then tap More Settings and disable the Automatic deskew setting.

Cannot access the network folder or HP SmartStream (if installed as an 
accessory)

The following sections provide details for this topic.
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If you have set up a network folder, but the printer cannot access it, try the following suggestions:

● Check that you have filled in each field correctly. See Configure a network folder on page 21.

● Check that the printer is connected to the network.

● Check that the remote computer is switched on, working normally and connected to the network.

● Check that the folder is shared and that you have the correct permissions and functionality use of it.

● Check that you can put/read files (depending of the functionality use), to the same folder from a 
different computer on the network, using the printer's logon credentials.

● Check that the printer and the remote computer are in the same network subnet; if they are not, 
check that the network routers are configured to forward the CIFS protocol traffic (also known as 
Samba).

Scanning to file is slow
The following steps provide the complete procedure for this topic.

Scanning large formats creates large files. This means that scanning to file can take time even under 
optimal system configurations and conditions. This is especially true when scanning across a network. 
However, if you think scanning to file with your system is unreasonably slow, the following steps may help 
you to locate and solve the problem.

1. Use the control panel to check the status of your scan job. If it is taking an intolerably long time, you 
can select the job and then cancel it.

2. Check that the Resolution setting is right for the job. Not all scanning tasks require high resolutions. 
If you lower the resolution, you will speed up the scanning process. For JPEG and PDF scan jobs, 
you can also change the Quality setting. Lower quality values produce smaller files.

3. Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher 
transfer rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet 
configuration, you can expect slower transfer of the scan data and thus slower scanning speeds.

4. Contact your network administrator for information about your network configuration, transfer 
rates, scan-to-file destinations on the network, and possible solutions for increasing the speeds.

5. If scanning to files on the network is too slow and the network configuration cannot be amended to 
correct this, improved speeds can be achieved by scanning to a USB flash drive.

6. If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. 
Your system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with 
Hi-Speed USB (sometimes known as USB 2). Also check that your USB flash drive contains enough 
storage space for scanned large-format images.

Scanner diagnostic plot

Prepare the printer and the paper to print the diagnostic sheet
Turn on your printer and wait until it is functioning. Then select the paper on which the diagnostic plot is 
going to be printed (you can reuse the diagnostic plot any time in the future, if it is saved carefully).

Ideally, the diagnostic plot should be printed on glossy paper, and you are highly recommended to do 
that if you use your printer mostly for scanning or copying photo originals (posters, pictures printed on 
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glossy paper, etc). If you use your printer mostly to scan or copy matte originals, then you can use any 
matte white paper to print the diagnostic plot. Do not use recycled or tracing paper to print this plot. The 
size of the diagnostic plot is 610 × 914 mm (24 × 36 in). It can be printed on any 914 mm (36 in) landscape 
or 610 mm (24 in) portrait paper roll. You can also use a single sheet that is at least 610 × 914 mm (24 × 36 
in).

Once the correct paper is loaded, if this paper permits color calibration then we recommend color-
calibrating the printer.

You can print the diagnostic plot from the control panel: tap the Menu icon , then the Tools icon , 
then Troubleshooting > Print Scan IQ Plot.

Visual check for errors while printing the diagnostic sheet
Once the diagnostic plot is printed, the first step is to check that all the patterns included in it are 
correctly printed.

The diagnostic plot, if printed correctly, should look like this:

If you see any problems, you should follow the recommended recovery procedure. Once the printer has 
been diagnosed and it is working correctly, you can reprint the diagnostic plot as described in Scanner 
diagnostic plot on page 101.

Scan or copy the diagnostic plot
There are two options for evaluating the diagnostic plot: scanning into a JPEG file, or copying onto 
paper. We recommend using the scan option, so that the generated file can be analyzed more easily 
by a remote support engineer if necessary. If you decide to scan the plot, first adjust your computer's 
monitor. Once you have scanned the diagnostic plot, remember to open the scanned file in any image 
viewer software and select a zoom of 100% for correct visual evaluation of patterns.

If you decide to copy, make sure that a paper roll at least 914 mm ( (36 in)) wide is loaded in the printer. 
Ideally, the same type of paper used to print the diagnostic plot should be used for copying it.

These are the settings that you should select:
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Scan

● Quality: Max

● File type: JPG

● Content type: Image

● Compression: medium

● Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in 
doubt.

Copy

● Quality: Best

● Content type: Image

● Paper type: photo or matte, according to the paper used to print the diagnostic plot. Use photo if in 
doubt.

Load the diagnostic plot into the scanner input tray, making sure that the printed side of the plot is 
facing up. The black arrows on the diagnostic plot indicate the direction of loading. Make sure that the 
diagnostic plot is loaded without skew, and it is centered (that is, it covers the whole scanner area).

Once you have scanned the diagnostic plot (in case you selected the scan option), remember to open 
the scanned file in any image viewer software and select a zoom of 100% for correct visual evaluation of 
patterns.

NOTE: The monitor on which the plot is going to be evaluated should ideally be calibrated.

NOTE: Store the diagnostic plot for future use to save reprints.

Scan from the HP app
You can also scan directly to your mobile device by using the HP app (available for Android and iOS).

For more information, see Print and scan using the HP app on page 70.
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Collection and finishing8

If you choose no specific job destination, prints are sent to the default output destination, which can be 
changed from the control panel.

From the home screen, tap the Settings icon , then Output destination.

Stacker
By default, the printer cuts the paper after every print job. The resulting printed sheet of paper is neatly 
stacked on top of the other printed sheets by the stacker.

1. Stacker

2. Stacker pivoting cover

To empty the stacker, stand in front of the printer and pull the stack of printed sheets out of the stacker. 
The stacker cover may open during this process; make sure that it is closed after you have removed the 
sheets. Normally the return spring will close it automatically.
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TIP: Although you can remove sheets from the stacker while the printer is printing, HP recommends 
removing all the prints together while the printer is not printing.

TIP: You can lock the stacker cover in the open position to collect special jobs. Make sure that you 
close it afterwards.

TIP: When stacking papers below 75 g/m², activate the blue separators located at the sides of the 
stacker cover. Make sure you deactivate them when using papers above 75 g/m².

Stacking with photographic paper
When printing on some photographic papers, the printer will ask you to print in attended mode.

This means that the printer will put the job on hold by default, and you will have to start it manually from 
the job queue application.

To start printing the job, tap the Release button.

Once the job has started, you will be asked to remove each page as soon as it has been printed, to avoid 
the current page scratching the printed surface of the previous page.
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Color management9

Introduction
Color management is performed using a set of software tools that allow you to reproduce a color as 
accurately as possible on any display or printing device.

In addition, your printer has been engineered with advanced hardware and software features to ensure 
predictable and dependable results.

● Color calibration for consistent colors

● The Photo Black ink provides pure blacks when printing on photo papers

How colors are represented
Color is usually represented as an array of numbers: three numbers in the RGB color model or four in the 
CMYK color model. These numbers are a measure of the base colors used in a mixture to create a given 
color. RGB means that we are using a mixture of Red, Green, and Blue to create any specific color. In the 
case of CMYK, the mixture is of Cyan, Magenta, Yellow, and blacK.

Most monitors use the RGB color model, while most printers use the CMYK color model.

An image can be converted from one color model to another, but in general the conversion is not 
perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents 
colors a little differently from another device, even if they use the same color model. However, color 
management software can adjust the colors in an image according to the characteristics of the 
particular device, using a color profile of the device, in order to achieve correct colors.

A summary of the color management process
To get the accurate and consistent colors that you want, you should follow these steps for each paper 
type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and 
then (see Color calibration on page 107). In addition, you may wish to calibrate immediately before a 
particularly important print job for which color consistency is vital.

2. When printing, select the correct paper preset for the paper type you are using. The paper preset 
contains the color profile* as well as various other characteristics of the paper. See Paper presets 
on page 47.

*A color profile is a description of a printer, ink, and paper combination, that contains all the information 
required for these color conversions.
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Color calibration
Color calibration enables your printer to produce consistent colors with the particular printheads, inks, 
and paper type that you are using, and under your particular environmental conditions.

Your printer supports two different kinds of color calibration. Both are treated the same in the control 
panel:

● For fast printing, the color calibration is optimized to reduce the amount of color banding. This is 
done by reducing the color differences between the two rows of printheads.

● For high-quality printing, the color calibration is optimized for color accuracy and consistency, so 
that you can expect to get similar prints from any two printers situated in different geographical 
locations.

See Print modes on page 226 to find the color calibration type supported by each paper type.

Color calibration is recommended in any of the following circumstances:

● Whenever a printhead is replaced

● Whenever a new paper type is introduced that has not yet been calibrated with the current set of 
printheads

● Whenever the environmental conditions (temperature and humidity) change significantly

You can check the color calibration status of the currently loaded paper at any time by going to the 
control panel and tapping the Menu icon , then the Tools icon , then Troubleshooting, then the 
ellipsis icon , then Calibration status. The status may be one of the following:

● Pending: The paper has not been calibrated.

NOTE: Whenever you update the printer's firmware, the color calibration status of all papers is 
reset to Pending.

● Obsolete: The paper has been calibrated, but the calibration is now out of date because a printhead 
has been replaced, and should be repeated.

● Done: The paper has been calibrated, and the calibration is up to date.

● Invalid: This paper cannot be calibrated.

NOTE: Color calibration cannot be performed on transparent, translucent or colored material.

You can start color calibration from the control panel: tap the Menu icon , then the Tools icon , 
then Troubleshooting > Color calibration > Start. Choose the paper and tap Continue.

The calibration process is fully automatic and can be performed unattended after you have loaded 
paper of the type you wish to calibrate—which should be wider than 355 mm (14 in). If you have more than 
one roll loaded, the printer will ask which roll you want to use for the calibration.

The process takes about 3–5 minutes and consists of the following steps:

1. A calibration chart is printed, which contains patches of each ink used in your printer.

NOTE: Depending on the color calibration type, the printed pattern may be one of the following:
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Figure 9-1 Color calibration chart A

Figure 9-2 Color calibration chart B

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors 
have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for 
consistent color printing on that paper type. It also calculates the maximum amount of each ink 
that can be applied to the paper.

Color management from printer drivers

Color management options
The aim of color management is to reproduce colors as accurately as possible on all devices: so that, 
when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

● Printer-managed colors: In this case your application program sends your image to the printer 
without any color conversion, and the printer converts the colors to its own color space. The details 
of this process depend on the graphics language that you are using. HP recommends this setting 
for the best experience and results.

– PDF: The PDF interpreter modules perform the color conversion using the profiles stored in the 
printer and any additional ICC color profiles sent with the job itself.

– PCL3: The color management is done using a set of stored color tables. ICC profiles are not 
used. This method is somewhat less versatile than the alternatives, but is a little simpler and 
faster, and can produce good results with standard HP paper types.

NOTE: The printer can convert to sRGB if you are using Windows, or to Adobe RGB if you are 
using macOS.

● Application-managed colors: In this case your application program must convert the colors of your 
image to the color space of your printer and paper type, using the ICC profile embedded in the 
image and the ICC profile of your printer and paper type.

IMPORTANT: Make sure to select matching settings in the driver and in the application.
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You are recommended to consult the HP Support Center (see HP Support Center on page 223) to 
understand how to use the color management options of your particular application. See also Print a 
document with the correct colors on page 113.

To choose between Application-managed colors and Printer-managed colors:

● In the Windows driver dialog: Go to Advanced > Color and Quality > Color management

● In some applications: You can make this choice in the application

Color options

Printing in color
The printer prints in color by default.

You can select color printing:

● In your application program: Many programs provide this option

● In the Windows driver dialog: Go to Basic > Color mode and select Color

Printing in grayscale
You can convert all colors in your image to shades of gray.

You can convert to grayscale:

● In your application program: Many programs provide this option

● In the Windows driver dialog: Go to Basic > Color mode and select Grayscale

Printing in pure black and white
You can convert all colors in your image to pure black and pure white.

● In the Windows driver dialog: Go to Basic > Color mode and select Pure black and white

HP Professional PANTONE Emulation
When you use a named PANTONE color in an image, your application will normally send to the printer a 
CMYK or RGB approximation to that color. But the application does not take the printer or the paper type 
into account, it merely produces a generic approximation of the PANTONE color, which will look different 
on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics 
of the printer and the paper type. The results look as similar to the original PANTONE colors as is 
possible on a given printer using a given paper type. This technology is designed to produce emulations 
similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by 
default.

● In the Windows PDF driver dialog: Go to Advanced > Color and quality and select Pantone emulation 
to ON

● From the control panel: Tap the Settings icon , then Default printing configuration > Color options 
> HP Pantone Emulation
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● In the Embedded Web Server: From the main menu, select the Color tab

HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your 
printer; it also gives clear information on how close the emulation is to the original spot color.

Default color spaces
When a document or image does not specify the working color space in which the content is originally 
described, the user can choose among different standards. That is, the user can determine how data 
should be interpreted by the color management system during the rendering process.

You can set source profiles in the following way:

● In the Windows PDF driver dialog: Go to Advanced > Color and Quality > Color management and 
select Printer-managed colors

The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide 
the most common standards for the different devices.

The options are as follows:

Default RGB source profiles
Your printer is provided with a selection of default color profiles.

They are:

● None (Native): No imitation, for use when the color conversion is done by the application or 
operating system, and therefore the data arrive at the printer already color-managed. Available 
for PDF drivers only.

● sRGB IEC61966-2.1 imitates the characteristics of the average PC monitor. This standard space is 
endorsed by many hardware and software manufacturers, and is becoming the default color space 
for many scanners, printers, and software applications.

● Adobe RGB (1998) provides a fairly large gamut of RGB colors. Use this space if you need to do print 
production work with a broad range of colors.

● ColorMatch RGB imitates the native color space of Radius Pressview monitors. This space provides 
a smaller gamut alternative to Adobe RGB (1998) for print production work. Available for PDF drivers 
only.

● Apple RGB imitates the characteristics of the average Apple monitor, and is used by a variety of 
desktop publishing applications. Use this space for files that you plan to display on Apple monitors, 
or for working with old desktop publishing files. Available for PDF drivers only.

Default CMYK source profiles
You can choose from a selection of CMYK source profiles recognized by the printer.

The default CMYK profile is ISO Coated v2 (ECI), available for PDF drivers only.

Color management from the control panel
You can color-calibrate the loaded paper type from the control panel.
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Tap the Menu icon , then the Tools icon , then Troubleshooting > Color calibration > Continue, and 
choose paper.

See Color calibration on page 107.

The other color options in the control panel can all be found by tapping the Settings icon , 
then Default printing configuration > Color options, (they can also be found under Advanced printing 
preferences).

Color/Grayscale

● Print in color

● Print in grayscale

● Print in pure black and white

RGB source profile

● You can choose from a selection of RGB source profiles recognized by the printer. Default: sRGB IEC 
1966-2.1.

CMYK source profile

● You can choose from a selection of CMYK source profiles recognized by the printer. Default: Coated 
FOFRA39 (ISO12647-2:2004).

Other profiles

● Select rendering intent: You can select the rendering intent. Default: Perceptual.

● Black point compensation: You can turn black point compensation on or off. Default: On.

● HP Professional PANTONE Emulation: You can turn HP Professional PANTONE Emulation on or off. 
Default: On (PDF jobs only).
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Practical printing examples10

Print a draft for revision with the correct scale
Page size and orientation may not always be set as you require. This can be altered.

Using Adobe Acrobat
Print a revision draft with the correct scale.

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to 
check the page size.

2. Select File > Print and ensure that Page Sizing & Handling is set to Actual size.

NOTE: The page size will not be automatically selected according to the drawing size.

3. Click the Properties button.

4. Choose whatever Document Size and Print Quality you want to use.

5. Select Rotation, then Autorotate.

6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a PDF multipage job from Adobe Acrobat Reader or Adobe 
Acrobat Pro

Setting up for a multipage job is a quick and simple process.

Using a PDF driver
You can print a multipage job from Adobe Acrobat.
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1. Open a multipage job in Adobe Acrobat Reader or Adobe Acrobat Pro (HP recommends always 
using the latest version).

2. Click File > Print.

3. Select the printer and driver.

4. Check the Choose paper source by PDF page size box.

5. Adjust other properties in the driver properties window, as required.

6. Click the Print button.

The pages will be printed on the standard page size closest to the page size in the original document.

Print a document with the correct colors
Print a document from Adobe Acrobat and Adobe Photoshop, with the emphasis on color management.

Using Adobe Acrobat Reader
The print process is very simple. Acrobat Reader is the most basic application for PDF files; several color 
management tools common in more sophisticated applications are not explicitly present, and work by 
default with presets that cannot be changed.

For example, there is no way to select a working color space; a default color space, most likely sRGB, 
is applied. This color space is used for screen display, for example. Also, as an alternative color profile 
when no other is specified by a file, as will be explained later.

1. Click File > Print.
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2. Select the printer and driver from the Printer drop-down menu in the Print dialog box. Driver 
settings can be adjusted by clicking the Properties button.

3. Adjust the color settings in the driver properties window. Click the Properties button in the Print 
dialog and set the Color option in the Color mode section. Click OK.

4. Click the Advanced button in the Print dialog box to set color management options. Check the box 
Let printer determine colors.

5. If the document contains several color profiles and you are not sure what the result will be, you 
can flatten the document first and print it as seen on the screen. To do this, check the box Print 
As Image in the Advanced Print Setup dialog box. In this case, the rasterization is performed by 
Acrobat Reader before calling the driver; whereas, if you do not check this box, the rasterization is 
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performed by the driver. So checking the box may have a visible effect on the look of the printed 
document.

Using Adobe Acrobat Pro
This is a professional application that allows full color management. See briefly described, the options 
to select a working color space, convert images to a desired color space, and print.

1. PDF files may not contain a color profile. In the absence of a color profile, Acrobat uses a working 
color space by default. To choose a working color space, first click Edit > Preferences.

2. In the Preferences dialog box, you can choose RGB, CMYK, and grayscale working color spaces.

3. PDF files can contain elements with different color profiles. Some may have color profiles, some 
may not. The working color space will affect only those without a color profile. If you want to attach 
a specific color profile to the document, you must convert the contents of the document as follows. 
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First, select Convert Colors from View > Tools > Print Production or by clicking the icon in the status 
bar.

4. Select the elements you want to convert by specifying matching criteria (object type and/or color 
type) and then the conversion attributes. If you want to change the embedded color profile, you 
can select Any Object and Any Colorspace in the Matching Criteria section. In the Conversion 
Attributes section you can choose, for example, to embed an Adobe RGB (1998) profile by selecting 
it as the Conversion Profile, checking the Embed box, clicking the OK button, and saving the file to 
keep the changes. The saved file will have an embedded Adobe RGB color profile.

5. To print the document, choose a printer from the Print dialog box, click the Properties button, and in 
the Color mode section, set the color options.

IMPORTANT: Select Print in color and Printer managed colors.

6. In the Print dialog box, click the Print button to print the document.

Using Adobe Photoshop
The printer can manage colors directly.

1. In Photoshop, click File > Print, then select your printer.
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2. In the Color Management section, set the Color Handling option to Printer Manages Colors.

Print a project using Autodesk AutoCAD
Set up a plot to print from a model or a layout.

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the 
model.
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2. Click the Plot icon at the top of the window.

3. The Plot window opens.

4. You can see further options by clicking the circular button in the lower right corner of the window.

NOTE: The Quality option here does not refer to the final print quality but to the quality of 
AutoCAD viewport objects that are sent for printing.

5. Select your printer and click the Properties button.
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6. Select the Device and Document Settings tab, and click the Custom Properties button.

7. In the Driver, select the paper type that you intend to use.

8. Select the print quality.

9. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows driver: Select Document > Margin layout > Clip content by margins.

10. Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

11. Click the OK button and save your configuration changes to a PC3 file.

12. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Print a presentation
Setup AutoCAD or Photoshop presentations.

Using Autodesk AutoCAD
Print a presentation with Autodesk AutoCAD.
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1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.

3. Ensure that the correct printer is selected, then click the Properties button.
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4. Select the Device and Document Settings tab, and click the Custom Properties button.

5. In the Driver, select the paper type that you intend to use.

NOTE: If you select neither the paper source nor the paper type, the printer will not print on any 
protected roll.

6. Select the print quality.

7. If you intend to print on roll paper, you must decide where the printer should cut the paper.

● With the Windows driver: Select Document > Margin layout > Clip content by margins.

8. Select the Rotation option Autorotate. Autorotation can help to avoid wasting paper.

9. Click the OK button and save your configuration changes to a PC3 file.

10. When you have clicked the OK button in the Plot window, the printer will construct a print preview.

Using Adobe Photoshop
Print a presentation with Adobe Photoshop.

1. In Photoshop, click File > Print and then select your printer.

2. Click Print settings, then select the Document size option.

3. Choose from the available paper sizes.

If you don't find your desired paper size, create it by following the instructions in Custom paper 
sizes on page 63.

4. Select Show preview before printing. You may also wish to change the default paper source, paper 
type and print quality.

5. In the Color section, the default color management option is Printer managed colors, which is the 
correct option as you have already selected Printer Manages Colors in Photoshop.
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Print and scale from Microsoft Office
With the scale options you can scale documents to print at a particular size.

Using Microsoft PowerPoint
Scale a job to fit your page size and clip content by margins.

1. Click File > Print, and select the name of your printer.

2. Click the Scale option to scale the document to a particular size.

3. Select the Paper Source and Paper Type.

4. Depending on your driver version:

● With the Windows driver: Select Document > Margin layout > Clip content by margins.

Using Microsoft Project
Use the proper scale option to scale a document to a particular size.

1. Click File > Print.

2. Select your printer's name.
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3. In the Settings section, you can choose the pages to print, the orientation, and the paper size.

4. Click Page Setup to choose the Paper Size you want.

5. Select Options to go to the printer driver.

The default options are probably suitable: Paper source: Automatic and Paper Type: Use Printer 
Settings.
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6. Click Proper scale option to scale the document to a particular size. Alternatively, you can scale the 
document in Project.
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Retrieving printer usage information11

Get printer accounting information
There are different ways of getting accounting information from your printer.

● View printer usage statistics for the whole lifetime of the printer, see Check usage statistics on page 
125.

● View ink and paper usage for each of your recent jobs, see Check usage statistics for a job on page 
127.

● Use a third-party application to request printer status, printer usage or job accounting data from the 
printer through the Internet. The printer provides data in XML to the application whenever requested. 
HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

Check usage from the control panel

Tap the Usage icon  on the control panel to display the usage information.

The following information can be retrieved:

● In the tab Print categories usage, you can see the ink, paper area, and paper length usage divided 
into categories:

– Mono lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with 
less than 1% of color pixel coverage

– Color lines: Between 0% and 10% of non-white pixel coverage, printed on standard paper, with 
more than 1% of color pixel coverage
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– Low density image: Between 10% and 50% of non-white pixel coverage printed on standard 
paper

– High density image: Over 50% of non-white pixel coverage printed on standard paper

– Premium quality image: Any content type printed on premium paper

– Blueprint: Any content type printed on blueprint paper

● Scan usage: The copy and scan usage in m², and the total amount.

● Ink usage: The ink consumed by each cartridge in ml, and the total amount of ink consumed.

● Paper usage: Amount of paper used and the total at the top, divided into paper categories or 
families.

Usage can be seen at each level.

When you tap the Print usage report button, a message is displayed: The usage report was sent to the 
job queue and will be printed soon.

All the values can be displayed in English or metric units.

Print the usage information

There are two different ways to print the usage information from the control panel’s home screen:

● Tap the Usage icon  to launch the usage information screen, then tap the Print usage report 

button.
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● Tap the Settings icon , then Internal prints > User information prints > Print usage report.

Check usage from the Embedded Web Server
The same information can be retrieved from the Embedded Web Server as from the control panel.

1. Access the Embedded Web Server, see Embedded Web Server on page 35.

2. In the control panel, go to Support Tools > Report and Pages, then, from either the Print or Download 
tab, select the Usage Report, and click the related button: Print or Download. 

The usage page shows all the printer usage information separated into various tables:

● Product Information:

– Date

– Product Name

– Serial Number

– Firmware Version

– Product Number

● Usage Information: The total ink usage and the total paper usage (in units of area and length).

● Print categories usage: The ink and paper usage and the number or pages printed for the different 
print categories (content type, such as mono lines, color lines, premium quality image, blueprint 
paper). This table information is shown only if the Show application categories printer setting is 
enabled. There are further conditions depending on the following settings:

– The paper printed usage is shown if the Paper area used and paper area printed setting is 
enabled.

– The blueprint category is shown if the Enable the blueprint category setting is enabled.

– The premium quality image category is only shown if the Enable the premium quality image 
category setting is enabled.

– If the printed-paper column information is shown, the paper area used field changes the string 
to "Paper area (m² used)". Otherwise, the string shown is "Paper area (m²)".

● Ink usage: The ink usage for the whole life of the printer (with approximate values). The ink 
consumption table lists the ink consumed in each color, ignoring the product number of the 
cartridge.

● Paper usage: All the papers that have been used throughout the life of the printer.

● Scan Usage: All the scan jobs (copy included); Paper Area and Paper Length.

Check usage statistics for a job
The accuracy of the usage statistics is not guaranteed.

1. Access the Embedded Web Server, see Embedded Web Server on page 35.

2. In the menu at the side, click Usage > Accounting.
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The accounting page shows a table of the latest printed jobs, with the following information per job (not 
per page):

● Name: The name of the job

● Number: The number of the job

● Time: The date and time when the job was completed

● User: The name entered by the person who submitted the job (this item is present only if the 
corresponding security setting is enabled)

The user name is shown only if the Show user name and job name in job accounting setting is 
enabled for users under Security > Security settings.

● Type: The type of job (print)

● Source: The source of the job: USB, network, and so on

● Print quality: The print quality used to print the job

● Copies: The number of copies requested (cumulative after reprints)

● Pages: The number of pages completed

● Status: The status of the job: printed, canceled by user, and so on

● Total cost: The total cost of the job (visible if cost assignment is enabled)

● Paper type: The paper type used for the job

● Paper area: The used paper area of the job

● Paper length: The used paper length of the job

● Ink used: The volume of ink consumed by the job

A job is considered completed when all its pages have been printed, or canceled by the user, or 
canceled by the printer itself. An ongoing job (waiting for printing, being printed, being canceled, on hold 
for preview, and so on) will not appear on this list.

You can filter the jobs shown on the accounting page by using a drop-down control available on the 
same page. This control just changes the view, the job accounting information is not deleted in the 
printer. Essentially, this page will report the last N jobs (or fewer if there are not enough completed jobs), 
where N is the value of this configuration parameter. By default, N is 10.

Two buttons appear in the accounting table:

● Help: This button opens a window displaying help information.

● Export to CSV: This button opens a window with a progress bar, and generates and downloads a 
CSV file. The downloaded file contains similar information to the accounting page, in CSV format. If 
the cost assignment is enabled, the CSV displays more detailed information about the cost of the 
job.
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Handling ink cartridges and printhead12

About the ink cartridges
Ink cartridges store the ink and are connected to the printhead, which distributes the ink onto the paper.

To purchase additional cartridges, see Supplies and accessories on page 153.

CAUTION: Observe precautions when handling ink cartridges, because they are ESD-sensitive 
devices (see the Glossary on page 230). Avoid touching pins, leads, and circuitry.

Check the ink cartridges status
There are two options for checking the status of your ink cartridges. Both are accessible from the 
control panel.

The two options are:

● Tap the Supplies icon , then tap Cartridges. The Replace button is generic. When you trigger the 
workflow you can replace any supply that you need.

● Tap the widget in the home screen which redirects you to Supplies. Then tap Cartridges. The 
Replace button is generic. When you trigger the workflow you can replace any supply that you need.

There is a Replace ink cartridges option on the ink information page in case you want to do so (see also 
Remove an ink cartridge on page 129).

To get more information on your ink cartridges, you can press the color of the cartridge on which you 
want information.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 
211.

Remove an ink cartridge
There are three occasions when you need to remove an ink cartridge.

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing 
(you can use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

● You want to replace the cartridge, and there is not enough ink left in the ink cartridge to complete 
the cartridge replacement process. In this case, if the cartridge is not depleted you can use it again 
later.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.
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CAUTION: Make sure the printer wheels are locked (the brake lever is pressed down) to prevent the 
printer from moving.

NOTE: When a cartridge runs out of ink, the current job is not automatically canceled: unless you 
cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a 
delay in replacing the cartridge, you may see some banding on the print.

1. From the control panel, tap the Supplies icon , then tap Cartridge > Replace.

2. Push the cartridge that you want to remove.

The cartridge comes out.

3. Remove the cartridge.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, as there may be ink 
on the connection.

NOTE: Avoid storing partially used ink cartridges.

NOTE: The images shows the same cartridge, but the instructions are the same to replace any 
cartridge.
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Insert an ink cartridge
Although it is possible to use non-HP ink cartridges, this choice has several serious disadvantages. 
It may not be possible to determine with enough accuracy the ink level or status of used, refilled, or 
counterfeit ink cartridges.

To insert an ink cartridge:

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters 
(in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the 
cartridge label.

3. Insert the ink cartridge into the correct slot and push it until it locks into position.

4. When all the required cartridges have been replaced, tap the Continue button to finish the process.

NOTE: If you use a non-HP ink cartridge, any service or repair required as a result is not covered 
under the warranty. System ink flushing, color calibration, and printhead alignment are recommended. 
If you experience print-quality problems, HP recommends changing to Original HP inks.

About the printheads
The printheads are connected to the ink cartridges and jet ink onto the paper.

CAUTION: Observe precautions when handling the printheads because they are ESD-sensitive 
devices (see the Glossary on page 230). Avoid touching pins, leads, and circuitry.
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Check the status of the printheads
The printer automatically checks and services the printheads after each print.

Follow the steps below to get more information on your printheads:

1. From the control panel, tap the Supplies icon , then tap Printheads.

2. The control panel displays:

● Colors

● Product name

● Product number

● Serial number

● Status, see Control-panel error messages - HP DesignJet XL 3800 Multifunction Printer Series 
on page 222

● Volume of ink it has used

● Warranty status

For an explanation of the printhead status messages, see Printhead status messages on page 217.

If the warranty status is See warranty note, this indicates that expired ink is being used. If the warranty 
status is Out of warranty, this indicates that non-HP ink is being used. See the limited warranty 
document provided with your printer for details of the warranty implications.

Replace printheads
When printheads are depleted or have an issue that cannot be fixed, you must replace them. When 
printheads are new or installed from another printer, the printer will automatically perform a printhead 
alignment on the loaded paper.

1. At the printer’s control panel, tap the Supplies icon , then tap Printheads, then Replace. The 
carriage moves to the removal position.

2. Open the top cover.
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3. Open the latch on top of the carriage.

4. Lift up the cover to access the printheads.

5. Lift up the blue handle.

6. Using the blue handle, gently disengage the printhead and gently pull it upwards until the printhead 
is released from the carriage.

CAUTION: Do not pull abruptly as it could damage the printhead.
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7. Remove the orange protective caps by pulling them down.

8. Perform steps 1 to 6 in reverse order.

Store supply usage data
The HP cartridge used with this printer contains a memory chip that assists in the operation of the 
printer.

In addition, this memory chip collects a limited set of information about the usage of the printer, which 
might include the following: the date when the printer cartridge was first installed, the date when 
the printer cartridge was last used, the number of pages printed using the print cartridge, the page 
coverage, the printing modes used, any printing errors that might have occurred, and the printer model. 
This information helps HP design future products to meet our customers printing needs.

The information collected by the memory chip does not include information that could be used to 
identify a customer or user of the cartridge or printer.

HP collects samples of the memory chips from print cartridges returned to HP’s free return and 
recycling program (HP Planet Partners, see the HP website at the following link: http://www.hp.com/
recycle). The memory chips from these samples are read and studied in order to improve future HP 
products. HP partners who assist in recycling these print cartridges might have access to this data as 
well.

Any third party possessing the printer cartridges might have access to the information on the memory 
chip. If you prefer not to allow access to this information, you can render the chip inoperable, however, 
after you render the memory chip inoperable, the memory chip cannot be used in an HP printer.
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If you are concerned about providing supply usage information, you can set the printer not to store 
the information in the memory chip. To do so, access the Embedded Web Server, and select Security > 
Security Settings > Printer Settings, then toggle to and select Anonymous usage information. This does 
not prevent the cartridge from working normally in other respects, however, if you change your mind 
later, you can restore the factory defaults to resume collecting printer usage information.

Safe mode
Under certain conditions, including printer operation outside of environmental specifications, and when 
a used, refilled, or counterfeit ink cartridge has been detected, the printer will operate in safe mode.

HP is unable to warrant the performance of the printing system when operated outside of environmental 
specifications or when a used, refilled, or counterfeit ink cartridge is installed. Safe mode is designed to 
protect the printer and the printheads from damage due to unexpected conditions, and is in operation 
when the icon is displayed on the printer’s control panel and by the Embedded Web Server and HP 
Command Center.

For optimal performance, use original HP ink cartridges. HP DesignJet printing systems, including 
original HP inks and printheads, are designed and engineered together to provide uncompromising print 
quality, consistency, performance, durability, and value—with every print.

NOTE: This printer is not designed to use continuous ink systems. To resume printing, remove the 
continuous ink system and install genuine HP (or compatible) cartridges.

NOTE: This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges 
prior to depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine 
HP or compatible) to continue printing.

NOTE: This printer is intended to only work with new or reused cartridges that have a new or reused 
HP chip, and it uses dynamic security measures to block cartridges using a non-HP chip. Periodic 
firmware updates will maintain the effectiveness of these measures. More information can be found on 
the HP website at the following link: http://www.hp.com/learn/ds.
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Printer maintenance13

General cleaning instructions
For general cleaning a lint-free cloth dampened with distilled water is recommended. Let it dry or use a 
cloth to dry the cleaned part completely.

● Do not spray fluids directly on the HP product. Spray the fluid on the cloth used for cleaning.

● To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent or 
general-purpose industrial cleaner (e.g. Simple Green industrial cleaner). Remove any remaining 
soap with a dry cloth.

● For glass surfaces, it is recommended to use a soft, lint-free cloth, lightly moistened with a non-
abrasive glass cleaner or with general purpose glass cleaner (e.g. Simple green glass cleaner). 
Remove any remaining soap with a lint-free cloth dampened with distilled water and dry it with a dry 
cloth to prevent spotting.

CAUTION: Do not use abrasives, acetone, benzene, sodium hydroxide or carbon tetrachloride on 
the glass; they can damage it. Do not place or spray liquid directly on the glass, the liquid could 
seep under the glass and damage the device.

● Is recommended to use a canister of compressed air to remove dust from electronic/electrical 
parts.

CAUTION: Do not use water-based cleaners for parts with electrical contacts, they could damage 
electrical circuits.

NOTE: To prevent product or environmental damage: Do not use wax, alcohol, benzene, thinner, 
ammonia-based cleaners, or other chemical detergents.

NOTE: In some locations the use of cleaning products is regulated. Assure that your cleaner follows 
federal, state, and local regulations.

Check printer status
You can check the current status of the printer from the Embedded Web Server and the control panel.

● If you access the Embedded Web Server, you see information about the general status of the 
printer.

● The control panel provides direct access to all printer functions. Tap on icons to see the status of ink, 
paper supplies, job queue, printer settings, etc.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Swipe 
down the dashboard to access the Status Center and take action.
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Clean the exterior of the printer
Clean the outside of the printer and all other parts of the printer that you regularly touch as part 
of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-
abrasive liquid soap.

WARNING! To avoid an electric shock, make sure that the printer is turned off and unplugged before 
you clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.

Periodic user maintenance
When printer usage warrants it, the control panel will occasionally request to run periodic user 
maintenance.

There are three periodic user maintenance procedures: 1. Clean and lubricate the carriage rod on 
page 137, 2. Clean the encoder on page 141, and 3. Clean the platen on page 143. Once maintenance 
is complete, you must press the reset counter to communicate to the printer that maintenance is 
complete, and to initiate a new maintenance period counter.

NOTE: The control panel may request these procedures individually.

At the control panel, tap the Settings  icon , then Preventive maint. tasks > Clean and lubricate.

The control panel guides you through the steps, follow the instructions, and when completed tap Next.

1. Clean and lubricate the carriage rod
Always use a clean cloth and dampen it with a general-purpose industrial cleaner. Lubrication oil is 
included in the maintenance kit.

1. Open the top cover.
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2. Clean the carriage rod using a clean cloth dampened with a general-purpose industrial cleaner 
(such as Simple Green). Remember to also clean the part under the left cover.
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CAUTION: While cleaning, be careful not to damage the plastic encoder strip located on top of the 
rod.

3. Wait until the rod is dry, then close then top cover.
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4. Open the top cover again.
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5. Now clean the carriage rod in the other area, including the part of the rod under the right cover.

6. Take the bottle of oil from the printer’s maintenance kit, and deposit a very thin zig-zag trickle of 
oil along the rod. Take care not use too much oil on the rod as it could spill into other parts of the 
printer.

7. Tap OK in the control panel, and close top cover.

8. The carriage moves from one side to the other of the printer to distribute the oil along the whole 
rod.

2. Clean the encoder
The encoder strip should be cleaned when requested by the printer. The control panel displays a 
message when cleaning is required or when running periodic user maintenance.
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1. Open the top cover.
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2. Clean the encoder strip on both sides with a cloth dampened with water, as instructed in the control 
panel, and tap Continue when finished.

NOTE: Be sure that all encoder strip surface is cleaned, especially behind the maintenance 
cartridge.

3. Close the top cover.

The carriage moves to the left-hand side of the printer.

4. The control panel prompts you to open the cover again, and clean the right-hand side of the 
encoder strip (inside the service station). Tap Continue when finished.

5. Close the top cover again. The carriage returns to its ready position in the service station.

3. Clean the platen
You should clean the platen when requested by periodic maintenance.

Also clean the platen if you notice any of the following:

● Ink smearing when printing with presets that used to work well.

● Frequent paper jams.

● Ink stains and marks on the back of your prints.

● Banding or graininess appears in the first 10 cm of the print cut, when you use a paper and preset 
that used to work well.

See Troubleshooting print-quality issues on page 196 for more information.

1. If loaded, unload the roll. See Unload a roll on page 43.
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2. Turn off the printer.

3. Open the top cover.
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4. Clean the print platen with a cloth in order to remove ink and paper dust.

5. Use a 1 mm (0.04 in) pin to unclog every hole in the print platen. Make sure to push the pin all the way 
through, clogged vacuum holes can create print-quality issues and paper crashes.

6. When finished, close the top cover.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to 
maintain the best print quality, replace a cartridge when it reaches its expiration date. The printer's 
control panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge's expiration date at any time: see Check printer status on page 136.

See also Handling ink cartridges and printhead on page 129.

Move or store the printer
If you need to move or store the printer, prepare it correctly to avoid possible damage to it.
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To prepare the printer, follow these instructions:

IMPORTANT: If you move the printer long distances you must always put the drawer security locks on. 
Please contact HP authorized service personnel.

1. Anti-tilt supports can be only be removed for printer transportation, always assemble them again 
before use to avoid an overbalance risk. If you cannot move the printer because of the anti-tilt 
supports, please contact HP authorized service personnel.

2. Do not remove the ink cartridges or printheads when you store the printer. If you move the printer, 
remove the paper and ink cartridges, but not the printheads.

3. Make sure that no paper is loaded.

4. Turn off the printer.

5. Disconnect any cables connecting the printer to a network or a computer.

6. If the stacker seems likely to impede the movement of the printer through doorways, you can fold it 
out of the way by removing two screws.

If you need to leave the printer turned off for a long time, follow the additional steps below:

7. Turn off the power using the Power key on the control panel.

8. Disconnect the printer's power cable.

CAUTION: If you turn the printer upside down, ink could escape into the printer and cause serious 
damage.

When reconnecting the power cable, remember to route the cable tidily along the back gutter.

When the printer is turned back on, it takes about three minutes to initialize itself and to check and 
prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the 
printer has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

CAUTION: If the printer remains off for a long period of time, the printheads may become unusable. In 
this case, you need to replace the printheads.

TIP: Because preparing and purging the printheads uses both time and ink, you are strongly 
recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the 
health of the printheads. In both cases, the printer wakes up from time to time to maintain the 
printheads. Thus, you can avoid going through lengthy preparation processes before using your printer.

Update the firmware - HP DesignJet XL 3800 Multifunction 
Printer Series

The printer's various functions are controlled by firmware that resides in the printer.

From time to time firmware updates will be available from HP. These updates increase the printer's 
functionality, enhance its features, and may correct minor problems.

IMPORTANT: You are strongly recommended to update the firmware periodically in order to take 
advantage of the latest developments.
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There are various ways of downloading and installing firmware updates; you can choose whichever you 
find most convenient. They can be divided into two categories: automatic and manual updates.

Automatic firmware updates
Automatic firmware updates are a convenience that is possible with Web-connected printers. Your 
printer can automatically download the latest firmware release and install it for you.

Important notes

● Your printer must be connected to the Internet; see Set up printer services on page 19.

● To configure automatic firmware updates, you can use the control panel or the Embedded Web 
Server; see Set up printer services on page 19.

● If an administrator password has been set, it will be required to change these settings.

● A firmware update package can be large; you may want to consider whether there are any 
implications for your network or Internet connection.

● A firmware update is downloaded in the background: the printer can be printing at the same time. 
However, it cannot be installed in the background: printing must stop.

Manual firmware updates
Manual firmware updates can be performed by using the Embedded Web Server or a USB flash drive.

● Using the Embedded Web Server, tap General > Firmware Update.

● Using a USB flash drive. Download the firmware file from the HP website at 
http://www.hp.com/go/DesignJetXL3800/firmware into the USB flash drive, and insert it into the 
Hi-Speed USB host port in the control panel. A firmware-update assistant will appear on the control 
panel to guide you through the update process.

Update the software
Under Windows, HP Software Update regularly offers to update your software.

Under macOS, Apple SW Update offers you software updates when available.

To update printer drivers and other software for your printer, go to the HP website at 
http://www.hp.com/go/DesignJetXL3800/drivers.
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Printer maintenance kits
Three maintenance kits are available for your printer, containing components that may need to be 
replaced after long use. When one of them is needed, a message is displayed on the control panel and 
by the HP Command Center.

When you see the message, you should contact HP Support (see Contact HP Support on page 224) and 
request the maintenance kit. The kits are installed by service engineers only.
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Scanner maintenance14

Clean the scanner’s glass plate
You are recommended to clean the scanner's glass plate periodically, depending on how often you use 
the scanner.

1. Turn off the printer using the Power key at the front and disconnect the power cable.

2. There is a small lever at the rear left of the scanner. Slide the lever up and open the scanner cover.

WARNING! Do not lift the scanner while the scanner cover is open. Your fingers or hand may be 
trapped or crushed.

3. Gently wipe the glass plate and the surrounding area with a lint-free cloth dampened with water 
and then wrung dry. A suitable cloth is provided with the printer.

CAUTION: Do not use abrasives, acetone, benzene or fluids that contain these chemicals. Do not 
spray liquids directly onto the scanner glass plate or anywhere else in the scanner.

Do not worry about tiny droplets of water left on the glass: they will evaporate.
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4. Optionally, for more thorough cleaning:

● Remove the glass plate and clean it on both sides.

● Clean the pressure rollers and the feed rollers.

5. Close the scanner cover and gently push it down to lock it into place.

6. Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

150 Chapter 14  Scanner maintenance



7. Reconnect the printer's power cable, turn on the printer using the Power key.

Calibrate the scanner
Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be 
recalibrated during their lifetimes.

Nevertheless, because of environmental changes, your scanner may start showing image defects that 
can be easily corrected by recalibrating the scanner. The whole procedure takes less than 10 minutes, 
and you are recommended to recalibrate the scanner whenever you see some undesired artifact or 
a lack of quality in scanned files or copies, bearing in mind the limitations of CIS technology already 
explained in this guide. If you perform calibration successfully and still have concerns about the image 
quality, see Scanner troubleshooting on page 91; alternatively, you may want to consider buying a CCD 
scanner.

To calibrate the scanner
Your scanner should not need to be recalibrated during its lifetime, but if for some reason it needs to be; 
follow the steps in the order shown.

1. Clean the scanner. See Clean the scanner’s glass plate on page 149.

2. Go to the control panel and tap the Maintenance > User Maintenance > Scanner Calibration.

3. Follow the instructions in the control panel.

If calibration fails
The following steps provide the complete procedure for this topic.

The supplied maintenance sheet required to perform scanner calibration looks like this:

Load the maintenance sheet into the scanner face up, centered and with as little skew as possible. 
Once the calibration is finished, the maintenance sheet should be carefully placed into its solid cover, 
and saved in a fresh and dry place. Otherwise, it could be damaged, which could affect the operation 
of your scanner in the future. Check that the maintenance sheet is not dirty, wrinkled, scratched, or 
folded before calibrating the scanner. If necessary, call your service representative and ask for a new 
maintenance sheet.

1. Ensure that the printer is turned on and ready for normal operation.

2. Ensure that the scanner is working correctly. To test it, scan a small document to file.
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3. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the 
calibration process.

4. Eject and reload the calibration sheet, checking that it is clean, in good condition, face up, and 
perfectly centered in the scanner.

5. If the above steps do not help, eject the sheet and restart the printer (turn off and on). When the 
system has restarted, repeat the calibration.

6. If you cannot perform the calibration successfully in three consecutive attempts, call your service 
representative and report the error code that appears in the control panel.
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Supplies and accessories15

How to order supplies and accessories - HP DesignJet XL 3800 
Multifunction Printer Series

There are two alternative ways to order supplies or accessories:

● Visit the HP website at the following link: http://www.hp.com, select your printer and click on the 
accessories button.

● Contact HP Support (see Contact HP Support on page 224), and check that what you want is 
available in your area.

The rest of this chapter lists the available supplies and accessories, and their part numbers, at the time 
of writing.

Order ink supplies
The availability of supplies is dependent on the region you are in. Check your local HP website or trusted 
reseller.

Table 15-1 Ink supplies

Supply Part number

HP 768 500ml Magenta Ink Crtg 4S5B3A

HP 768 500ml Yellow Ink Crtg 4S5B4A

HP 768 500ml Cyan Ink Crtg 4S5B5A

HP 768 500ml Black Ink Crtg 4S5B6A

HP 768B 500ml Magenta Ink Crtg 4S5B7A

HP 768B 500ml Yellow Ink Crtg 4S5B8A

HP 768B 500ml Cyan Ink Crtg 4S5B9A

HP 768B 500ml Black Ink Crtg 4S5C0A

Table 15-2 Printheads

Printhead Part number

HP 769 Black Magenta 1-2 Printhead 7K5U5A

HP 769 Yellow Cyan 3-4 Printhead 7K5U6A

HP 769 Magenta Black 5-6 Printhead 7K5U7A
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Table 15-3 Maintenance cartridge

Cartridge Part number

HP 768 DesignJet Maintenance Cartridge 3EE18A

Order paper
Your printer can use a wide range of paper types.

Supported paper types

Supported HP papers

HP Large Format Printing Materials have been engineered to work together with HP printers and 
printheads.

They can be ordered from the HP website http://www.hplfmedia.com/. Here you can find the latest 
HP-branded paper types designed for your printer. You can also filter by printer type and specifications.

Graphics and technical paper types can be found at the HP website 
http://www.hplfmedia.com/graphics-technical. They include:

● Bond and Coated Papers

● Photographic Papers

● Films (Technical & Graphics)

● Self-adhesive Materials

● Banner and Sign Materials

Check compatibility with your printer:

● The Graphics & Technical Compatibility Chart can be found at the HP website 
http://support.hplfmedia.com/docs/graphics--technical.

Ensure that the selected roll has a 3-inch core.

Additional tools and support

● Paper presets can be found at the HP website http://www.hplfmedia.com/paperpresets.

● HP Support Hub can be found at the HP website http://support.hplfmedia.com/docs.

● Graphics & Technical Brochure (additional information) can be found on the HP website 
http://support.hplfmedia.com/docs/graphics-technical-brochure.

Other supported paper types

Some supported non-HP paper types may be compatible with your printer, but are not guaranteed to 
provide the best print quality.

Additional supported paper types

● Bond/plain paper
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● Recycled paper

● Colored paper

● Natural tracing paper

● Blueprint paper

● Backlit materials

Order accessories
There are a variety of accessories that you can order for your printer.

Table 15-4 Accessories

Name Product number

HP SmartStream Preflight Manager 8SW00AE

HP SmartStream USB Preflight Manager 8SW00A

HP SmartStream Print Controller for HP XL 3000 Printer Series 8SW02AE

HP SmartStream Print Controller USB for HP XL 3000 Printer 
Series

8SW02A

HP F40 Folder1 8SF40A

HP DesignJet XL 3800 MFP Folder Upgrade Kit 701X5A

1 The folder is not immediately supported by the printer. Support will be provided later.
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Why fold large format jobs
When it comes to managing large format drawings, there are primarily two options: rolling or folding.

Opting to fold your drawings offers several advantages:

● Space Efficiency: Folded drawings require less storage space, making them ideal for archiving.

● Organization: Folded sets of drawings can be neatly organized in ring binders or file folders, making 
them portable and easy to carry to meetings in a briefcase.

● Accessibility: With folded drawings in a binder or folder, you can flip through them without the need 
to unfold each one. The title block remains visible in the lower right corner for easy identification.

● Convenience: When you locate the drawing you need, it can be unfolded to its full size effortlessly, 
without the necessity to remove it from its storage binder or folder.

● Cost-Effective Shipping: Sending a folded drawing in an envelope is typically less expensive than 
shipping a rolled drawing in a cardboard tube.

Important Considerations for Folding

Correct folding is crucial to reap the benefits previously mentioned. The following is a list of what you 
need to know:

● Standard Folding Procedure: The most commonly used method adheres to the DIN 824 standard, 
which is based on the "A4" paper size (210x297mm).

● Orientation for A0-A1-A2 Drawings: When sending A0, A1, or A2 size drawings, ensure they are in 
Portrait orientation. The title block should be positioned in the top right corner of the unfolded page. 
This placement ensures that the title block will be visible on the "cover page" of the folded packet, 
facilitating quick identification and access.

By following these guidelines, handling, storing, and transporting your large format drawings becomes 
more efficient and practical.
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NOTE: AFNOR Folding styles (Folding width > 230mm) are not supported by the HP Designjet 
3800MFP Folding Solution.

Folding styles
This topic provides a full set of reference information for this subject.

The folder can fold pages in two different ways:

● Fan fold, in which folds are perpendicular to the printing direction

● Cross fold, in which folds are parallel to the printing direction

Folding styles are usually based on DIN B or DIN C style:

DIN B

The top and bottom folds are always on opposite sides. If this is what you want, select a folding style 
below marked with an asterisk, as these are the ones based on DIN B style. All folding styles that include 
a filing option (tab or filing margin) need to follow that configuration. It requires compensation folds in 
many formats since the last page’s end needs to be in a certain position for the filing option (hanging 
strip/filing margin). As those packets have more, unevenly distributed, folds, they tend to be thicker on 
one side making them topple over when you pile them up. Furthermore, the stack gets bigger.
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DIN C

The top and bottom folds are not necessarily on opposite sides. There are no compensation folds, which 
means that you are getting a thinner and more even stack when plotting a lot of prints and keeping them 
in one stack, either in plastic jackets or in envelopes/ folders.

DIN

● DIN A 190+20 × 297 mm (with binding edge)*

190 mm width, 20 mm margin, 297 mm height

● DIN B 210 × 297 mm (back panel covered)*

210 mm width, 297 mm height

● DIN C 210 × 297 mm (compact fold)

210 mm width, 297 mm height

● DIN B 210 × 305 mm*

210 mm width, 305 mm height
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ANSI

● ANSI 7.5 + 1 × 11 in

7.5 in width, 1 in margin, 11 in height

● ANSI 8.5 × 11 in

8.5 in width, 11 in height

Fan fold only

● Fan fold only (210 mm)

● Fan fold only 9 in

Others

● 185 + 20 × 297 mm (with binding edge)

185 mm width, 20 mm margin, 297 mm height

● ARCH 9 × 12 in

9 in width, 12 in height
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● Mailer 7.5 × 10 in

7.5 in width, 10 in height

● Inverse DIN (210 × 297 mm)

210 mm width, 297 mm height

The title block will be shown as follows when unfolded:

For the full list, see the front-panel menu at the default Folding style selection.

TIP: The folder tries to compensate automatically if the sheet width is exceeded. If the compensation 
is not successful, try choosing the DIN B 210 × 305 mm folding style.

Maximizing reliability in print & fold operations
For optimal performance and reliability in your Print & Fold processes, consider the following guidelines:

● Media Roll Width: Utilize media rolls that conform to ISO standards with widths of 841mm, 597mm, or 
420mm. The printer can accommodate roll widths ranging from 297 to 914mm, ensuring versatility 
across various project requirements.

● Job Length: Aim for Print & Fold jobs with lengths between 600 to 2000mm. The printer supports a 
broader range of page lengths from 415 to 6000mm, allowing for a wide variety of project sizes.
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● Ink Density: For best results, manage ink density to remain moderate to low, not exceeding 1cc/m2. 
This ensures the media handles the ink without quality loss or smudging.

● Media Weight: Use media within the 70 to 90 gsm range for most jobs, including bond, plain, or 
recycled types. For jobs with moderate to high ink density, opt for media weights of 90gsm or 
higher, within the supported range of 70 to 110gsm, to accommodate the additional ink without 
bleed-through.

● Folder Output Area Preparation: Ensure the Folder Output areas are clear of any obstacles before 
initiating a job. This includes checking the Fanfold exit gate and ensuring the Crossfold tray is empty 
or neatly organized to prevent jams or errors.

● Media End Usage: Avoid Print & Fold operations with the end portion of media rolls, as media curling 
can become excessive, leading to quality issues or folding inaccuracies.

By adhering to these recommendations, you can significantly enhance the reliability and quality of your 
Print & Fold operations, ensuring that your projects are completed efficiently and to high standards.

Submitting a job to the folder
The following sections provide details for this topic.

NOTE: If you submit a job without specifying a folding style, the default style is applied. Tap Menu then 
"Settings > Print > Default Print Options > Default Output Destination" to change the default folding 
style.

NOTE: In most cases the title block (legend) should be on the leading edge of the document entering 
the folder. The title block position has to be set in the printing software you are using (by rotation if 
necessary).

To use the folder, select it as follows:

● You can select the folder as the default output destination in the front panel: Tap Menu, then 
"Settings > Print > Default Print Options > Default Output Destination > Folder".

● When copying, you can select the folder as the output destination. Tap Copy, then select the more 
settings button at the bottom. Go to Output Destination > Folder. You can also select adjust the 
Default folding style.
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● Printer driver: Go to the printer properties, select the Layout/Output or Output tab (depending of the 
driver), and select Folder as the output destination.

● HP SmartStream: Set the destination to Folder, in the job preparation pane or in the settings pane. 
You can also select the folding style.
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You can specify in the application preferences whether you want to see the dimensions of the folded 
paper indicated in green in the preview.

NOTE: The folded dimensions are not shown if they are unknown at this point.

The green rectangle in the preview indicates which part of the page will be on top after folding. 
If the page contains some header or summary information describing its contents, you may want 
to ensure that this is in the green rectangle, so that it will be easily visible once the page has 
been folded. To move the contents of the page, you can use the rotation, alignment, and/or margins 
options (among the paper source options in the settings pane).

The following steps are recommended to check that the required content is in the green rectangle, 
and to adjust the page if necessary:

1. Set the default alignment between pages and roll in the preferences so that the page is placed 
on the correct side of the roll. You need to do this only once.

2. Select the first page of the job to see it in the preview.

3. Zoom in on the green rectangle. You may want to maximize the preview.
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4. If required, use the E key on the keyboard to rotate the page 90° counterclockwise or the R key to 
rotate 90° clockwise.

5. Use the down-arrow navigation key to select and preview the next page.

Optimal job types for Print & Fold with the HP DesignJet XL 
3800

The HP DesignJet XL 3800 Printing and Folding Solution excels with specific types of print jobs, ensuring 
reliability and high-quality results:

● Low Ink Coverage Jobs: It is ideally suited for jobs featuring low ink coverage, such as documents 
primarily composed of text and lines. This focus helps in maintaining clarity and preventing issues 
related to ink saturation on the paper.

● Engineering Projects: The folding solution demonstrates exceptional reliability with engineering 
drawings and documents. These typically include detailed plans and schematics that benefit from 
precise folding for easy handling, storage, and presentation.

Understanding the HP F40 Folder LED Status Indicators
The HP F40 Folder, an integral component of the folding solution, features an LED indicator that provides 
vital status information. Here is how to interpret its signals:

● White and Blinking LED: Indicates the Folder is currently processing a job.

● Steady White LED: Signals that the Folder is ready for operation.

● LED Off: The Folder is either in sleep mode or powered off. It takes about 30 seconds to initialize and 
re-establish communication with the printer upon waking or turning on.

● Red LED: This indicates a problem with the Folder. Follow these troubleshooting steps:

1. Check for and remove any media jams inside the Folder, including the input area, under the main 
cover, transport rollers tray zone, under the crossfold cover, and at the crossfold exit.

2. Ensure the conveyor tray is empty.

3. Verify all covers are securely closed.

4. Restart the Folder after completing the above steps. Note: Wait approximately 15 seconds 
before powering on the Folder, or until all Folder lights are off, as a precaution.
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● Blue LED: Signifies a communication issue with the printer. To resolve:

1. Inspect the CAN connection cable for damage and ensure it is properly connected.

2. If the issue persists, restart the Folder first, then the printer, following the same precautionary 
step of waiting approximately 15 seconds before powering on.

Selecting folding styles and media roll widths for the HP F40 
Folder

When utilizing the HP F40 Folder, choosing the correct folding styles and media roll widths is crucial for 
efficient operation and to avoid jams. Here's a guide to making these selections.

Supported Dimensions for Folded Packets

● Fanfold Length: The width of the folded packet should be between 170mm and 230mm.

● Crossfold Length: The height of the folded packet should be between 210mm and 310mm.

Folding Style Limitations

● The HP F40 Folder can perform up to 2 crossfolds. This introduces certain restrictions regarding the 
folding styles that can be used without issue.

Conflictive Folding Styles

1. Mailer 7.5x10”
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● Suitable only for roll widths less than 760mm. Using wider rolls may result in the folded packet 
getting trapped inside the crossfold module due to an excessively long tail after the second 
crossfold.

2. ARCH 9x12”

● The panel width of this style is very close to the folder's maximum packet width limit (230mm). 
This similarity poses a risk of fanfold jobs becoming jammed in the rollers' transport tray.

3. General Advice

● Avoid folding styles with panel widths in the range of 220 to 230mm to ensure system reliability.

Recommendations for Using 36” Rolls (914mm Width)

● DIN B 210x305mm Folding Style

– This style is recommended for its compatibility with the folder's limitations on packet 
dimensions.

– Panels longer than 310mm may not eject properly from the crossfold module.

● Example of a Potential Issue

– Utilizing the DIN B 210x297mm folding style with a 914mm roll width might result in two crossfold 
panels of 297mm and one panel of 320mm. The latter exceeds the ejection capability of the 
Crossfold module, potentially leading to jams.

By carefully selecting folding styles and media rolls that match the capabilities of the HP F40 
Folder, you can maintain high productivity and minimize operational disruptions.

Where to locate the “Folded Packet” cover page
Ensuring the correct positioning of the "Folded Packet" cover page is essential for efficient Print & Fold 
operations. Here is where to locate it:

Positioning

● Top-Right Corner: The "folded packet" cover page is consistently positioned in the top-right corner of 
the page, as illustrated in the provided image.

NOTE: Occasionally, you may need to rotate the job to ensure the cover page is in the correct 
corner before initiating the Print & Fold process.
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Page Alignment Settings

● Default Alignment: Under normal circumstances, the default setting is to align the page with the 
roll's right edge.

NOTE: When printing to the stacker, the page is justified to the left edge of the roll.

● Adjustments for Specific Cases: In certain scenarios, you may need to justify the page to the left 
edge of the roll or to the center of the roll during Print & Fold operations.

Control Panel Menu Options

● Procedure for Adjusting Page Alignment:

1. Navigate to Settings → Print → Advanced Settings → Page Alignment in the Control Panel 
Menu.

2. Choose from the following options:

a. Align Page with the Left Edge of the Roll: Use this setting when you need to justify the page 
to the left edge of the roll.

b. Page Centered: Select this option to align the page to the center of the roll when necessary.

Achieving low noise operation
To ensure a quieter operation of the system, follow these guidelines:

Print Mode Selection:

● Standard or Best Print Modes: Opt for these modes for quieter operation

– Exception: If time is of the essence, consider using Fast print modes. However, note that 
Standard or Best print modes offer better reliability, image quality, and lower noise levels.
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Benefits of Standard or Best Print Modes:

● Enhanced Reliability: These modes are associated with improved system reliability, reducing the 
likelihood of errors or interruptions during printing.

● Superior Image Quality: Standard and Best print modes produce sharper, more detailed prints 
compared to Fast modes, ensuring high-quality output.

● Reduced Noise Levels: By selecting Standard or Best print modes, you will experience quieter 
operation, contributing to a more comfortable working environment.

Considerations

● Priority of Print Speed vs. Quality: Assess your printing needs and balance the urgency of 
completing tasks quickly with the desire for optimal print quality and reduced noise levels.

● Impact on Workflow: Depending on the nature of your work environment and the importance of 
noise reduction, prioritize print modes accordingly to achieve the desired balance between speed, 
quality, and noise levels.

Media Jams in the Folder: General advice
To minimize media jams risk, please take the following action.

1. Take care that HP F40 Folder is correctly aligned with the printer, especially in height.

■ The Folder should be easily attached and detached from printer.

2. Use Standard Printmodes instead of fastest ones.

3. Print & Fold jobs with low ink density.

Paper jams with the HP F40 Folder

Paper jam in the folder input
The following steps provide the complete procedure for this topic.

1. Disengage the printer from the folder.

2. If necessary, cut the paper between the printer and the folder.

3. Remove the paper from the folder input.

4. Open the printer’s output interface and check if there is any paper.
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5. Ensure that there is no paper left anywhere in the folder. If you suspect that the jam affects other 
areas of the folder, see Paper jam on the fan-folding path on page 169 and Paper jam on the 
cross-folding path on page 170.

6. Re-engage the printer with the folder. Follow the front panel instructions.

7. The printer resumes the job and automatically reprints any lost pages. However, you should check 
that all pages of the job have been printed.

Paper jam on the fan-folding path
The following steps provide the complete procedure for this topic.

1. Open the fan-folding cover.

2. Move the rollers to release the paper.

3. Pull the paper out.

4. Ensure that the metal balls remain in place.

5. Close the fan-folding cover.
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6. Check whether there is any paper left in the fan area on the output side of the folder.

7. Remove any remaining pieces of paper.

8. Follow the front panel instructions.

9. The printer resumes the job and automatically reprints any lost pages. However, you should check 
that all pages of the job have been printed.

Paper jam on the cross-folding path
The following steps provide the complete procedure for this topic.

1. Open the top cross-folding cover.

2. Remove the paper.

CAUTION: Take care to avoid injury.
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3. Close the top cross-folding cover.

4. If the jam is not resolved, open the lateral cross-folding cover.

5. Remove the paper.

CAUTION: Take care to avoid injury.

6. Close the cover.

7. Follow the front panel instructions.

8. The printer resumes the job and automatically reprints any lost pages. However, you should check 
that all pages of the job have been printed.

Resolving Jams inside the Fanfold Module when High Ink 
Coverage

In situations where jams occur inside the Fanfold Module due to excessive ink coverage, follow these 
guidelines to address the issue effectively:

Ink Coverage Limitation

● The DesignJet XL 3800 Folding solution operates reliably with jobs that feature an average ink 
coverage of under 1cc/m2.
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Recommendations for High Ink Coverage Jobs

● Media Weight: Utilize media with a weight ranging from 90 to 110gsm to better accommodate high 
ink coverage.

● Ink Density Reduction: Reduce the ink density of the job to alleviate strain on the system and 
enhance reliability.

● Print Mode Selection: Opt for the Standard print mode instead of the Fast mode to ensure smoother 
operation and minimize the risk of jams.

Media jams when input roll is “Low on Media”
When encountering media jams inside the Folder due to a low media input roll, follow these steps to 
address the issue effectively:

Causes of difficulty

● Media Curling: The final portion of media rolls tends to be more curled, making them challenging to 
fold compared to the rest of the roll.

Recommendations

● General Advice: Consider discarding the last portion of the roll, approximately the last 5 meters, or 
utilize it specifically for printing to the stacker to avoid issues with curling.

● Indicator Light Significance: The orange color of the drawer light indicates that the input roll is "Low 
on media." In such cases, it's advisable to discard the roll for printing and folding purposes.

● Curling Threshold: If the curling of a 200mm long piece of paper exceeds 30mm, the folding system's 
reliability is compromised, see Paper curl on page 172.

Importance of Addressing Curing Issues

● Excessive curling can impede the folding process, leading to jams and disruptions in printing and 
folding operations.

● By recognizing the signs of curling and taking appropriate action, such as discarding the affected 
portion of the roll, you can maintain smooth and reliable performance of the folding system.

NOTE: Regular monitoring of media roll status and proactive measures to address curling issues are 
essential for preventing media jams and ensuring the efficient operation of the folding system.

Paper curl
Severe paper curl has an effect on the quality and reliability of the system. Print-quality issues and paper 
jams could result from a curl greater than 30 mm.

To measure the paper curl, cut a piece 200 mm long from the copy and lay it face down on a table. 
Measure the distance between the table’s surface and the highest point of the paper.

● Curl < 30 mm: Should not be a problem.

● Curl 30–50 mm: Possible paper jams and unstable tab position

● Curl > 50 mm: Out of specification
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Resolving folded packet jams at the crossfold exit area
While positioning the exit plate in the middle typically ensures smooth operation with most Folding 
Styles, page sizes, media types, and ink contents, occasional jams may still occur. Follow these steps to 
address jams effectively:

Troubleshooting Steps

1. Empty the Conveyor: Begin by ensuring the conveyor is clear of any obstructions or excess 
materials.

2. Adjust the Movable Plate at the Crossfold Exit:

● Upward Adjustment: When dealing with tall packets resulting from long crossfolded jobs or 
using higher media grammages, move the crossfold exit plate upwards.

● Downward Adjustment: For shorter jobs or those with lower media grammages, adjust the 
crossfold exit plate downwards.

Procedure

● Step-by-Step Adjustment:

1. Identify the height and weight characteristics of the job packet.

2. If the packet is tall or heavy, raise the crossfold exit plate.

3. If the packet is light or short, lower the crossfold exit plate.

4. Test the adjustment by running a new job through the system to observe the outcome.

Importance of Adjustment:

● Proper adjustment of the crossfold exit plate ensures optimal performance and minimizes the risk 
of jams, enhancing overall efficiency and reliability.
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By following these steps and making necessary adjustments based on the specific characteristics 
of the job packet, you can effectively resolve jams at the crossfold exit area and maintain smooth 
operation of the folding system.

How to reliably print & fold jobs with medium ink density
To ensure the smooth printing and folding of jobs with medium ink density, follow these 
recommendations:

Challenges with Medium Ink Density Jobs

● GIS, maps, and certain render jobs may encounter difficulties in folding due to excessive ink 
saturation and uneven ink distribution, causing the media to output from the printer too wet and 
resulting in media wrinkles inside the Folder.

Recommendations

● Media Selection: Use media with a grammage of at least 90gsm to better withstand the ink 
saturation and reduce the likelihood of media wrinkling.

● Print Mode: Opt for Standard or Best print modes to achieve optimal print quality and reduce the risk 
of media issues during folding.

● Media Profile: Utilize "Low_ink_density" media profiles to control ink application and minimize 
wetness, thereby mitigating the occurrence of media wrinkles.

Examples

● The following are some images to illustrate job examples where the use of "low_ink_density" media 
profiles is recommended:
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Importance of Recommendations

● By following these recommendations, you can improve the reliability of printing and folding 
operations for jobs with medium ink density, ensuring consistent output quality and minimizing 
issues such as media wrinkling.

NOTE: It is crucial to assess each job's ink density and characteristics carefully to determine the 
most appropriate media, print mode, and media profile settings for reliable printing and folding results.

How to use “Low_ink_density” media profiles
To use "Low_ink_density" media profiles effectively, follow these steps:

Assume you have Plain paper loaded in Roll-1.

1. Access Printer Control Panel:

■ Navigate to Media Rolls => Roll-1 => Modify in the Printer's Control Panel.

2. Select Custom Media Profiles:

■ Within the Custom category, you will find the following media profiles:

● Paper_ink_density_50

● Paper_ink_density_60

● Paper_ink_density_70

● Paper_ink_density_80

● Paper_ink_density_90

● Paper_ink_density_100

3. Choosing the Right Profile:
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■ Typically, selecting "Paper_ink_density_70" yields the best results due to the following reasons:

● Colors are maintained with slightly lower ink saturations.

● Media is not excessively wet, allowing for reliable print and fold operations.

Benefits

● Improved Reliability: By selecting the appropriate "Low_ink_density" media profile, reliability in print 
and fold operations can improve by a factor of around 10x.

Visual examples

● The following are images to illustrate the expected ink saturation when selecting these print modes. 
Note the improvement in reliability achieved by using these profiles.

● In case the job just contains lines and text, selecting “Plain Paper” should not cause any problem.

Resolving not uniform lateral margins
In general, all the printing systems could have some tendency to show a small lateral movement of the 
media. This lateral movement should stabilize after a few meters of printing/working with this media.

In the case that the lateral margins of the job are detected to be not uniform enough, take the following 
steps:

1. Use the upper drawer to load the media roll. The upper drawer usually is more stable as is closer to 
the printzone.

2. If you use both drawers:

a. Load wider media roll (841mm, 941mm) in the bottom drawer.

b. Load narrower media roll (594mm, 420mm or 297mm) in the upper drawer.
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3. When loading the roll manually take care that the hubs are fully pressed against the roll, like is 
shown in these pictures.

■ If after loading the roll the printer shows a message of “Skew detected”, press Cancel and load 
the media again.

4. Verify that the Folder is fully hooked to the printer and check that both are correctly aligned. Printer 
and folder separation on both sides should be the same.

Minimum media roll width to use with each Folding Style
To avoid jam incidences in the Folder crossfold module, there is a maximum width of the rolls that should 
be used depending on the Folding Style selected.

The values are shown in the table below.

Table 16-1 Minimum media roll width to use with each folding style

Folding style Panel height (mm) Max roll width with F40 
(mm)

Recommendation

DIN A DIN A 170/40x297 297 904 Use 841mm wide rolls

DIN A 180/30x297 297 904 Use 841mm wide rolls

DIN A 185/25x297 297 904 Use 841mm wide rolls

DIN A 190/20x297 297 904 Use 841mm wide rolls
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Table 16-1 Minimum media roll width to use with each folding style (continued)

Folding style Panel height (mm) Max roll width with F40 
(mm)

Recommendation

DIN B DIN B 198x297 297 904 Use 841mm wide rolls

DIN B 210x297 297 904 Use 841mm wide rolls

DIN B 210x305 305 920

DIN B 210x310 310 930

DIN C DIN C 210x297 297 904 Use 841mm wide rolls

JPN JPN 210x297F 297 904 Use 841mm wide rolls

JPN 210x297P 297 904 Use 841mm wide rolls

JPN 210P 210 730 Use 841mm wide rolls

JPN 297P 297 904 Use 841mm wide rolls

JPN X FoldA Use 841mm wide rolls

JPN X FoldB Use 841mm wide rolls

Imperial 8.5x11.3" 287 884 Use 841mm wide rolls

8.5x12" 305 920

ANSI ANSI 7.5+1x11" 279 869 Use 841mm wide rolls

ANSI 8.5x11" 279 869 Use 841mm wide rolls

ARCH ARCH 8+1x12" 305 920

ARCH 9x12" 305 920

Mailer Mailer 7.5x10 254 818 Use approximately 
760mm wide rolls

FanFold Only FanFold Only 210 Roll width Any

FanFold Only 8.5 Roll width Any
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Troubleshooting paper issues17

Paper cannot be loaded successfully
There are a variety of reasons why you may have issues loading the paper.

● Ensure that no paper is already loaded.

● Check that you have a roll in the selected drawer.

● Ensure that you locked the hub before feeding paper into the printer.

● Check that the paper is wound tightly on the roll.

● Check that the paper is attached to the core.

● Check that you follow the paper specifications.

● Ensure that the paper is far enough inside the printer: you should feel the printer grab the paper.

● The paper may be crumpled, or warped, or may have irregular edges.

● If a jam has recently occurred, make sure that no pieces of paper remain inside the drawer, 
cleanout, or printzone.

Unsuccessful roll load issues
If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be 
trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new 
roll of paper.

You should also:

● Ensure the roll ends are tight against the hubs.

● Check that all roll end plugs have been removed.

● Check that the paper is wound tightly on the roll.

● Do not touch the roll or paper at during the alignment process.

● Make sure the drawer is completely close.

● If you cannot insert the leading edge of the paper into the drawer, close and reopen the drawer.

● It can be difficult to insert a particularly stiff paper from the upper roll. Try moving it to the lower roll.

If the paper has not been inserted straight, the printer attempts to straighten the roll.

If you would like to start the load process again, cancel the process on the control panel and rewind the 
roll from the end of the spindle until the edge is removed from the printer.

NOTE: If the roll has become loose around the core, the printer cannot load the paper.
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Paper loading error messages
Error messages related to paper loading appear in the control panel, along with the suggested 
corrective action.

Table 17-1 Paper loading error messages

Control-panel message Suggested action

Paper incorrectly loaded The paper has not been loaded correctly. Remove the paper.

Paper loaded with too much skew During the paper load process the printer detected that the paper had too much 
skew. Follow the instructions on the control-panel display.

Paper loose around core The end of the roll has become loose around the core. Tighten the paper to the core 
or insert a new roll.

Paper not detected During the paper load process the printer did not detect any paper. Ensure the 
paper is inserted fully and is not transparent.

Drawer closed during paper load process Do not close the drawer until you are prompted to do so by the control panel.

Paper type is not in the driver
To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, 
however, you must identify whether your paper is transparent or translucent, glossy or matte.

Glossy or satin photo paper
If your paper is a photo paper, use the corresponding category: glossy or satin photo paper.

Matte paper
If your paper is a matte paper, choose a paper in the Bond and Coated Paper or Photo Paper categories.

General-purpose paper

● For thin papers (< 90 g/m2) uncoated papers (for example plain paper or bright white paper) select 
paper type Bond and Coated Paper > Plain Paper.

● For light coated papers (< 110 g/m2), select paper type Bond and Coated Paper > HP Coated Paper.

● For heavyweight coated papers (< 200 g/m2), select paper type Bond and Coated Paper > 
Heavyweight Coated Paper.

● For cockle-free very thick coated papers (> 200 g/m 2), select paper type Bond and Coated Paper > 
Super Heavyweight Coated Paper.

● For natural tracing papers, select paper type Natural Tracing Paper.

After printing, the paper has wrinkles or there is too much ink
This happens when too much ink is used. To use less ink, select a thinner category.
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Matte paper categories from thinnest to thickest are:

● Plain Paper

● Coated Paper

● Heavyweight Coated Paper

● Super Heavyweight Coated Paper

For other image quality problems, see Troubleshooting print-quality issues on page 196.

Printer printed on the wrong paper type
If the printer prints your job before you were able to load your desired paper, you may have Use Printer 
Settings selected for the Paper Type in the printer driver.

When either of these is selected, the printer will print immediately on whichever paper is loaded. Load 
your desired paper, see Paper handling on page 36, and select your paper type specifically in the driver.

● In the Windows driver dialog: Go to Advanced > Paper type, then select your paper type from the list.

NOTE: Use Printer Settings (Windows) is the driver default.

Automatic cut not available
Some paper types cannot be cut by the automatic cutter. When such a paper type is loaded and active, 
the printer cannot switch automatically to the other roll: the active roll must first be unloaded manually.

On hold for paper
Based on a set of conditions that you can set when sending a job, the printer will decide which of the 
loaded rolls of paper is more suitable to print the job.

If there is no roll of paper available that meets all the conditions, the printer will put the job on hold 
for paper. You can manually resume the job, forcing it to print on a paper other than the one originally 
specified, otherwise it will stay on hold.

See Solve paper mismatch on page 76.

NOTE: When an uncut roll is active and a job is sent to any other paper source, the paper is cut and 
the roll switches to print the incoming job.

What criteria are used to decide on which roll a job will be printed?
When you send a job, you can set the desired paper type in the printer driver.

If possible, the printer will print the job on a roll of paper of the chosen paper type that is large enough to 
print the drawing without clipping.

When is a job put on hold for paper?
If the paper mismatch action is set to Pause and ask, a job can be put on hold for paper.

See Solve paper mismatch on page 76.
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A job is put on hold for paper in the following cases:

● The paper type that has been selected by the user is not currently loaded on the specified roll—or on 
either of the rolls, if no roll has been specified.

● The paper type that has been selected by the user is loaded on the specified roll, but the drawing is 
too large to fit on the roll—or on either of the rolls, if no roll has been specified.

If I load a new roll of paper, will jobs that were on hold for paper be automatically 
printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper 
that could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?
Yes, this can be done from the control panel.

See Solve paper mismatch on page 76.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put 
on hold for paper

Margins are managed in different ways depending on the file type.

● For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) 
HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for 
paper.

● For other file formats, such as PDF, TIFF, or JPEG, the printer assumes that margins need to be 
added outside the drawing (as, in many cases, these formats are used for photographs and other 
images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs 
to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed; this would cause the 
job to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip 
contents by margins option can be used. This option will force the margins to be set inside of the 
drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put 
on hold. However, if there is no white space already included in the drawing’s borders, some contents 
could be clipped because of the margins.

Paper jam in the printzone
When a paper jam occurs, you normally see the Possible paper jam message in the control-panel 
display. The control panel starts the paper jam wizard which displays where the jam has occurred and 
how to fix it. Clear the paper jam following the wizard screens.

Below are the standard actions for a printzone paper jam:
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1. Open the top cover.

2. Try to move the printhead carriage out of the way.
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3. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

IMPORTANT: Use scissors to cut, not a single blade.

CAUTION: Do not move the paper sideways, as it could damage the printer.

4. Open the drawer with the paper jam.
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5. Cut the paper is necessary, then rewind the paper.

6. If required, trim the leading edge of the paper.

7. Rewind the paper and feed it into the slot.
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8. Close the drawer.

9. Reload the roll, see Paper handling on page 36.

10. Check the end caps of the maintenance cartridge area to see there is no stuck paper that could 
cause further issues.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the 
procedure and carefully remove all pieces of paper.

Paper jam before the printzone
When the printer detects a jam, it tries to resolve the issue automatically. If it cannot, it stops, and you 
must fix the problem manually. The control panel starts the paper jam wizard which displays where the 
jam has occurred and how to fix it. Clear the paper jam following the wizard screens.
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1. Open the drawer with the paper jam.

2. Cut the paper is necessary, then rewind the paper.

3. If required, trim the leading edge of the paper.
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4. Rewind the paper and feed it into the slot.

5. Close the drawer.

To reload the roll see Paper handling on page 36.

NOTE: If there is still an obstruction in the printer, restart the procedure, and carefully remove all 
remaining pieces of paper.

NOTE: If after completing steps 1–5 the problem persists, continue with the following steps:

6. Open the top drawer.
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7. Remove the cleanout by pushing its handles inwards to unlock it and pulling it out. 

8. Place the cleanout somewhere safe.

9. Carefully remove any pieces of paper from the cleanout area.

10. Put the cleanout back in place taking care to slot in into the guides.
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11. Push the cleanout in (1), until it clicks into place (2).

12. Close the top drawer.

The paper has jammed in the stacker
Paper can get stuck in the stacker. Follow the steps in order to remove it.
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1. Identify the top stacker.

2. Open the top-stacker cover and remove the paper.

3. Ensure that no pieces of paper are left in the printer.
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4. Close the top-stacker cover.

The paper has jammed in the scanner
The following steps provide the complete procedure for this topic.

1. At the rear left of the scanner, slide the small lever up, and open the scanner cover.
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2. Remove the paper.

3. Ensure that no pieces of paper are left in the scanner.

4. Close the scanner cover.
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Printer displays out of paper when paper is available
If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. 
If possible, tighten the paper to its core or load a new roll.

Paper is cut when the print has been completed
By default, the printer cuts the paper after the drying time has been completed.

You can disable the cutter, see Turn the automatic cutter on and off on page 48.

Cutter does not cut well
By default, the printer is set to cut the paper automatically after the drying time has been completed. 
If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any 
obstacles.

If the cutter is turned off, Move and cut only advances the paper. Use it to move the print far enough out 
of the front of the printer, until it is convenient to cut manually with a straight edge or scissors.

Roll is loose on the roll core
The roll may need to be replaced or reloaded: Tighten the roll of paper by hand until it is tight around the 
core, then try to reload it.

Recalibrate the paper advance
Accurate paper advance is important to print quality because it is part of controlling the proper 
placement of dots on the paper. If the paper is not advanced the proper distance between printhead 
passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the control panel. When 
you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while 
printing. However, if you are not satisfied with the default calibration of your paper, you may need to 
recalibrate the rate at which the paper advances. See Troubleshooting print-quality issues on page 196
for steps to determine if paper advance calibration will solve your issue.

Recalibrating the paper advance procedure
The recalibration procedure takes approximately 3 minutes. Do not worry about the paper-advance 
calibration image. The control-panel display shows any errors in the process.
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CAUTION: Do not try to recalibrate a transparent paper or film.

1. From the control panel, tap the Menu icon , then the Tools icon , then Troubleshooting > 
Automatic paper-advance calibration. The printer automatically recalibrates the paper advance 
and prints a paper-advance calibration image.

2. Wait until the control panel displays the status page, and reprint your print.

If you are satisfied with your print, continue using this calibration for your paper type. If you see 
an improvement in your print, continue with step three. If you are dissatisfied with the recalibration, 
return to the default calibration, see Return to default calibration on page 195.

Return to default calibration
Returning to the default calibration sets all the corrections made by the paper advance calibration to 
zero. To return to the default paper advance calibration value, you must reset the calibration.

1. At the control panel, tap the Menu icon , then the Tools icon , then Troubleshooting, then tap 
the ellipsis icon , then Reset calibrations, then select the calibration that you want to reset.

2. Wait until the control panel tells you that the operation has completed successfully.
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General advice
To achieve the best performance from your printer, use only genuine manufacturer’s supplies and 
accessories.

When you have any print-quality problem:

● Use genuine supplies and accessories, whose reliability and performance have been thoroughly 
tested to give trouble-free performance and best-quality prints. For details of recommended papers, 
see advice on the recommended settings depending on the application in section Supported paper 
types on page 154 and Order paper on page 154.

● Make sure that the paper type selected in the control panel is the same as the paper type loaded 
into the printer (see Supported paper types on page 154 and Paper options on page 45). At the same 
time, check that the paper type has been calibrated. Also make sure that the paper type selected in 
your software is the same as the paper type loaded into the printer.

CAUTION: If you have the wrong paper type selected, you could experience poor print quality and 
incorrect colors, and perhaps even damage to the printheads.

● Check that you are using the most appropriate print-quality settings for your purposes (see Printing 
on page 57). You are likely to see lower print quality if you have set the print quality to Fast.

● Check that your environmental conditions (temperature, humidity) are in the recommended range. 
See Environmental specifications on page 229.

● Check that your ink cartridges and printheads have not passed their expiration dates: see Maintain 
the ink cartridges on page 145.

All-purpose procedure
Most print-quality issues can be solved with an all-purpose procedure, which sequentially performs the 
most common calibrations.

At the control panel, tap the Menu icon , then the Tools icon , then Troubleshooting, and, lastly, Full 
Calibration.

Horizontal lines across the image (banding)
In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level.

For instance, if you have set the print quality to Fast, try setting it to Best.

Check that you are using the appropriate print-quality settings for your purposes (see Printing on page 
57).

To diagnose the origin of the banding problem, select your type of banding based on the following:
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1. If banding consists of thin light lines affecting only some colors, then it could be related to clogged 
printhead nozzles.

2. If banding consists of light or dark lines affecting all colors, then the defect could be related to 
paper-advance or printhead-alignment problems.

In this case:

● Go to the control panel and tap the Menu icon , then the Tools icon , then 
Troubleshooting > Paper-advance calibration, then tap Continue. Choose the paper source.

● If the issue persists, realign printheads (see Align the printheads on page 216).
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3. If you see wide bands alternating between dark and light, there could be a drop-weight or color 
difference, which could be solved by a color calibration.

If you are using Plain, Bond, or Bright White paper and you see the defects in Normal print mode, try 
loading it as Plain Graphics.

If the problem persists despite all the above actions, contact your service representative.

Whole print is blurry or grainy
If your print looks grainy, follow the steps in the order shown.

1. Check that you are using appropriate print-quality settings (see Printing on page 57). In some cases, 
you can overcome a print-quality problem by selecting a higher print-quality level. For instance, if 
you have set print quality to Fast, try setting it to Best.

2. Go to the control panel and tap the Menu icon , then the Tools icon , then Troubleshooting > 
Paper-advance calibration. Choose the paper source. See Recalibrate the paper advance on page 
194.

3. Realign the printheads. See Align the printheads on page 216. After alignment, you may wish to 
reprint your job in case the problem has been solved.

4. If you are using Plain, Bond, or Bright White paper, try loading it as Plain Graphics.

If the problem persists despite all the above actions, contact your service representative.
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Lines are discontinuous
If your lines are broken as shown, follow the steps to fix the issue.

1. Align the printheads on the paper that you have the issue with. See Align the printheads on page 
216.

2. Reseat the printheads by removing them and then reinserting them. See Replace printheads on 
page 132.

Wide horizontal bands in green areas
Green horizontal bands may be seen on plain, bond, and coated papers when print quality is set to Fast. 
Try setting print quality to Normal or Best.

Lines are occasionally shadowed or have spray stains
Horizontal lines show a slight shadow or there is a local spray mark on vertical lines, as well as if sparse 
large ink drops are found on the paper..

Slight shadow:
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Spray mark:

Clean the printhead (see Clean the printheads on page 212.

Paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to 
see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that 
becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. See Paper options on page 45.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper or HP Super 
Heavyweight Plus Matte Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.

Print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other 
object.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other. Try removing the printed sample from the stacker before 
sending the next one.

Horizontal smears on the paper
If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the 
printheads move over the paper, the printheads may come into contact with the paper and smear the 
printed image.
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Whenever you notice this problem, cancel the printing job immediately. Tap the Cancel icon  and also 
cancel the job from your computer application. Soaked paper can damage the printheads.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. See Paper options on page 45.

2. Use a recommended paper type (see Order paper on page 154) and the correct print settings.

3. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

5. Try to increase the margins by relocating the image to the center of the page using your software 
application.

Ink marks on the back of the paper
Clean the platen with a soft cloth. Clean each rib separately.

Edges of objects are stepped or not sharp
Edges of objects or lines appear to be poorly defined or lighter in density.

1. If you have this issue, and have already set print-quality to Best in the print dialog box, select the 
custom print-quality options, and try setting the quality level to Normal. See Printing on page 57.

2. The issue may be related to orientation. Try rotating the image: you may find that the result looks 
better.
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Edges of objects are darker than expected
Edges of objects seem darker than expected.

1. Set print quality to Normal in the print driver dialog.

2. The issue may be related to orientation. Try rotating the image: you may find that the result looks 
better.

Vertical lines of different colors or tone
Your print has vertical bands of different colors along it.

If you have this issue:

1. Try using thicker paper, choosing from the recommended paper types such as HP Heavyweight 
Coated Paper and HP Super Heavyweight Paper. See Order paper on page 154.

2. Try using higher print-quality settings (see Printing on page 57). For instance, if you have set print 
quality to Fast, try setting it to Best.

White spots on the print
You may notice white spots on the print. This is probably due to paper fibers, dust, or loose coating 
material.

To avoid this problem:

■ Protect your paper rolls and sheets by storing them in bags or boxes.

Colors are inaccurate
If the colors of your print do not match your expectations, follow the steps in the order shown to resolve 
the issue.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the control 
panel and in your software. See Paper options on page 45.

2. Tap the Menu icon , then the Tools icon , then Troubleshooting, then the ellipsis icon , then 
Calibration status. If the status is PENDING or OBSOLETE, you should perform color calibration: see 
Color calibration on page 107. If you have made any changes, you may wish to reprint your job in 
case the problem has been solved.

3. Check that you are using appropriate print-quality settings (see Printing on page 57). If you have 
selected the Fast option, you may not get the most accurate colors. If you change the print-quality 
settings, you may wish to reprint your job at this point in case the problem has been solved.

4. If you are using Application Color Management, check that the color profile you are using 
corresponds to the selected paper type and print-quality settings. If you have doubts about which 
color settings to use, see Color management on page 106.

5. If the problem consists of color differences between your print and your monitor, try calibrating 
your monitor. At this point, you may wish to reprint your job in case the problem has been solved.

If the problem persists despite all the above actions, contact your service representative.

Image is incomplete (clipped at the bottom)
This topic explains the concepts involved in this subject.

● Did you tap  before all the data were received by the printer? If so, you have ended the data 
transmission and will have to print the page again.

● The I/O timeout setting may be too short. This setting determines how long the printer waits for 
the computer to send more data, before deciding that the job is finished. From the control panel, 
increase the I/O timeout setting to a longer period and then send the print again. Tap , then 
Connectivity > Network > I/O timeout.

● There may be a communications problem between your computer and the printer. Check your USB 
or network cable.

● Check to make sure that your software settings are correct for your current page size (for example, 
long-axis prints).

● If you are using network software, make sure it has not timed out.
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Image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and 
the printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.

Printable area = paper size − margins

● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that 
are larger than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own 
minimal margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip 
contents by margins option (see Select margin options on page 64).

● If you are trying to print a very long image on a roll, check that your software is capable of printing an 
image of that size.

● If you try to print an image larger than your software can handle, the bottom of the image may be 
clipped. To print the whole image, try to save the file in another format, such as TIFF or EPS, and open 
it with another application.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide 
enough.

● If necessary, reduce the size of the image or document in your software application, so that it fits 
between the margins.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a high-quality large-format print job, and in some 
specific workflows there may be issues that can result in some objects missing from the output.

Here are some suggestions to help you to avoid this problem:

● Use HP Click software to print the file.

● Try printing from a USB flash drive.

● Reduce the resolution of bitmap images in your application software.

Lines are too thick, too thin, or missing
Check the paper type and settings, and run a report.
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1. If the resolution of your image is greater than the printing resolution, you may notice a loss of line 
quality. See Print modes on page 226.

2. If lines are too thin or missing, print the Image Diagnostics Print. See Image Diagnostics Print on 
page 208.

3. If the problem remains, go to the control panel and tap the Menu icon , then the Tools icon , 
then Troubleshooting > Printhead alignment to align the printheads. See Align the printheads on 
page 216. After alignment, you may wish to reprint your job in case the problem has been solved.

4. Go to the control panel and tap the Menu icon , then the Tools icon , then Troubleshooting, 
then perform paper advance calibration: see Recalibrate the paper advance on page 194.

If the problem persists despite all the above actions, contact your service representative.

Lines appear stepped or jagged
If lines in your image appear stepped or jagged when printed the problem may be inherent in the image

■ Try to improve the image with the application you are using to edit it.

Lines print double or in the wrong colors
This problem can have various visible symptoms.

● Colored lines are printed double, in different colors.
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● The borders of colored blocks are wrongly colored.

To correct this kind of problem:

1. Reseat the printheads by removing them and then reinserting them. See Replace printheads on 
page 132.

2. Align the printheads. See Align the printheads on page 216.

Lines or text are blurred
Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following:

1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality 
printing. See Environmental specifications on page 229.

2. Check that the paper type selected in the control panel is the same as the paper type you are 
using. See Paper options on page 45.

3. Select the custom print-quality options, then select Best.

4. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper or HP Super 
Heavyweight Plus Matte Paper.

5. Select a paper type that is slightly thinner than the paper you have loaded; this will cause the 
printer to use less ink. Here are some example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper, Super Heavyweight Plus Matte Paper.
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6. Align the printheads. See Align the printheads on page 216.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your 
purposes, you can try to improve line length accuracy.

1. Polyester film is about ten times more dimensionally stable than paper. However, using film that is 
thinner or thicker than HP Matte Film will reduce line length accuracy.

2. Set the print quality to Best.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance. See Recalibrate the paper advance 
on page 194.

Image Diagnostics Print
The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It 
helps you to check the performance of the printheads that are currently installed in your printer, and 
whether any printhead suffers from clogging or other problems.

To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.

2. Check that the selected paper type is the same as the paper type loaded into the printer. See Paper 
options on page 45.

3. At the printer’s control panel, tap the Menu icon , then the Tools icon , then Troubleshooting, 
then Print diagnostic plot at the top of the window.

It takes about 2 minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance:

● Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the 
print quality that you will get from each color.

● Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part 
complements the first, and aims more specifically to detect how many faulty nozzles each printhead 
has.

Look carefully at the print. The names of the colors are shown above the rectangles and in the center of 
the patterns of dashes.
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First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without 
any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of 
the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead 
responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing 
dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a printhead in a good state:

And here is an example of the same printhead in a bad state:
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Corrective action
If there is an issue with the Image Diagnostics Print, follow the steps to fix the issue.

1. Clean any faulty printheads (see Clean the printheads on page 212). Then reprint the Image 
Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see 
whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads on 
page 212). You could also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem still remains, replace any persistently faulty printheads (see Handling ink cartridges 
and printhead), or contact HP Support (see Contact HP Support on page 224).

If you still have a problem
If you still experience print-quality problems after applying the troubleshooting advice, there are some 
further things that you can do.

● Try using a higher print-quality option. See Printing on page 57.

● Check the driver you are using to print with. If it is a non-HP driver, consult the driver 
vendor about the problem. You could also try using the correct HP driver, if feasible. 
The latest HP drivers can be downloaded from the HP website at the following link: 
http://www.hp.com/go/DesignJetXL3800/support.

● Check that your printer's firmware is up to date. See Update the software on page 146.

● Check that you have the right settings in your software application.
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Troubleshooting ink cartridge and 
printhead issues

19

This topic gives the details about troubleshooting ink cartridge and printhead issues

Cannot insert an ink cartridge
The following steps provide the complete procedure for this topic.

1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label 
right-side up and readable.

CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages
These are the possible ink cartridge status messages:

● OK: The cartridge is working normally, with no known problems.

● Missing: There is no cartridge present, or it is not correctly connected to the printer.

● Low: The ink level is low.

● Very low: The ink level is very low.

● Empty: The cartridge is empty.

● Reseat: You are recommended to remove the cartridge and then reinsert it.

● Replace: You are recommended to replace the cartridge with a new cartridge.

● Expired: It is past the cartridge's expiration date.

● Incorrect: The cartridge is not compatible with this printer. The message includes a list of 
compatible cartridges.

● Non-HP: The cartridge is used, refilled, or counterfeit.

Cannot insert the printhead
It is important that you are using the correct type of printhead, and that it is well placed in its slot.

Then:

1. Check that you have the correct type of printhead (model number).
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2. Check that you have removed the two orange protective caps from the printhead.

3. Check that the printhead is correctly oriented (compare with the others).

4. Check that you have correctly closed and latched the printhead cover.

The control-panel display recommends reseating or replacing a 
printhead

When a printhead has been replaced, the printer will automatically perform a printhead alignment on the 
loaded paper.

1. From the control panel, turn the power off then on.

2. Check the control-panel display message, if it shows the ready message, the printer is ready to 
print. If the problem remains continue with the next step.

3. Remove the printhead.

4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can 
carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

CAUTION: This is a delicate process and may damage the printhead. Do not touch the nozzles on 
the bottom side of the printhead, especially not with any alcohol.

CAUTION: Do not leave the printhead outside the printer for a long time. If this is absolutely 
necessary, cover the printhead with the original orange caps, then store it in a horizontal position.

5. Reinsert the printhead into the same slot from which you removed it.

CAUTION: Do not move it to a different position in the carriage. Once a printhead is inserted into a 
specific slot, it is set up to work only with a specific combination of colors and cannot be moved to 
other slots.

6. Check the control-panel display message. If the problem remains, try a new printhead.

Clean the printheads
As long as the printer is kept turned on, automatic cleaning is performed periodically.
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This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy. If 
you have not already done so, see Image Diagnostics Print on page 208 before proceeding

To clean the printheads, go to the control panel and tap the Menu icon , then the Tools icon , then 
Troubleshooting > Clean printheads. You can also clean the printheads from the Embedded Web Server, 
go to Color > Optimize print quality. If you have gone through the Image Quality Diagnostic print process, 
you know which colors are failing. Select the pair of printheads which contain the failing colors. If you are 
not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes 
about 6 minutes. Cleaning a single pair of printheads takes about 4 minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

If you have cleaned the printheads using the Clean printheads procedure from the control panel and are 
still experiencing print-quality problems, you can try cleaning the printhead nozzles manually using the 
following procedure.

CAUTION: This is a delicate process, which may damage the printhead. Do not touch the electrical 
connections on the rear of the printhead.

First remove the printhead, then use a lint-free cloth to clean the bottom of the printhead until the 
residue is removed.

Clean the printhead drop detector
The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in 
order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block 
the sensor print-quality is affected.
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When the control panel displays a warning message that the clean process is needed, you are 
recommended to clean the printhead drop detector. If you do not clean the printhead drop detector 
immediately, the printer continues working normally, however, the control panel display continues to 
show the warning.

CAUTION: Wear gloves to avoid getting ink on your hands.

1. Turn off the printer at the control panel.

2. To avoid an electric shock, turn off the printer and unplug it.
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3. Open the top cover.
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4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6. With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Close the top cover.

8. Plug in and turn on the printer.

9. Power the printer on at the control panel.

Align the printheads
Precise printhead alignment is essential for accurate colors, smooth color transitions, and sharp edges 
in graphical elements. Your printer has an automatic printhead alignment process which runs whenever 
the printheads have been accessed or replaced.

You may need to align the printheads after a paper jam or if you are experiencing print-quality problems.

1. Load the paper you wish to use, see Paper handling on page 36. You can use a roll or a cut sheet.

CAUTION: Do not use transparent, semi-transparent, or colored paper to align the printhead. HP 
recommends plain or bond paper.

2. Ensure that the scanner is lowered, as a strong light source near the printer during printhead 
realignment can affect alignment.
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3. From the control panel, tap the Menu icon , then the Tools icon , then Troubleshooting > 
Printhead alignment.

NOTE: Printhead alignment can also be started from the Embedded Web Server (Support > Print 
quality troubleshooting).

4. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment 
pattern.

5. The process takes about 7–8 minutes. Wait until the control-panel display shows the process 
complete before using the printer.

If the printer cannot complete the printhead alignment successfully, you may be asked to clean the 
printhead and try again.

Printhead status messages
These are the possible printhead status messages:

● OK: The printhead is working normally, with no known problems

● Missing: There is no printhead present, or it is not correctly installed in the printer.

● Reseat: You are recommended to remove the printhead and then reinsert it. If that fails, clean 
the electrical connections, see The control-panel display recommends reseating or replacing a 
printhead on page 212. If that fails, replace the printhead with a new one, see Replace printheads on 
page 132.

● Replace: The printhead is failing. Replace the printhead with a working one, see Replace printheads 
on page 132.

● Replacement incomplete: The printhead replacement process has not completed successfully; 
re-launch the replacement process and let it finish completely.

● Non-HP ink: Ink from a used, refilled, or counterfeit ink cartridge has passed through the 
printhead. See the limited warranty document provided with your printer for details of the warranty 
implications.
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Printer does not print
If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why 
a file you have sent from your computer may not start printing when expected.

● You may have an electrical power problem. If there is no activity at all from the printer, and the 
control panel does not respond, check that the power cable is connected correctly and that there is 
power available at the socket. Press the power key for 5 seconds to reset the printer.

● You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic 
fields or severe electrical disturbances, which can cause the printer to behave strangely or even 
stop working. In this case, turn off the printer using the power key on the control panel and unplug 
the power cord, wait until the electromagnetic environment has returned to normal, then turn it on 
again. If you still experience problems, contact your service representative.

● Nesting may be on, and the printer is waiting for the specified nest wait time before calculating the 
appropriate nests. In this case, the control panel shows the remaining time needed for nesting.

● You may have the wrong graphic language setting, see Change the graphic language setting on 
page 34.

● You may not have installed in your computer the correct driver for your printer, see the assembly 
instructions.

● The printer may be holding the job for suitable paper (see On hold for paper on page 181) or 
accounting ID information (see Required account ID on page 33).

Control panel fails to initialize
If the printer will not start (the control panel is blank), you are recommended to replace the firmware, in 
the following way:

1. Go to the HP Support Center (see HP Support Center on page 223) and download the firmware.

2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted 
with the FAT filesystem.

3. Ensure that the printer is turned off. Connect the USB flash drive to the Hi-Speed USB host port 
beside the control panel, then turn the printer on.

4. The printer takes about a minute to read the firmware file, then asks you to remove the USB flash 
drive.

5. The printer automatically installs the new firmware and restarts.

Printer seems slow
The printer is running slower than normal, for no obvious reason.
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Here are some possible explanations:

● Did you set the print quality to Best or Maximum detail? Best-quality and maximum detail prints take 
longer.

● Did you specify the correct paper type when loading the paper? Some paper types require more 
time for printing; for example, photo and coated papers require more drying time between passes. To 
find out the printer’s current paper type setting, see Paper options on page 45.

● If your printer is connected by network, check that all components used in the network (network 
interface cards, hubs, routers, switches, cables) are capable of high-speed operation. Is there a lot of 
traffic from other devices on the network?

● Did you specify Extended drying time in the control panel? Try changing the drying time to Optimal.

Communication failures between computer and printer
Your computer hangs or shows an error message when trying to communicate with the printer, or 
print-quality issues occur.

Some symptoms are:

● The control-panel display does not show the Receiving message when you have sent an image to 
the printer.

● Your computer displays an error message when you are trying to print.

● Your computer or printer hangs (stays idle), while communication is taking place.

● Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

● Ensure that you have selected the correct printer in your application, see Printing on page 57.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process and print.

● If your printer is connected to your computer through any other intermediate devices, such as 
switch boxes, buffer boxes, cable adapters, cable converters, and so on, try using it when connected 
directly to your computer.

● Try another interface cable.

● Ensure that the graphic language setting is correct, see Change the graphic language setting on 
page 34.

● If the printer is connected by network, check that your printer has a static IP address. If it is using 
DHCP, the IP address may change every time it is turned on, in which case the driver may not be able 
to find it.

Cannot access the Embedded Web Server
If you have not done so already, read Embedded Web Server on page 35.
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At the control panel, tap the Menu icon , then the Settings icon , then Security > Enable Web 
Server, and check if it is enabled.

If you are using a proxy server, try bypassing the server and accessing the Web server directly:

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and 
check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click 
the Advanced button and add the printer’s IP address to the list of exceptions, for which the proxy 
server is not used.

● In Safari for macOS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings 
button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy 
server is not used, in the Bypass proxy settings for these Hosts & Domains field.

If you still cannot connect, turn the printer off and back on with the power key on the control panel.

Cannot connect to the Internet
If your printer has difficulty in connecting to the Internet, it may start the Connectivity Wizard 
automatically.

The Connectivity Wizard performs a series of tests automatically.

If any test fails, the printer describes the problem and recommends how to solve it. You can modify 
settings and rerun the test, unless the settings are protected.

Web Services issues
If you have any issues with HP ePrint, see HP Connected.

Go to http://www.hpconnected.com.

Automatic file system check
When you turn on the printer, you will occasionally see a control-panel message: File system check.

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

CAUTION: If you turn the printer off before the file system check has finished, the file system could be 
seriously damaged, making the printer’s hard disk unusable. In any case, the file system check will 
restart from the beginning whenever you turn the printer on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.

NOTE: When the printer is powered back on, it takes about 3 minutes to initialize and check and 
prepare the printheads. However, it can take up to 40 minutes under some conditions: for example, 
when the printer has not been used for a long period of time and requires more time to prepare the 
printheads.

Alerts
Your printer can communicate two types of alerts: errors and warnings.

220 Chapter 20  Troubleshooting general printer issues

http://www.hpconnected.com


● Errors: Mainly alerting you to the fact that the printer is unable to work normally. However, in the 
printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even 
if the printer is able to print.

● Warnings: Alert you when the printer needs attention either for an adjustment, such as a calibration 
or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your printer's system:

● Control-panel display: The control panel shows only the most relevant alert at a time. In the case of 
a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on 
ink", that reappear when the printer becomes idle and there is not another more severe alert.

TIP: From the control panel display you can configure paper mismatch alerts, see Solve paper 
mismatch on page 76.

● Embedded Web Server: The upper-right corner of the Embedded Web Server window shows the 
printer status. If there is an alert in the printer, the status shows the alert text.

● Driver: The driver warns about job configuration settings that may produce a problem in the final 
output. If the printer is not ready to print, it displays a warning.

By default, alerts are displayed only when you are printing. If alerts are enabled and there is a problem 
that prevents a job from completing, you see a pop-up window, which explains the reason for the 
problem. Follow the instructions to achieve your required result.
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The printer may occasionally display a system error which consists of an 8 character or 12 digit error 
code, followed by the recommended action that you should take.

In most cases you will be asked to restart the printer, because when the printer starts it can diagnose 
the issue better and may be able to fix it automatically. If the problem persists after restarting, you 
should contact your service representative and be ready to give the error code from the message.

If the error message contains some other recommended action, follow the printer’s instructions.

System error log
The printer saves a log of system errors that you can access by using a USB drive or the Embedded Web 
Server.

Using a USB flash drive
You will need a standard USB flash drive, formatted as FAT32.

1. Create an empty file in the USB flash drive (right-click, New > Text Document), and name it 
pdipu_enable.log.

2. When an error message is displayed on the control panel, insert the USB flash drive into the 
Hi-Speed USB host port at the front of the printer. The log is automatically copied into the drive. You 
can remove the USB flash drive when prompted by the control panel.

3. Contact your service representative (see Contact HP Support on page 224) to share the file 
created in the USB flash drive.

Using the Embedded Web Server
In your Web browser, go to https://printer IP address/supportTools/servicesupport.

Then:

1. Click the Download button under Diagnostics package to get Diagnostic package.

2. Save the package in your computer and contact your service representative (see Contact HP 
Support on page 224).
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Introduction
HP Customer Care offers award-winning support to ensure you get the most from your HP DesignJet, 
providing comprehensive, proven support expertise and new technologies to give you unique end-to-end 
support.

Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange 
services, phone and Web support, software updates and self-maintenance services. To find out more 
about HP Customer Care, see Contact HP Support on page 224.

To register your warranty, visit the HP website at the following link: http://register.hp.com/.

HP Professional Services

HP Support Center
Enjoy a world of dedicated services and resources to ensure you always get the best performance from 
your HP DesignJet printers and solutions.

Join the HP community at the HP Support Center, your large-format printing community, for 24×7 access 
to:

● Multimedia tutorials

● Step-by-step how-to guides

● Downloads: the latest printer firmware, drivers, software, paper presets, etc.

● Technical support: online troubleshooting, customer care contacts and more

● Workflows and detailed advice for completing various printing tasks from particular software 
applications

● Forums for direct contact with the experts, both HP and your colleagues

● Warranty tracking online, for your peace of mind

● Latest product information: printers, supplies, accessories, software, etc.

● Supplies Center for all you need to know about ink and paper

The HP Support Center can be found on the HP website at the following link: 
http://www.hp.com/go/DesignJetXL3800/support.

By customizing your registration for the products you have purchased and your type of business, and by 
setting your communication preferences, you decide the information you need.

Download printer software
Install the printer software from the HP website at the following link: 
http://www.hp.com/go/DesignJetXL3800/drivers. Be sure to follow the software installation instructions.
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HP Care Packs and Warranty Extensions
HP Care Packs and Warranty Extensions allow you to extend your printer's warranty beyond the 
standard period.

They include remote support. On-site service is also provided if necessary, with two alternative 
response-time options:

● Next business day

● Same business day, within four hours (may not be available in all countries)

There is an HP Installation service that unpacks, sets up, and connects the printer for you.

For more information on HP Care Packs, see http://cpc.ext.hp.com/portal/site/cpc.

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or 
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace 
them. Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to 
address a defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you 
contact HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair.

Contact HP Support
HP Support is available to you by telephone.

What to do before you call:

● Review the troubleshooting suggestions in this document.

● Review the relevant driver documentation.

● If you have installed third-party software drivers and RIPs, see their documentation.

● If you call your service representative, please have the following information available to help us 
answer your questions more quickly:

– The product you are using (the product number and the serial number, found on the label at the 
back of the product).

– If there is an error code on the control panel, note it down; see Control-panel error messages - 
HP DesignJet XL 3800 Multifunction Printer Series on page 222.
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– The computer you are using.

– Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, 
modems or special software drivers).

– The type of interface used on your product (USB or network).

– The software and driver name and version number that you are currently using.

● The Printer Service information is available from the Embedded Web Server; In a Web browser, enter 
your printer’s IP address to access the Embedded Web Server.

To access the printer’s service information:

– Tap Product Information > Printer Information.

– Tap Product Information > Supply Status.

– Tap Tools > Reports > Usage Report.

– Tap Tools > Reports > Error Log.

You can also print the service information from the control panel:

– Tap the Settings icon , then Reports > Printer Status Report.

– Tap the Settings icon , then Reports > Print Quality Report.

– Tap the Settings icon , then Reports > Error Log.

Telephone number
Your HP Support telephone number is available on the Web.

See http://welcome.hp.com/country/us/en/wwcontact_us.html.
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Functional specifications
Table 23-1 HP ink supplies

Supply Description

Printhead Six printheads, black-magenta, cyan-yellow, magenta-black, two of each

Ink cartridges Cartridges containing 500 ml of ink: cyan, magenta, yellow, and black. Cartridges 
shipped with the printer are for printer startup and may contain less ink

Table 23-2 Paper sizes

Description Minimum Maximum

Roll width 279 mm (11 in) 914 mm (36 in)

Roll length N/A 198 m (650 ft)

Roll diameter N/A 180 mm (7.09 in)**

Roll weight N/A 15 kg (33.07 lb)

Roll paper thickness N/A 0.5 mm (19.7 mil)*

Paper weight 60 g/m² 328 g/m²

* up to 0.6 mm (23.6 mil) printed to the output stacking tray with attended mode.

** Roll core diameter of 76.2 mm (3 in).

Table 23-3 Print modes

Paper type Print mode Rendering 
resolution

Printing resolution 
(horiz/vert) [dpi]

Printing time 
[sec/A1]

Plain Fast 600 × 600 600 × 1200 10

Plain Normal 600 × 600 1200 × 1200 30

Plain Best 600 × 600 1200 × 1200 100

Heavyweight coated Fast 600 × 600 600 × 1200 120

Heavyweight coated Normal 600 × 600 600 × 1200 160

Heavyweight coated Best 600 × 600 1200 × 1200 190

Photo paper (gloss/satin) super-
heavyweight coated

Fast 600 × 600 600 × 1200 120

Photo paper (gloss/satin) super-
heavyweight coated

Normal 600 × 600 600 × 1200 160

Photo paper (gloss/satin) super-
heavyweight coated

Best 600 × 600 1200 × 1200 190
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Table 23-3 Print modes (continued)

Paper type Print mode Rendering 
resolution

Printing resolution 
(horiz/vert) [dpi]

Printing time 
[sec/A1]

Photo paper (gloss/satin) super-
heavyweight coated

Best-max detail 600 × 600 2400 × 1200 TBD

NOTE: For a list of supported papers, see Order paper on page 154.

Scanner resolutions are 200, 300, 600 ppi.

Table 23-4 Margins

Margins Size

Top, right, and left margins 3 mm (0.1 in) (default) / 5 mm (0.2 in) (optional)

Table 23-5 Mechanical accuracy

Specification

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing 
material in Best or Normal mode.

Table 23-6 Graphic languages supported

HP DesignJet Languages

XL 3800MFP HP PCL3GUI, HP-GL/2 and HP RTL, CALS G4, TIFF, JPEG, URF, PWG, Adobe PDF 1.7

Mobile printing specifications
Table 23-7 Mobile printing

Type Description

Mobile printing Yes, AirPrint in iPhone and HP Print Service plugin for Android

Mobile devices supported 
by HP Mobile printing

Smartphones and tablets

Supported operating 
systems

iOS, Android, Windows

OS Versions iOS from 7.0 and Android from 4.4, Windows any

Connectivity requirements Printer and mobile device must use the same network

Supported file formats PDF, JPEG
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Physical specifications
Table 23-8 Printer physical specifications

Specification HP DesignJet XL 3800

Weight 182 kg (401 lb)

Width 1603 mm (63.1 in)

Depth 805 mm (31.7 in) (with waste bin open)

614 mm (24.2 in) (with stacker folded and waste bin closed)

Height 1225 mm (48.2 in) (stacker and control panel deployed)

Memory specifications
Table 23-9 Memory specifications

HP DesignJet Physical DRAM File-processing memory Long-term storage

XL 3800MFP 8 GB 128 GB 256 GB encrypted

Power specifications
Table 23-10 Printer power specifications

Type Description

Input voltage 100–240 V AC ±10%, auto-ranging

Frequency 50/60 Hz

Maximum current 3 A

Power 220 W

Ecological specifications
This product complies with the WEEE Directive 2012/19/EU and RoHS Directive 2011/65/EU.

To determine the ENERGY STAR and EPEAT registration status of these product models, check your 
model at http://www.epeat.net and http://www.energystar.gov/productfinder, or see the HP website at 
https://www.hp.com/us-en/hp-information/sustainable-impact/document-reports.html.

Take sustainability further with cardboard-based cartridges and a printer made with 33% recycled 
plastic.

Free, convenient HP ink-cartridge recycling with HP Planet Partners program. Program availability varies. 
See the HP website at http://www.hp.com/recycle.

For every page you print, HP protects, restores, and manages forests. HP works collaboratively with our 
partners including WWF and Conservation International to manage, restore, and protect forests in many 
countries around the world. With HP, every print—regardless of paper brand—is addressed through HP’s 
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Forest Positive Framework to counteract risks of deforestation. To learn more, see the HP website at 
http://hp.com/forestfirst.

Environmental specifications
Table 23-11 Printer environmental specifications

Type Range

Operating temperature 5 to 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type

Storage temperature −25 to 55°C (−13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0 to 95% RH

Maximum altitude when printing 3000 m (10000 ft)

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid location, 
water from the atmosphere can condense on the printer parts and cartridges and can result in ink 
leaks and printer errors. In this case, HP recommends that you wait at least 3 hours before turning on 
the printer or installing the ink cartridges, to allow the condensation to evaporate.

Acoustic specifications
Declared noise emission levels for the HP DesignJet XL 3800 Printer Series. Sound pressure levels at 
by-stander positions and sound power levels measured per ISO 7779.

Table 23-12 Printer acoustic specifications

Type Description

Operating sound pressure 50 dB(A) (plain paper, line drawing, normal mode)

45 dB(A) (color scan)

Operating sound power ≤6.8 B(A) (plain paper, line drawing, normal mode)

≤6.3 B(A) (color scan)

Idle sound pressure <30 dB(A) (ready)

<20 dB(A) (sleep)

Idle sound power <4.8 B(A) (ready)

<3.8 B(A) (sleep)
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 Bonjour  
Apple Computer’s trade name for its implementation of the IETF Zeroconf specification framework, a 
computer network technology used in Apple’s Mac OS X from version 10.2 onwards. It is used to discover 
services available on a local area network. It was originally known as Rendezvous.

Color accuracy  
The ability to print colors that match the original image as closely as possible, bearing in mind that 
all devices have a limited color gamut and may not be physically capable of matching certain colors 
precisely.

Color consistency  
The ability to print the same colors from a particular print job from print to print and from printer to 
printer.

Color model  
A system of representing colors by numbers, such as RGB or CMYK.

Color space  
A color model in which each color is represented by a specific set of numbers. Many different color 
spaces can use the same color model: for instance, monitors generally use the RGB color model, but 
they have different color spaces, because a particular set of RGB numbers results in different colors on 
different monitors.

Cutter  
A printer component that slides back and forth across the platen to cut the paper.

ESD  
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the 
car door, or the cling of clothing. Although controlled static electricity has some useful applications, 
uncontrolled electrostatic discharges are one of the main hazards to electronic products. Therefore, to 
prevent damage some precautions are needed when setting up the printer, or handling ESD sensitive 
devices. This type of damage may reduce the life expectancy of the device. One way to minimize 
uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part 
of the printer (mainly metal parts) before handling ESD sensitive devices (such as the printheads or 
ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid 
working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive 
devices. Also, avoid working in low humidity environments.

Ethernet  
A popular computer networking technology for local area networks.

Firmware  
Software that controls your printer’s functionality and is stored semi-permanently in the printer (it can 
be updated).

Gamut  
The range of colors and density values reproducible on an output device, such as a printer or monitor.
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Gigabit Ethernet  
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet 
interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet 
devices.

HP RTL  
HP Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

HP-GL/2  
HP Graphics Language 2: a language defined by HP to describe vector graphics.

I/O  
Input/Output: this term describes the passing of data between one device and another.

ICC  
The International Color Consortium, a group of companies that have agreed on a common standard for 
color profiles.

Ink cartridge  
A removable printer component that stores ink of a particular color and provides it to the printhead.

IP address  
May mean an IPv4 address (most likely) or an IPv6 address.

IPSec  
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets 
sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. 
Applications are usually unaware whether IPSec is being used or not.

IPv4 address  
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four 
integers separated by full stops. Most networks in the world use IPv4 addresses.

IPv6 address  
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up 
to 8 groups of hexadecimal digits separated by colons. Each groups contains up to 4 hexadecimal digits. 
Only a few new networks in the world use IPv6 addresses.

Jetdirect  
HP's brand name for its series of print servers that allow a printer to be connected directly to a local 
area network.

LED  
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

MAC address  
Media Access Control address: a unique identifier used to identify a particular device on a network. It 
is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP 
address.
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Network  
A network is a set of connections that pass data between computers and devices. Every device is able 
to communicate with every other device in the same network. This allows data to be moved between 
computers and devices, and allows devices such as printers to be shared between many computers.

Nozzle  
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper  
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind 
which are pulped, dried and pressed.

Platen  
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver  
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead  
A removable printer component that takes ink of one or more colors from the corresponding ink 
cartridge(s) and deposits it on the paper, through a cluster of nozzles. In your printer, each printhead 
prints two different colors.

Spindle  
A rod that supports a roll of paper while it is being used for printing.

TCP/IP  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is 
based.

USB  
Universal Serial Bus: a standard serial bus designed to connect devices to computers.

USB host port  
A rectangular USB socket such as those on found on computers. A printer can control USB devices that 
are connected to such a port. Your printer has two USB host ports, which it uses to control accessories 
and USB flash drives.
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